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About Chancery SMS
Welcome to Chancery SMS® from Pearson. Chancery SMS is a software tool for managing 
student and family information in your school district.

Support Services Available
Chancery offers a full suite of documentation, Online Help, and technical support to help you 
with your day-to-day tasks.

Documentation Included
The following documentation is included with Chancery SMS:

See For

Chancery SMS Guides The following guides are available in PDF format from our 
support web site at http://support.chancery.com:

• District Administration Guide: For district administrators, the 
District Administration Guide provides information about 
maintaining the centralized Chancery SMS solution, including 
setting up your district, adding schools to the district, and 
standardizing data across the district using setup lists.

• District User Guide: For district office staff, the District User 
Guide provides information about using Chancery SMS at a 
district level, including registering and enrolling students and 
working with student data.

• School Administration Guide: For school administrators, the 
School Administration Guide provides information about 
maintaining a school and performing administrative tasks.

• School Setup Guide: The School Setup Guide provides 
information about setting up schools in the district, including 
the steps to be performed as a district administrator and as a 
school administrator.

• School User Guide: For school office staff, the School User 
Guide provides information about using Chancery SMS at the 
school level, including how to take attendance, enter grades, 
and work with student data in the office.

• Chancery SMS in the Classroom: This guide covers the basics 
of using Chancery SMS at the homeroom and class level, 
including how to take attendance, enter grades, and work 
with student data in the classroom.
About Chancery SMS 1
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Chancery SMS Speciality Guides Additional feature-specific guides to supplement the standard 
guides are available in PDF format from our support web site at 
http://support.chancery.com:

• Address Validation Guide: For school and district 
administrators, the Address Validation Guide provides 
information about setting up address validation at the district 
and performing address validation tasks at the district and at 
schools.

• cTools Guide: This guide provides information about 
customizing Chancery SMS, along with instructions for using 
the customization features.

• Grading Setup Guide: For school administrators, the Grading 
Setup Guide provides information about setting up grading 
properties and performing grading-related tasks.

• Permissions Guide: For district administrators, this guide 
provides information about setting up permissions in 
Chancery SMS. The Permissions Guide explains the 
permission structure and provides information about each 
permission’s dependencies, effect on the system, options, 
and defaults. 

• Program Management Guide: For district and school 
administrators and district and school staff who enroll 
students and process applications, the Program Management 
Guide is a feature-specific guide that describes the process of 
setting up programs at the district and at schools and 
performing program-related tasks.

• Registration and Enrollment Quick Guide: For school and 
district staff, the Registration and Enrollment Quick Guide 
provides procedures for registering students in the district 
and enrolling students in schools.

• Scheduling Guide: For school administrators, the Scheduling 
Guide covers the process of setting up a school scheduling 
structure, as well as scheduling in elementary and secondary 
schools.

• Next-Year Preparation and Year-End Processing Guide: For 
district and school administrators, this guide covers all the 
steps required to close off the current school year and 
prepare for the next.

See For
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Getting Training
Training courses are available to help ensure you get every advantage from your student 
information system. We are committed to helping you put our solutions to work. Our broad 
training offerings are designed with you in mind so that you’ll receive the most suitable and 
effective training for your needs.

Choose from on site training or live online training. We can also create a customized training 
program to meet your district’s needs.

Phone us toll free at 1-800-999-9931 or see the Training area of our customer support web 
site at http://support.chancery.com for an up-to-date list of scheduled courses.

Chancery SMS Technical Guides Technical guides are available in PDF format from our support 
web site at http://support.chancery.com:

• Import/Export Guide: For district administrators, the 
Import/Export Guide describes the process for importing and 
exporting data into and out of Chancery SMS.

• Interoperability Guide: For district administrators, the 
Interoperability Guide covers how to integrate third-party 
applications with Chancery SMS using SIF and Import/Export 
functionality.

• Report Writer Guide: For district and school administrators 
and third-party report writers, the Report Writer Guide covers 
how to plan, build, and upload reports using the new 
reporting framework. The guide also includes an in-depth 
examination of this framework, extensive information about 
how to use Crystal Reports® functionality, and reference 
material about using previous reporting methods.

Chancery SMS Online Help Help is available by accessing the Help menu from the task bar.

Release Notes Release Notes are summaries of the new features and changes 
in the current release.

Installation Documentation The Installation Guide provides technical details for installing 
the entire Chancery SMS system.

The Upgrade Guide provides detailed instructions for upgrading 
from a prior version of Chancery SMS.

See For
About Chancery SMS 3
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Getting Support
The following support programs are available by subscription only:

For more information about Technical Support Programs, phone Customer Service at  
1-800-999-9931.

Support Description

One-on-one Technical Support Talk to a technical support analyst to help solve problems 
and answer questions when software doesn’t produce the 
expected results. Analysts can use the telephone or Internet 
access to troubleshoot your issues.

Monday to Friday, 5 am to 5 pm Pacific Time 
Phone: 1-800-688-9939 
Fax: 1-800-446-5650 
Email: psstechsupp@pearson.com

Access to our web site http://support.chancery.com
In Chancery SMS, from the Help menu, click Support 
Website.

Our web site includes a searchable KnowledgeBase with 
frequently asked questions, tips, and troubleshooting 
instructions, as well as support forums for users to share 
experience and knowledge.

Software updates Updates are provided free of charge for three months from 
your date of purchase and are included in the subscription to 
Support Programs. 
4 About Chancery SMS
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Grading Setup Overview
Because the grading setup process is significantly different between schools that use 
elementary scheduling and schools that use secondary scheduling, this guide is divided into 
two sections. Refer to the appropriate section for the type of scheduling your school uses:

• “Elementary Grading Setup” on page 9.

• “Secondary Grading Setup” on page 49.

Setting Up Grading to Support Data Mapping
Data mapping is required for running reports and when uploading data to K12Planet. For 
more information about data mapping, see the Chancery SMS School Administration Guide 
and for more information about K12Planet, see the K12Planet System Administrator Guide. 
Both guides are available from our support site at http://support.chancery.com.

To map data and subsequently upload data to K12Planet or generate reports, be aware of the 
following grading constraints when setting up the grading structure for your school. If your 
grading data is not set up to support these constraints, data mapping might fail or data will 
not be reported or uploaded correctly.

Grading Tables
Grading tables define the format and meaning of the grades that students receive on their 
report cards. For information about elementary school grading tables, see “Understanding 
Elementary Grading Tables” on page 19. For information about secondary school grading 
tables, see “Defining Secondary Grading Tables” on page 65.

If your school uses K12 Planet, define only numeric or letter grade grading tables. Data 
mapping for K12 Planet supports numeric and letter grades for both regular and special 
grades. Other grade types, such as graphic symbols and narrative grades, are not supported. 

NOTE

If subjects and courses are not associated with a Numeric or Letter Grade grading table, data mapping 
still completes; however, Bin Marks data does not appear in K12Planet. 

Grade Items (Secondary)
Grade items are ways that your school measure student performance. For information about 
grade items, see “Setting Up Grade Items” on page 63.

Data mapping supports a maximum of 30 grade items each year. If you have four grading 
periods in a year, the default grade item for the course grade is used four times. You have 26 
grade items remaining that you can assign to the course throughout the four grading 
periods. The additional grade items, together with the grade item for the course grade, must 
not exceed 30 for all grading periods combined.

Complete the following tasks to ensure your grade items are mapped:

• Associate the default “Course” grade item with a Numeric grading table.

• Create three grade items with the following Short Names:

• WRKHBT
Grading Setup Overview 5
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• CTZSHP

• CMNT

Associate these grade items with a Standard Comment type grading table. Additional 
grade items can be set up; however, only these three grade items map and upload to 
K12Planet as Bin Marks.

NOTE

If these grade items are not defined or if they’re associated with a different type of grading table, 
data mapping still completes; however, the Bin Marks data does not appear in K12Planet.

Standard Comments
A standard comment is a sentence or two that all teachers can re-use repeatedly when 
entering grades. For information about elementary standard comments, see “Setting Up 
Elementary Standard Comments” on page 15. For information about secondary standard 
comments, see “Setting Up Secondary Standard Comments” on page 59.

The maximum number of standard comments supported for each grading period depends on 
the grade item:

• WRKHBT supports one comment

• CTZSHP supports one comment

• CMNT supports five comments

If additional comments are entered in the standard comment grading tables associated with 
these grade items, only the number of comments supported appear in K12Planet.

Comment codes for work habits and citizenship grade items cannot exceed four characters.

For secondary schools, include comments for a course by assigning a standard comment 
grading table to the required grade items (WRKHBT, CTZSHP, CMNT).

Measures
Measures are used to rate achievement or effort and are defined when creating the 
elementary report card template. For information about measures, see “Setting Up 
Elementary Report Cards” on page 39.

For each subject, make sure the following Measures are defined:

• Work Habit

• Citizenship

• Comment

Each measure must be associated with a Standard Comment type grading table. 

NOTE

If these measures are not set up or the measures are not associated with a Standard Comment type 
grading table, data mapping still completes; however, Bin Marks Comments data does not appear in 
K12Planet.

Additional elements, skills, and measures can be defined and used on Report Cards and 
Progress Reports; however, only the three measures listed above are mapped and uploaded 
to K12Planet.
6 Grading Setup Overview
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About Assigned Grades
For elementary schools, only assigned grades that are associated with generic subjects are 
mapped. Grades associated with subject elements are not mapped. For example, grades 
assigned to the Language Arts subject are mapped, but grades assigned to its subject 
elements, such as reading, spelling, and writing, are not mapped.

For information about subjects and subject elements, see the Chancery SMS Scheduling 
Guide and for instructions about assigning grades, see the Chancery SMS School User Guide. 
Both guides are available from Pearson’s Customer Support website.
Grading Setup Overview 7
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Elementary Grading Setup
The following steps illustrate how the completed grading setup tasks flow through to the 
running of the actual report cards or progress reports for elementary schools.

Step 1: Set Up Standard Comments and Categories
Use standard comments and standard comment categories to capture comment-type grades 
for students. For information about creating standard comments, see “Setting Up Elementary 
Standard Comments” on page 15.

Step 2: Set Up Grading Tables for All Grade Levels
Use grading tables to define the format and meaning of grades that students receive on their 
report cards. A grading table legend appears on the report card so that readers can interpret 
the grades. For information about creating grading tables, see “Understanding Elementary 
Grading Tables” on page 19.
Elementary Grading Setup 9
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Step 3: Set Up Grading Periods
Grading periods define the span of time that report cards and progress reports cover. For 
information about setting up grading periods, see “Defining Elementary Grading Periods” on 
page 37.

Step 4: Set Up Common Report Card Elements
Common elements are items you want to have print on all report cards and progress reports. 
For information about setting up common report card elements, see “Selecting Common 
Report Card Elements” on page 39. 

Step 5: Set Up Report Card and Progress Report 
Templates
Report card and progress report templates define how the reports will look when printed. 
Each subject, subject element, skill, and measure can use a different grading table. For 
information about setting up elementary report card templates, see “Adding and Editing 
Elementary Report Cards/Progress Reports” on page 40 and “Working with Elementary 
Progress Reports” on page 44.
10 Elementary Grading Setup
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NOTE

Subjects and subject elements come from the subject framework. To set up a subject framework, see 
“Elementary School Scheduling” in the Chancery SMS Scheduling Guide.
g

Step 6: Enter Grades
Enter grades for each student in a homeroom or class. The columns on the Student Grades 
page correspond to the subjects, subject elements, skills, and measures found in the report 
card content area in Step 5. In addition, the choices available from the dropdowns in each of 
these columns are the grading codes that correspond to the grading tables defined in Step 2. 
A legend that explains the meaning of each grading code appears at the bottom of the 
screen.

For information about entering grades, see the Chancery SMS School User Guide available 
from the Pearson Customer Support website.
Elementary Grading Setup 11
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Step 7: Run Report Cards or Progress Reports
When you run report cards or progress reports, the common elements you defined in Step 4 
print on the report card or the progress report. The subjects and subject elements are from 
the subject framework and the skills and measures are added to the report card template in 
Step 5, along with the grades and comments entered in Step 6. 

For information about printing reports, see the Chancery SMS School User Guide available 
from the Pearson Customer Support website.

Before getting started, ensure you have the necessary permissions. See “Permissions to Set 
Up Grading and Enter Grades” on page 13. 
12 Elementary Grading Setup
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Permissions to Set Up Grading and Enter Grades
To set up grading and collect grades, you need the following permissions:

By default, the school administrator role can perform all grading setup and collection tasks. 
For further information about permissions, contact your system administrator or see the 
Chancery SMS Permissions Guide.

To You need this permission Set to

Define standard comments School Setup > Standard Comments Delete

Define grading tables School Setup > Grading Tables Delete

Define grading periods School Setup > Grading Period Sets Delete

School Setup > Define Report Card Periods Yes

School Setup > Define Progress Report Periods Yes

Define report cards and progress reports School Setup > Report Card Setup Delete

Edit grades entered by teachers Grading > Edit Grades from Other Teachers Yes

Enter or edit grades for any class 
(including grades entered during a 
specified grace period)

Grading > Enter Grades for All Classes Yes

Enter or edit past grades Grading > Modify Grades for Completed 
Periods

Yes
Elementary Grading Setup 13
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Setting Up Elementary Standard 
Comments
A standard comment is a sentence or two that teachers can re-use on any report card or 
progress report. 

Here are a few examples:

• “Making satisfactory progress”

• “Lack of attendance is affecting progress”

• “An enthusiastic participant”

• “Needs to participate more in class”

You do not need to set up standard comments, but they can be helpful. Instead of repeatedly 
typing the same comments, teachers can enter a standard comment with a click of the 
mouse. Typically, schools or districts have grading policies governing when standard 
comments can be used.

If you have many standard comments, you can create categories for them and group the 
comments into those categories. Categories are not required, but they can make selecting 
comments for student evaluation quicker and easier. You can categorize some, all, or none of 
the standard comments.

On the Standard Comments page, comments are sorted first by category and then by code. 
Comments that are not categorized appear first.

To use Standard Comments, you must set up a Standard Comments Grading Table. See 
“Adding and Editing Standard Comment Grading Tables” on page 33.

NOTE

If you want teachers to be able to enter unique comments, rather than standard comments, you can set 
up a narrative grading table. See “Creating and Editing Narrative Comment Grading Tables” on page 32.

Creating and Editing Categories for Standard Comments
If you have many standard comments, you can create categories to group the comments. 

Categories have a full name and a short name consisting of no more than six letters. The 
short name appears on the Standard Comments page and describes each category of 
comments, so ensure the short name is as descriptive as possible.

You can create as many categories as you need. Later, if no comments are assigned to that 
category, you can delete or change the category.

To create or edit categories for standard comments:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 1, click Standard Comment Categories.
Setting Up Elementary Standard Comments 15
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3 On the Standard Comment Categories page, do any of the following:

4 Click OK.

Adding and Editing Standard Comments
You can create as many standard comments as you need. Later, if the comment has not been 
used on a report card or progress report, you can delete or change it.

To add or edit standard comments:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 1, click Standard Comments.

3 On the Standard Comments page, do any of the following:

To Do this

Add a category 1 If all rows are used, from the Actions menu, click Add 
Rows.

2 In the first empty row, under Standard Comment Category 
name, enter the name of the category that you want to 
create.

3 Under Short Name, enter a short name of no more than 
six characters. 

NOTE
Make the short name as descriptive as possible because it appears on 
the Standard Comments page as a description of the category.

Delete a category 1 Select the category to delete. 

2 From the Actions menu, click Delete Row.

Edit a category • Click the category and enter the changes.

To Do this

Show only comments in a specific 
category

• From the View dropdown, select a category.

Add a comment 1 From the Actions menu, click Add Comments.

2 On the Add Comments page, if you want to assign the 
comment to a category, select a category in the Comment 
Category dropdown.

3 For each comment you want to add, enter a unique 4-or 
5-character code for the comment and then enter the 
complete comment text as it will appear on the report 
card.

4 If you want to add more comments, click “Save+Add”.

5 Click OK.

Delete a comment 1 Select the comment to delete.

2 From the Actions menu, click Delete. 
16 Setting Up Elementary Standard Comments
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4 Click OK.

To use the standard comments, set up a standard comment grading table to link to 
appropriate grade items. See “Adding and Editing Standard Comment Grading Tables” on 
page 33.

Edit a comment • Click the comment and enter the changes.

To Do this
Setting Up Elementary Standard Comments 17
Adding and Editing Standard Comments



Chancery SMS Grading Setup Guide
18 Setting Up Elementary Standard Comments
Adding and Editing Standard Comments



Understanding Elementary Grading Tables 
Grading tables define the format and meaning of the grades that students receive on their 
report cards. 

The main purpose of a grading table is to list all of the possible grades a student can receive 
and the meaning of each grade. Grading tables can also identify conversions from one format 
to another, such as percentages to letters, and whether a grade is a pass or a fail 

You need to create a grading table for each way that you capture grades. For example, 
subjects might be graded as a G (Good), S (Satisfactory), or N (Needs Improvement), while 
conduct or participation are graded using teacher comments. Students in higher grade levels 
might be graded using percentages. In each of these scenarios, a different type of grading 
table is required.

Grading tables appear as a legend on report cards to help readers interpret the grades. Since 
a report card often includes items with different grading tables, report cards often display 
multiple grading table legends.

You can choose from five types of grading tables. The type of grading table is determined by 
how the grade is entered, not how it is displayed on the report card. For more information, 
see “Selecting a Grading Table Type” on page 19.

In addition, you can add special grades, such as “Incomplete” or “Exempt”, to all grading 
tables. See “Adding Special Grades to Grading Tables” on page 34.

Selecting a Grading Table Type
Grading tables provide the flexibility to enter grades in several ways and either display the 
grades in the form they were entered or convert them to other forms on report cards.

NOTE

If your school uses K12Planet, use only numeric or letter grade grading tables. Data mapping for 
K12Planet supports numeric and letter grades for both regular and special grades. Other grade types, 
such as graphic symbols and narrative grades, are not supported.

Grading table legends
Understanding Elementary Grading Tables 19
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With Chancery SMS grading tables, you can:

• Enter letter grades in any format you design; for example, A, B, C, D, and F, or G, S, and 
N for Good, Satisfactory, and Needs Improvement. 

• Enter comments for conduct or participation grades, or enter codes that are shown as 
symbols, such as ☺, ., /.

• Use scales such as percentages, 4-point scale, or 12-point scale. 

• Enter numbers that are converted to letter grades or symbols.

To get such a wide range of options, grading tables are divided into five different types. 
These types correspond to the way you enter the grades, not how the grades appear on the 
report card. 

The five types of grading tables are summarized in the following table:

The following table shows the options available for entering and displaying grades, along with 
the required grading table settings:

Grading Table Type Description

Letter Grade Grades entered as letters will appear on the report card as 
letters.

Numeric Grades entered as numbers are either left as is or converted 
so that they appear as letter grades or graphic symbols on 
the report card.

Graphic Symbol Grades entered as codes will appear on the report card as 
graphic symbols, such as “H” for ☺.

Narrative Comment Grades entered as free form text.

Standard Comment Grades selected from a list of predefined options.

Grades on Report Cards Grading Table Type

Letters, such as A, B, C, D, F or G, S, 
N

To enter letter grades that appear as letter grades on the 
report card, set the Type to Letter Grade.

To enter numbers that appear as letter grades on the report 
card, set Type to Numeric and then set Equivalent Grade 
Type to Letter Grade.

For further information, see “Letter Grade Grading Table – 
Enter Letters and Display Letters” on page 24.
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Numeric Grading Table – Enter Numbers and Display 
Numbers 
To enter grades as numbers and display them as numbers on the report card, set Type to 
Numeric and Equivalent Grade Type to None.

If you enter grades as percentages, use a grading scale of 100 and a numeric grade input 
range of 0 to 100.

NOTE

If you want to award bonus points, make the upper input range greater than 100 (e.g. 110). For more 
information, see “Setting Up for Bonus Points” on page 26.

Numbers, such as percentages or 
1.0, 2.0, 3.0

To enter numeric grades and display them as numeric on the 
report card, set Type to Numeric and then set Equivalent 
Grade Type to None.

For further information, see “Numeric Grading Table – Enter 
Numbers and Display Numbers” on page 21.

Graphics, such as ☺, ., / To enter and display a code, such as “H,” as a graphic symbol 
on the report card, set Type to Graphic Symbol. 

To enter grades as numbers that appear as symbols on the 
report card, set Type to Numeric and then set Equivalent 
Grade Type to Graphic Symbol.

For further information, see “Numeric Grading Table – Enter 
Numbers and Display Symbols” on page 24

Comments To enter and display free-form comments, set Type to 
Narrative Comments.

For further information, see “Creating and Editing Narrative 
Comment Grading Tables” on page 32

To enter comments by selecting from a set of predefined 
comments, set Type to Standard Comments.

For further information, see “Defining Standard Comments” 
on page 60.

Grades on Report Cards Grading Table Type
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In the Lower Cutoff column, enter the lowest mark required to earn the grade. In the 
Description in Legend column, describe the meaning of the grade.

NOTE

The marks you enter in the Lower Cutoff column must be of the same format as the scale you entered in 
the Grading Scale field. For example, if you enter a grading scale of 100, you must enter lower cutoff 
marks between 0 and 100.

If you want to report on passing and failing grades, in the P/F column, select Pass (for pass) 
or F (for fail).

If you enter grades on a 4-point scale, use a grading scale of 4 and a numeric grade input 
range of 0 to 4.

In the Lower Cutoff column, enter the lowest mark (from 0 to 4) required to earn the grade. 
In the Description in Legend column, describe the meaning of the grade.

NOTE

The marks you enter in the Lower Cutoff column must be of the same format as the scale you entered in 
the Grading Scale field. For example, if you enter a 4-point grading scale, you must enter lower cutoff 
marks between 0 and 4.
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If you want to report on passing and failing grades, in the P/F column, select Pass (for pass) 
or F (for fail).

Numeric Grading Table – Enter Numbers and Display 
Letters
To enter grades as numbers and display them as letters on the report card, set Type to 
Numeric and Equivalent Grade Type to Letter Grade.

Set up the Numeric Grade Scale and Numeric Grades Input Range as appropriate for 
percentages or grade points.

In the Lower Cutoff column, enter the lowest mark required to earn the grade. If you want to 
report on passing and failing grades, in the P/F column, select Pass (for pass) or F (for fail). 
In the Letter Grade column, enter the equivalent letter grade. In the Description in Legend 
column, describe the meaning of the grade. 
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Numeric Grading Table – Enter Numbers and Display 
Symbols
To enter grades as numbers and display them as symbols on the report card, set Type to 
Numeric and Equivalent Grade Type to Graphic Symbol.

Set up the Numeric Grade Scale and Numeric Grades Input Range as appropriate for 
percentages or grade points.

In the Lower Cutoff column, enter the lowest mark required to earn the grade. In the Graphic 
Symbol column, select the equivalent symbol. If you want to report on passing and failing 
grades, in the P/F column, indicate if the grade is a pass or fail. In the Description in Legend 
column, describe the meaning of the grade. 

Letter Grade Grading Table – Enter Letters and Display 
Letters
To enter letters and display letters on the report card, set Type to Letter Grade.
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Enter the appropriate letters in the Letter Grade column. In the Lower Cutoff column, enter 
the lowest mark required to earn the grade. If grades will be transferred in from Gradebook, 
define the Grbk % Cutoff (this value can be different from the Lower Cutoff value, if 
required). If you want to report on passing and failing grades, in the P/F column, indicate if 
the grade is a pass or fail. In the Description in Legend column, describe the meaning of the 
grade. For example:

NOTE

The letter grade is not required in the description because it is added to the legend automatically.

Graphic Symbol Grading Table – Enter Codes and Display 
Symbols
To display symbols, such as a faces or checkmarks, on the report card, set Type to Graphic 
Symbol.

In the Input Grade column, enter up to three characters that staff will use to enter this 
grade. In the Reporting Grade column, select the symbol to show on the report card. If 
grades will be transferred in from Gradebook, define the Grbk % Cutoff (this value can be 
different from the Lower Cutoff value, if required). If you want to report on passing and 
failing grades, in the P/F column, indicate if the grade is a pass or fail. In the Description in 
Legend column, describe the meaning of the grade. 
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Special Grades
To handle special circumstances, such as exemptions, incomplete courses, and grades that 
are not available, use the Special Grades area at the bottom of numeric, letter, or graphic 
symbol grading tables. 

In the Input Grade column, enter up to three characters that staff will use to enter this 
grade. In the Reporting Grade column, select the symbol to show on the report card. In the 
P/F column, indicate if the grade is a pass or fail. In the Description in Legend column, 
describe the meaning of the grade. 

Setting Up for Bonus Points
When you are creating or editing numeric grading tables, you can set up your grade input 
ranges to accommodate awarding bonus points. The key fields involved are the Grading 
Scale, the Numeric Grades Input Range fields, and the Lower Cutoff column.

In the Grading Scale field, you enter the number that acts as the denominator in all of the 
calculations relating to grades from this table. In the Numeric Grades Input Range fields, you 
enter the lowest and highest grades a student can receive for a grade item that uses this 
table. 

Use these 
fields to set up 
bonus points.
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When you set up bonus points, the maximum value in the Numeric Grades Input Range 
should be greater than the value in the Grading Scale field. 

If, for example, you are working with percentages and students are eligible for up to ten 
bonus points, enter a Grading Scale of 100 and a Numeric Grades Input Range of 0 to 110. In 
the Numeric Grading Table grid, add a row with a Lower Cutoff of 101 to accommodate all 
grades above 100%, and define all of the other settings as appropriate.

Adding and Editing Numeric Grading Tables
With Numeric Grading Tables, you can choose to enter grades as numbers and have them 
display as numbers on the report card or you can set up the grading table so numeric grades 
can be entered as numbers but display as letters or graphic symbols on the report card.

To add or edit a numeric grading table:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the Type dropdown, select Numeric.

6 Define the overall properties for the numeric grading table as follows:

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading 
table

1 Select the grading table to delete. 

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading Table Name Enter a name of up to 30 characters, such as “Numeric Grades 1-6”.

Short Name Enter an abbreviation up to six characters, such as “N16”. This 
abbreviation is used when you create report cards.

Description If you want to describe the table and when to use it, enter a brief 
description.

Field Description

Max No. of Digits Select the maximum number of digits that teachers can enter. To 
determine the number of digits, add the digit in the Decimal Places field 
to the digits in the upper range of the numeric grade input range. For 
example, for an input range of 0 to 100 with no decimal places, the max 
number of digits is “3”.
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7 For each grade you want to define in the grading table, complete the following fields, as 
appropriate:

Decimal Places Select the number of digits that indicates how many of the Max No. of 
Digits appear to the right of the decimal point, such as “1” for grades like 
“3.5”.

For example, if you enter “3” for Max No. of Digits and “1” for Decimal 
Places, the maximum value possible is “99.9”.

Numeric Grades 
Scale

Enter the maximum grade a student can receive. For example, if you are 
assigning percent grades, this value would be 100.

Numeric Grades 
Input Range

Enter the minimum grade and maximum grade that will be accepted, 
using only positive numbers. For example, “0 to 4.0” or “0 to 100”.

Equivalent Grade 
Type

Select one of the following:

• None to display the numeric grades exactly as they are entered. 

• Letter Grade to display the numeric grades as letters.

• Graphic Symbol to display the numeric grades as symbols.

Field Description

Lower Cutoff Enter the lowest mark required to earn the grade, such as “75”. The 
range of marks for the grade start at this value and go to the next 
highest grade (or to the maximum value for the “Numeric grade input 
range”, if it is the highest range of grades). For example, if the Lower 
Cutoff for the first row in the table is “80” and the second row is “60”, 
the range for the second row is  
60-79.9. This number is used only to determine the grade and is not 
shown on the report card.

NOTE
The marks you enter in the Lower Cutoff column must be of the same format as the 
scale you entered in the Numeric Grades Scale field. For example, if you enter a 
grading scale of 100 you must enter the lower cutoff marks on a 100 point scale.

Letter Grade If you will display numeric grades as letters, enter the equivalent letter 
for the grade.

Grade Points Not applicable to elementary grading.

Graphic Symbol If you chose an equivalent grade type of graphic symbol, select the 
graphic symbol to display for the numeric grade.

P/F If you want to indicate whether the grade is considered a passing or 
failing grade, select P or F. For example, if the course requires 50% to 
pass, click F for all grades under 50%.

Use this column if you later want to report on passing and failing grades.

% Credit Not applicable to elementary grading.

Description in 
Legend

Enter a description of the grade, up to 15 characters long, that will 
appear in the legend on the report card. Ensure the description includes 
the grade itself, not just the description (e.g., “3.0-4.0—Excellent”, 
“A—85—100”, “Happy Face—Excellent”).

Field Description
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8 Do any of the following:

9 Click OK.

Creating and Editing Letter Grade Grading Tables
With Letter Grade Grading Tables, grades are entered as letters and appear on the report 
card as letters. 

To create or edit a letter grade grading table:

1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the type dropdown, select Letter Grade.

6 In the Grading Scale field, enter the maximum value of any grade.

For example, enter “4” for a 4-point scale or “100” for a 100-point scale.

To Do this

Add more rows • From the Actions menu, click Add Rows to> Grading Table.

Handle special cases 
such as incomplete, 
medical exemption, 
exempt, audit, pass, 
and fail 

• Create special grades for the grading table. See “Adding Special 
Grades to Grading Tables” on page 34.

Add more rows to 
the special grades 

• From the Actions menu, click Add Rows to>Special Grades.

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading 
table

1 Select the grading table to delete.

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading Table Name Enter a name up to 30 characters, such as “Letter Grades 1-6”.

Short Name Enter an abbreviation up to 6 characters, such as “L16. This abbreviation 
is used when you create report cards.

Description If you want to describe the table and when to use it, enter a brief 
description.
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7 For each grade that you want to define in the grading table, complete the following fields:

8 Do any of the following:

9 Click OK.

Field Description

Letter Grade Enter up to 3 characters that staff will use to enter this grade on a report 
card. For example, enter “A” so that staff can press the A key to enter 
this grade. 

Lower Cutoff Enter the lowest mark required to earn the grade, such as “75”. The 
range of marks for this grade start at this value and go to the next 
highest grade, with the specified grading scale determining the highest 
possible value.

NOTE
The marks you enter in the Lower Cutoff column must be of the same format as the 
scale you entered in the Grading Scale field. For example, if you enter a grading scale 
of 100, the lower cutoff marks must also be on 100 point scale.

Grbk % Cutoff If you use Gradebook, enter the percentage in Gradebook that students 
must earn to receive this grade in Chancery SMS.

NOTE
The Grbk % can be different than the lower cutoff mark, if required.

Grade Points Not applicable to elementary grading.

P/F If you want to indicate whether the grade is considered a passing or 
failing grade, select P or F. For example, if the course requires 50% to 
pass, click F for all grades under 50%.

Use this column if you later want to report on passing and failing grades.

% Credit Not applicable to elementary grading.

Description in 
Legend

Enter a description of the grade up to 15 characters, such as “Good”. 
Unlike Numeric grading tables, you do not need to include the grade 
itself. The report card legend will include the Input Grade next to the 
description, such as “B - Good”.

To Do this

Add more rows to 
the grading table

• From the Actions menu, click Add Rows to>Grading Table.

Handle special cases 
such as incomplete, 
medical exemption, 
exempt, audit, pass, 
and fail 

• Create special grades for the grading table. See “Adding Special 
Grades to Grading Tables” on page 34.

Add more rows to 
the special grades 

• From the Actions menu, click Add Rows to>Special Grades.
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Creating and Editing Graphic Symbol Grading Tables
With Graphic Symbol Grading Tables, grades are entered as codes and appear on the report 
card as graphic symbols. For example, teachers might enter “H” to display ☺.

To create or edit a graphic symbol grading table:

1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the Type dropdown, select Graphic Symbol.

6 In the Grading Scale field, enter the maximum value of any grade.

For example, enter “4” for a 4-point scale or “100” for a 100-point scale.

7 For each grade that you want to define in the grading table, complete the following fields:

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading 
table

1 Select the grading table to delete. 

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading Table Name Enter a name up to 30 characters, such as “Graphic Grades 1-6”.

Short Name Enter an abbreviation up to 6 characters, such as “GS6”. This 
abbreviation is used when you create report cards.

Description If you want to describe the table and when to use it, enter a brief 
description.

Field Description

Input Grade Enter up to 3 characters that staff will use to enter this grade. For 
example, enter “G” so that staff can press the G key to enter this grade. 

Reporting Grade Determine how the grade is displayed on the report card by doing one of 
the following:

• To display a symbol, select Check Mark, Happy Face, Neutral Face, or 
Sad Face.

• To display nothing, select Blank Space.

• To display the Input Grade itself, select Same.  
For example, select Same for an Input Grade of “X” to have a symbol 
that corresponds to the Check Mark symbol.
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8 Do any of the following:

9 Click OK.

Creating and Editing Narrative Comment Grading Tables
Narrative comment grades are entered free form and appear on the report card as they were 
entered.

To create or edit a narrative comment grading table:

1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

Lower Cutoff Enter the lowest mark required to earn the grade, such as “75”. The 
range of marks for this grade start at this value and go to the next 
highest grade, with the Grading Scale determining the highest possible 
value.

NOTE
The marks you enter in the Lower Cutoff column must be of the same format as the 
scale you entered in the Grading Scale field. For example, if you enter a grading scale 
of 100, the lower cutoff marks must also be on 100 point scale.

Grbk % Cutoff If you use Gradebook, enter the mark in Gradebook that students must 
earn to receive this grade in Chancery SMS.

NOTE
The Grbk % can be different than the lower cutoff mark, if required.

Grade Points Not applicable to elementary grading.

P/F If you want to indicate whether the grade is considered a passing or 
failing grade, select P or F. For example, if the course requires 50% to 
pass, click F for all grades under 50%.

Use this column if you later want to report on passing and failing grades.

% Credit Not applicable to elementary grading.

Description in 
Legend

Enter a description of the grade up to 15 characters, such as “Good”. 
Unlike with Numeric grading tables, you do not need to include the grade 
itself. The legend on the report card will include description next to the 
Reporting Grade, such as “☺ Good”.

To Do this

Add more rows • From the Actions menu, click Add Rows to Special Grades.

Handle special cases 
such as incomplete, 
medical exemption, 
exempt, audit, pass, 
and fail 

• Create special grades for the grading table. See “Adding Special 
Grades to Grading Tables” on page 34.

Add more rows to 
the special grades 

• From the Actions menu, click Add Rows to>Special Grades.

Field Description
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3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the Type dropdown, select Narrative Comment.

6 Define the following fields:

7 Click OK.

Adding and Editing Standard Comment Grading Tables
Standard comment grades are selected from a list of predefined options and appear on the 
report card as they were entered.

NOTE

To use a Standard Comment Grading Table, you must first set up standard comments. See “Setting Up 
Elementary Standard Comments” on page 15 for details. 

To add or edit standard a comment grading table:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading 
table

1 Select the grading table to delete.

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading Table Name Enter a name up to 30 characters, such as “Narrative Comment 1-6”.

Short Name Enter an abbreviation up to 6 characters, such as “NAR”. This 
abbreviation is used when you create report cards.

Description If you want to describe the table and when to use it, enter a brief 
description.

Field Description

Max No. of Chars Enter a number that represents the maximum number of characters 
permitted in a comment.

Comments Are 
Mandatory

When you select this checkbox, if no comments have been entered, the 
Missing Grades report displays the narrative comment grades as 
“Missing”.
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3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the Type dropdown, select Standard Comment.

6 Define the following fields:

7 Click OK.

Adding Special Grades to Grading Tables
If required, you can add special grades, such as “Incomplete” or “Exempt”, to numeric, letter 
grade, and graphic symbol grading tables. 

To add special grades to a grading table:
1 Create or edit a numeric, letter grade, or graphic symbol grading table and set the 

common options. Refer to the following topics for details:

• “Adding and Editing Numeric Grading Tables” on page 27

• “Creating and Editing Letter Grade Grading Tables” on page 29

• “Creating and Editing Graphic Symbol Grading Tables” on page 31

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading 
table

1 Select the grading table to delete. 

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading Table Name Enter a name up to 30 characters, such as “Participation Comments”. 

Short Name Enter an abbreviation up to 6 characters, such as “Partic”, This 
abbreviation is used when you create report cards.

Description If you want to describe the table and when to use it, enter a brief 
description.

Field Description

Max no. of 
Comments

Enter a number that represents the maximum number of comments that 
a grade item can receive.

Comments Are 
Mandatory

When you select this checkbox, if no comments have been entered, the 
Missing Grades report displays the narrative comment grades as 
“Missing”.
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2 On the Edit Grading Table page, under Special Grades, create grades for special 
circumstances – such as incomplete, medical exemption, exempt, and so on – as follows:

3 To add additional rows, from the Actions menu, click Add Rows to Special Grades.

4 Click OK.

Field Description

Input Grade Enter up to 3 characters that staff will use to enter this grade. For 
example, enter “I” so that staff can press the I key to enter an 
incomplete grade.

Reporting Grade Click on a blank row and, from the dropdown, select Same to display the 
Input Grade on the report card or select one of the other options 
(Checkmark, Happy Face, Neutral Face, Sad Face, Blank space) as 
appropriate. For example, select Same to display “Inc” (Incomplete) for 
the “Inc” grade.

P/F If you want to indicate whether the grade is considered a passing or 
failing grade, select P or F. For example, select F to indicate that 
Incomplete is a failing grade.

% Credit Not applicable to elementary grading.

Description in 
Legend

Enter a description of the grade, such as “Incomplete”. On the report 
card, the description will appear in the legend next to the grade, such as 
“Inc Incomplete”.
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Understanding Elementary Grading 
Periods
Before you can create report cards and progress reports, you must define the date ranges 
that they cover. These date ranges are called grading periods. Common grading periods are 
6-week periods and 9-week periods (also known as quarters). 

In Chancery SMS, grading periods are defined in sets, enabling you to stagger grading 
periods by grade levels. The grade levels that you can choose from are defined on the Grade 
Levels Setup page. Grading periods affect what grade levels a given report card applies to, 
because a grading period set is linked to one or more grade levels in the school. 

Whatever way you choose to configure the grading periods, ensure that all of the grade 
levels in your school are included in a grading period set. For information about grade levels, 
see “Choosing Grade Levels” in the Chancery SMS School Setup Guide.

The following are examples of sets of grading periods that include progress reports:

Kindergarten

Grades 1 to 5

Defining Elementary Grading Periods
Grading periods are defined in sets. Typically, you create multiple grading periods sets so 
that you can provide report cards at different times for different grades. 

NOTE

Once you cover all the grades in your school, you can’t create more grading period sets unless you 
delete an existing one first.

When you define grading period sets, you can also specify a grace period for entering student 
grades. The grace period is the number of days past the last date of all grading periods that 
staff can continue to enter or submit grades. The grace period is not connected to past 
grades.

To add or edit grading periods:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 3, click Grading Periods.

Report Card Progress Report

 Name End Date Name End Date

First Interim Report Oct. 15 First Progress Report Nov. 14

Second Interim Report Dec. 22 Second Progress Report Feb. 1

Report Card Progress Report

 Name End Date Name End Date

First Interim Report Oct. 5 First Nine Weeks 
Progress Report

Nov. 4

Second Interim Report Dec. 14 Second Nine Weeks 
Progress Report

Jan. 27
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3 On the Grading Periods page, in the Grace Period field, enter how many days staff can 
continue entering or submitting grades after the last date of each grading period.

NOTE

The grace period you enter here applies to all grading periods in all grading period sets.

4 Do one of the following:

5 On the Add/Edit Grading Period Set page, define the entire set as follows:

6 In the Grading Periods panel, define grading periods as follows:

If you need more rows, from the Actions menu, click Add Rows.

7 Click OK.

8 Repeat Steps 5 to 7 for each grading period you need to add or edit in the set.

To Do this

Add a set • From the Actions menu, click Add Grading Period Set. 

Delete a set 1 Select the grading period set to delete.

2 From the Actions menu, click Delete Grading Period Set.

3 Click OK and skip the remaining steps.

Edit a set • Click the name of a set. 

Field Description

Set Name Enter a meaningful name for the set of grading periods, such as 
“Grade 3 Grading Periods”.

Grade Levels Select the grade levels that this set applies to. If you do not 
select all of the grade levels, ensure you create additional sets 
for the remaining grade levels. The grade levels available are 
those that are not already covered by other grading period sets.

Field Description

Type Click in the first blank row and, form the dropdown, select 
whether this grading period appears on a progress report or a 
report card.

Grading Period Name Enter the name of the reporting period (such as Report Card 1 or 
Interim Report 1) as you want it to appear on reports.

Period Code Enter up to 3 characters to identify each period that is displayed 
on the report card as a column heading, for example “Q1”. 

End Date Enter the end date of each reporting period. The first period 
starts on the first school day of the school year, while each other 
period starts the day after the previous period end date.
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Setting Up Elementary Report Cards
Once you have created your grading structure, you are ready to define report cards and 
progress reports. For information about creating the grading structure, see “Setting Up 
Elementary Standard Comments” on page 15, “Understanding Elementary Grading Tables” 
on page 19, and “Understanding Elementary Grading Periods” on page 37. 

You can create different report cards for different grade levels or have one report card for all 
grade levels; however, you cannot have more than one report card for each grade level. You 
need to be sure to cover all grade levels in your school. 

Once you’ve assigned a report card to a grade level, that grade level is no longer available for 
any other report card setup. For example, if your school has grade levels K-5, you could 
create a report card and assign it to grade levels 1, 2, 3, 4 and 5. You can then create a 
different report card and assign it to Kindergarten. When you set up the second report card, 
you only have the option to select Kindergarten because all other grade levels have already 
been assigned a report card.

At elementary schools, you can use the same design for progress reports and report cards or 
you can create a different design for progress reports with different report elements. In 
addition, if initially you have a different progress report than report card, and then later 
choose to use the same design for both, the progress report, with all its report elements, is 
deleted and only the report card is used.

The rules for report cards also apply to progress reports; therefore, each grade level can be 
assigned only one progress report and one report card.

The grade levels you can choose from are defined on the Grade Levels Setup page. For 
information about grade levels, see the Chancery SMS School Setup Guide.

Selecting Common Report Card Elements
For elementary report cards and progress reports, you can have common elements, such as 
signatures and attendance summaries, appear on all the school’s report cards and progress 
reports.

These common elements apply even if you set up multiple report cards for different grade 
levels.

To select common report card elements:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 4, click Common Elements.

3 On the Common Elements page, select the elements you want to appear on all of the 
school’s report cards and progress reports.

NOTE

You can specify one set of common elements for all report cards and another set of common 
elements for all progress reports.

Element Description

Grading table legend Select to include the legend to help readers interpret the grades 
on report cards and progress reports.

Attendance summary Select to include a daily attendance summary on each student’s 
report card or progress report.
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4 Click OK.

Adding and Editing Elementary Report Cards/Progress 
Reports
Once you have defined the common elements that you want to appear on all report cards, 
you are ready to create the report card/progress report template. Each grade level at your 
school can be assigned only one progress report and one report card

To add or edit a report card/progress report:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 5, click Report Card and Progress Report Setup.

3 On the Report Card Setup page, do one of the following:

4 On the Add/Edit Report Card page, define the report card as follows:

Parent/Guardian comment 
area

Select to include a comment area where parents or guardians 
can write comments after reviewing the report card or progress 
report. 

Signature area Select to include signature lines for Principal, Teacher, and/or 
Parent/Guardian.

To Do this

Add a report card • From the Actions menu, click Add Report Card. 

Delete a report card 1 Select the report card to delete.

2 From the Actions menu, click Delete Report Card.

3 Click OK and skip the remaining steps.

Edit a report card • Click the name of the report card. 

Field Description

Report Card Name (not 
available on Progress 
Report)

Enter the report card name the way you want it printed on the 
report card. If you are working on a progress report, this field is 
not available.

Grade Level Select the grade levels this report card is for. The only grade 
levels available are those that are not already assigned to a 
report card/progress report.

When you select a grade level, the page refreshes and the Report 
Card Content area displays the subjects and elements that are 
assigned to that grade level in the subject framework.

NOTE
Only subjects that have the Can Schedule checkbox selected on their Subject 
page display. For more information, see the Chancery SMS Scheduling Guide 
available from the Pearson Customer Support website.

Element Description
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When you select a grade level, the page refreshes and the Report Card Content area 
displays the subjects and elements that are assigned to that grade level in the subject 
framework.

5 In the Overall Report Card Period Comments panel, indicate whether staff are to enter 
overall grading period comments.

6 Enter the maximum number of characters that staff can enter for overall comments.

7 If you want missing comments to appear on the Missing Grades report as “missing”, 
select “Overall comments are mandatory”.

8 If you want overall comments to print on a new page, select “Print on a New Page”.

9 In the Report Card Content panel, in the Grading Table column, select the Grading Table 
that will be used for each subject and element. 

The following table lists which grading tables can be associated with each report card 
item type.

Progress Report Name If your school uses progress reports, enter the progress report 
name the way you want it printed on the progress report.

Progress Report Content 
Same as Report Card

If you want the progress report to have a different structure than 
the report card, clear this checkbox. For information about 
making progress reports that are different from report cards, see 
“Working with Elementary Progress Reports” on page 44.

NOTE
When you clear this checkbox, the report card and progress report become 
two separate reports with different report elements (provided grades have 
not been entered). If you select this checkbox later, the progress report, with 
all its report elements, is deleted and only the report card is used. This 
checkbox cannot be changed once grades have been entered for the 
specified grade levels.

Item Grading Tables

Subject Numeric, Letter Grade, Graphic Symbol

Element Numeric, Letter Grade, Graphic Symbol

Skill Numeric, Letter Grade, Graphic Symbol, Standard Comments, 
Narrative Comments

Measure Numeric, Letter Grade, Graphic Symbol, Standard Comments, 
Narrative Comments

Field Description
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If you created a numeric grading table and set the Equivalent Grade Type to Letter Grade 
or Graphic Symbol, the Grade Item Display setting indicates how the grade for the 
subject, element, skill, or measure will appear on the progress report. The default is 
Numeric but you can change this to Letter Grade or Graphic Symbol, depending on what 
you chose as the equivalent grade type.

For more information about grading tables, see “Selecting a Grading Table Type” on 
page 19.

Indicates how the 
entered grade will 
appear on the report 
card. 

Subjects and elements from the 
subject framework.

Measures are used to rate 
achievement or effort. Pause your 
cursor over the icon to see what is 
being measured.

Skills are used as evaluation criteria 
for subjects or elements.

Sections are used to evaluate areas 
that fall outside of scheduled 
subjects and elements.

Descriptions make it easier to 
interpret the report card.

Headers and footers are used to 
format the report by adding general 
descriptions or white space.
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10 Add skills and measures as follows:

11 Add sections, descriptions, headers, and footers to enhance the layout:

Report Card Section Description

Skill Skills are a set of evaluation criteria for a subject or element, 
such as Comprehension or Expression skills for Reading. To add 
one or more skills to a subject or element:

1 Select the subject or element.

2 From the Actions menu, click “Add Skill(s) for the selected 
item”.

3 On the Add Skill page, in the Item Description fields, enter 
each skill.

4 Select a Grading Table. Click OK.

Measure Define one or more measures for any level in your subject 
framework. For example, an Effort measure and an Achievement 
measure can be collected for subjects, elements, and skills. To 
add a measure:

1 Select the item.

2 From the Actions menu, click “Add Measure for the selected 
item(s)”.

3 On the Add Measure page, the “For” field defaults to the item 
being measured. In the Item Description field, enter a 
description of the measure.

4 Select a grading table. Click OK.

NOTE
If your school uses K12Planet, define the following measures: Work Habit, 
Citizenship, and Comment. Each of these measures must be associated with a 
Standard Comment type grading table.

Report Card Section Description

Section Create additional sections for areas to be graded that fall outside 
of scheduled subjects and elements, such as Work Habits, or a 
Special Services section for ESL, Speech or Language support, or 
Occupational Therapy. To add a section:

1 Select the subject or section you want the section to follow.

2 From the Actions menu, click “Add Section after the selected 
item”. 

3 On the Add Section page, enter a description. Click OK.

Description Enter descriptions to help make it easier to interpret report 
cards. You can enter descriptions for any subject, element, or 
section. To add a description for an item:

1 Select the item

2 From the Actions menu, click “Add Description for the selected 
item”. 

3 On the Add Description page, enter a description. Click OK.
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12 To change the order of grading elements, such as subjects, elements, and measures:

• From the Edit menu, click Change Order. 

• Click the item you want to move and use the up and down arrows. Click OK.

NOTE

If you highlight and move a subject, any associated elements or measures are also moved. If you 
highlight an element or measure, you only change the display order as it relates to the associated 
subject.

13 Click OK.

Working with Elementary Progress Reports 
When you create report cards, you automatically create identical progress reports. You can 
make the progress report different from the report card by:

• Entering different Overall Report Card Period Comments

• Selecting different Grading Tables for subjects, elements, skills, and measures

• Creating different sections, headers, footers, and descriptions

You can also change the common elements, such as Grading Table Legend, Attendance 
Summary Parent Guardian Comment, and the Signature Area for all progress reports. See 
“Selecting Common Report Card Elements” on page 39.

You cannot change the subjects, elements, measures, and skills of a progress report and/or 
change the order of these items. They must be exactly the same as the report card. However, 
you can remove a subject, element, measure, or skill from the progress report by setting its 
Grading Table to None.

Header Use headers to include a short description to summarize an area. 

For example:

Required, non-academic courses:

• Physical Education

• Team Sports

To add a header:

1 Select an item.

2 From the Actions menu, click “Add Header for the selected 
item”. 

3 On the Add Header page, enter a description. Click OK.

Footer Use footers to add white space to the layout. For example, insert 
a footer between a subject and a section, so that it is clear that 
the subject and section are unrelated. To add a footer:

1 Select an item.

2 From the Actions menu, click “Add Footer for the selected 
item”.

3 On the Add Footer page, enter a description. Click OK.

Report Card Section Description
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To work with progress reports that are not the same as report cards:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 5, click Report Card and Progress Report Setup.

3 On the Report Card Setup page, do one of the following:

4 On the Edit Progress Report page, in the Progress Report Name field, enter the progress 
report name the way you want it printed on the progress report.

5 In the Overall Progress Report Period Comments panel, if you want missing comments to 
appear on the Missing Grades report as “missing”, select “Overall comments are 
mandatory”.

6 If you want overall comments to print on a new page, select “Print on a New Page”.

7 Under Progress Report Content, select the Grading Table that will be used for each 
subject, element, skill, and measure.

The following table lists which grading tables can be associated with each progress report 
item type.

To Do this

Create a progress report 
that is different from the 
report card

1 Click the name of the corresponding report card.

2 On the Edit Report Card page, deselect Same as Report Card. 
Click OK.

3 On the Report Card Setup page, in the Progress Report Setup 
column, click the name of the progress report you just created.

Delete a progress report 
that is different from the 
report card

1 Click the name of the corresponding report card.

2 On the Edit Report Card page, select Same as Report Card. 
Click OK. The progress report is deleted.

Edit a progress report that is 
different from the report 
card

• Click the name of the progress report. 

Item Grading Tables

Subject Numeric, Letter Grade, Graphic Symbol

Element Numeric, Letter Grade, Graphic Symbol

Skill Numeric, Letter Grade, Graphic Symbol, Standard Comments, 
Narrative Comments

Measure Numeric, Letter Grade, Graphic Symbol, Standard Comments, 
Narrative Comments
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NOTE

If your school uses K12Planet, define the following measures: Work Habit, Citizenship, and 
Comment. Each of these measures must be associated with a Standard Comment type grading table.

If you set Grading Table to None, the subject, element, skill, or measure does not appear 
on the progress report. You cannot add or delete subjects, elements, skills, or measures, 
or change their order.

If you created a numeric grading table and set the Equivalent Grade Type to Letter Grade 
or Graphic Symbol, the Grade Item Display setting indicates how the grade for the 
subject, element, skill, or measure will appear on the progress report. The default is 
Numeric but you can change this to Letter Grade or Graphic Symbol, depending on what 
you chose as the equivalent grade type.

.

For more information about grading tables, see “Selecting a Grading Table Type” on 
page 19.

To prevent an item from 
appearing on the progress 
report, set Grading Table to 
None.

Indicates how the 
entered grade will 
appear on the progress 
report. 
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8 Add descriptions, sections, headers, and footers to enhance the layout.

9 Click OK.

Report Card Section Description

Section Create additional sections for areas to be graded that fall outside 
of scheduled subjects and elements, such as Work Habits, or a 
Special Services section for ESL, Speech or Language support, or 
Occupational Therapy.

NOTE
Special Services aren’t graded on report cards. Instead, create a grading 
table entry with a Yes code and a blank code.

To add a section:

1 Select the item that you want the section to follow.

2 From the Actions menu, click “Add Section after the selected 
item”.

3 On the Add Section page, enter a description, and then click 
OK.

Description Add descriptions for subjects, elements, or sections to make it 
easier to understand them. To add a description for an item:

To add a description:

1 Select the item.

2 From the Actions menu, click “Add Description for the selected 
item”.

3 On the Add Description page, enter a description. Click OK.

Header Use headers to include a short description to summarize an area. 
In the following example, the header introduces a list of skills:

The student writes clearly

• Stays on topic

• Organizes writing

To add a header:

1 Select an item.

2 From the Actions menu, click “Add Header for the selected 
item”.

3 On the Add Header page, enter a description. Click OK.

Footer Use footers to add white space to the layout, such as between a 
subject and a section.

To add a footer:

1 Select an item.

2 From the Actions menu, click “Add Footer for the selected 
item”.

3 On the Add Footer page, enter a description. Click OK.
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Secondary Grading Setup
The following steps illustrate how the completed grading setup tasks flow through to the 
running of the actual report cards or progress reports for secondary schools.

Step 1: Set Up Standard Comments and Categories
Create standard comments and standard comment categories to capture comment-type 
grades for students. For information about creating standard comments, see “Setting Up 
Secondary Standard Comments” on page 59

Step 2: Set Up Grading Tables for All Grade Levels
Define grading tables to specify the format and meaning of grades that students receive on 
their report cards. A grading table legend appears on the report card to help readers 
interpret the grades. For information about creating grading tables, see “Defining Secondary 
Grading Tables” on page 65.

NOTE

Standard Comment and Narrative Comment grading tables cannot be used to calculate GPAs for report 
cards. 
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Step 3: Set Up Grade Items to be Collected in Grading 
Periods
Grade items are ways that your school measures student performance. Create grade items to 
be taken into consideration for student performance in a course. Examples of grade items are 
effort, conduct, semester exams, and semester grades. For information about creating grade 
items, see “Defining Grade Items” on page 64.

Step 4: Set Up Grading Periods
Create grading periods to define the span of time that report cards and progress reports 
cover. For information about creating grading periods, see “Defining Secondary Grading 
Periods” on page 93.
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Step 5: Set Up Grading Properties for Courses
Course grading properties determine the grading table to be used for a grade item for a 
particular course, which grade items appear on report cards, what grades will be kept for 
historical purposes, if credit is awarded, if the grade will be used in calculating cumulative 
GPAs, the number of credits the course is worth, the adjustment factor, and the grading 
period set to which the course belongs. 

For information about setting up course grading properties, see “Defining the Grading 
Properties of a Course” on page 99.
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Step 6: Set Up Calculations
Grade calculation formulas are assigned to existing grade items. Each grade calculation 
formula indicates which items contribute to the calculation, how they are weighted, how they 
should be treated when missing, and which courses they should be applied to. 

For information about setting up calculated grade formulas, see “Setting Up and Editing 
Grade Calculation Formulas” on page 97.
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Set Up Current Year and Cumulative GPA Definitions

Set up current year and cumulative GPA definitions to calculate grade point averages and 
have the results appear on report cards and transcripts.

For information about setting up the GPA definitions, see “Setting Up Grade Point Averages” 
on page 117.
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Set Up Class Rank Definitions

Set up Class Ranks definitions to determine the ranking of students based on the cumulative 
GPA.

For information about setting up class ranks, see “Adding and Editing Class Rank Definitions” 
on page 137.
. 
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Step 7: Create Report Cards & Set Up Transcripts
Report card and progress report templates determine how the reports will look when printed. 
To create a template, you define the following:

The report card elements:

The GPA type:

The report card columns and grading tables:
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The row headers:

For information about setting up report templates, see “Creating Secondary Report 
Cards/Progress Reports” on page 141.

Although transcript setup is not directly tied to grading setup, an accurate transcript is the 
ultimate goal of all secondary grading. At the same time that report cards are set up, set up 
transcript settings and columns as appropriate for your school. For more information about 
setting up transcripts at the school level, see “Setting Up Transcripts (School-Level)” on 
page 149.

Step 8: Enter or Import Historical Transcript Information
Before you run your grading calculations, enter or import information about students’ 
performance in past years, including courses and grades. Student historical grades are used 
in cumulative GPA calculations. For information about entering historical transcript 
information, see “Student Historical Transcript Information” on page 153

Step 9: Enter Grades and Perform Calculations
Enter grades for each student in a class. The columns on the Student Grades page 
correspond to the grade items set up in the course grading (Step 4). The grading period 
corresponds to the grading periods set up in Step 3. The legend for the grading table codes is 
displayed at the bottom of the screen. For more information about entering grades, see the 
Chancery SMS School User Guide available from the Pearson Customer Support website.

Once grades have been entered, return to the Grading page to run calculated grade, student 
credit, GPA, and class rank and honor roll calculations. For more information about 
performing calculations, see “Performing Grading Calculations & Overrides” on page 165.
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Step 10: Run Report Cards or Progress Reports
When you run report cards or progress reports, the grade items you defined in the report 
card and progress report setup (Step 6) print on the report. 

For more information about printing reports, see the Chancery SMS School User Guide 
available from the Pearson Customer Support website.

Before getting started, ensure you have the necessary permissions. See “Permissions to Set 
Up Secondary Grading & Enter Grades” on page 58.
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Permissions to Set Up Secondary Grading & Enter 
Grades
To set up grading and collect grades, you need the following permissions:

By default, the school administrator can perform all grading setup and collection tasks. For 
further information about permissions, contact your system administrator or see the 
Chancery SMS Permissions Guide.

To You need this permission Set to

Define standard comments School Setup>Standard Comments Delete

Define grading tables School Setup>Grading Tables Delete

Define grade items School Setup>Grade Items Delete

Define grading periods School Setup>Grading Period Sets Delete

School Setup>Define Report Card Periods Yes

School Setup>Define Progress Report Periods Yes

Define course grading properties School Setup>Course Grade Items Delete

Define GPAs School Setup>GPA Definitions Delete

Define class rank definitions School Setup>Class Ranks Delete

Define honor roll definitions School Setup>Honor Rolls Definitions Delete

Define report cards and progress 
reports

School Setup>Report Card Setup Delete

Edit grades entered by teachers Grading>Edit Grades from Other Teachers Yes

Enter or edit grades for any class 
(including grades entered during the 
specified grace period)

Grading>Enter Grades for All Classes Yes

Enter or edit past grades Grading> Modify Grades for Completed Periods Yes

Set up transcripts Transcript/Permanent Record>Transcript Grade 
Items

Delete

Override a student’s calculated class 
rank

Grading>Override Student Ranks Yes

Override a student’s calculated 
earned credits

Grading>Override/Recalculate Earned Credits Yes

Run calculations for calculated 
grades, student credits, and GPAs

Grading>Run Grade, Credit, and GPA Calculations Yes

Run calculations for class ranks Grading>Run Class Ranks Yes
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Setting Up Secondary Standard Comments
A standard comment is a sentence or two that teachers can re-use on any report card or 
progress report. 

Here are a few examples:

• “Making satisfactory progress”

• “Lack of attendance is affecting progress”

• “An enthusiastic participant”

• “Needs to participate more in class”

You do not need to set up standard comments, but they can be helpful. Instead of repeatedly 
typing the same comments, teachers can enter a standard comment with a click of the 
mouse. Typically, schools or districts have grading policies governing when standard 
comments can be used.

If you have many standard comments, you can create categories for them and group the 
comments into those categories. Categories are not required, but they make selecting 
comments for student evaluation faster and easier. You can categorize some, all, or none of 
the standard comments.

On the Standard Comments page, comments are sorted first by category and then by code. 
Comments that are not categorized appear first.

To use Standard Comments, you must set up a Standard Comments Grading Table. See 
“Creating and Editing Standard Comment Grading Tables” on page 87.

NOTE

If you want teachers to be able to enter unique comments, rather than standard ones, you can set up a 
narrative grading table. See “Creating and Editing Narrative Comment Grading Tables” on page 86.

Specifying Categories for Standard Comments
If you have many standard comments, you can create categories to group the comments. 

Categories have a full name and a short name consisting of no more than six letters. The 
short name appears on the Standard Comments page and describes each category of 
comments, so ensure the short name is as descriptive as possible.

You can create as many categories as you need. Later, if no comments are assigned to that 
category, you can delete or change the category.

To add or edit categories for standard comments:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 1, click Standard Comment Categories.
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3 On the Standard Comment Categories page, do any of the following:

4 Click OK.

Defining Standard Comments
You can create as many standard comments as you need. Later, if the comment has not been 
used on a report card or progress report, you can delete or change it.

To add or edit standard comments:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 1, click Standard Comments.

3 On the Standard Comments page, do the following:

To Do this

Add a category 1 If all rows are used, from the Actions menu, click Add Rows.

2 In the first empty row, under Standard Comment Category 
name, enter the name of the category that you want to 
create.

3 Under Short Name, enter a short name of no more than 6 
characters. 

NOTE
Make the short name as descriptive as possible because it appears on the 
Standard Comments page as a description of the category.

Delete a category 1 Select the category to delete. 

2 From the Actions menu, click Delete Row.

Edit a category • Click the category and enter the changes.

To Do this

Show only comments in a 
specific category

• From the View dropdown, select a category.

Add a comment 1 From the Actions menu, click Add Comments.

2 On the Add Comments page, if you want to assign the 
comment to a category, select a category in the Comment 
Category dropdown.

3 For each comment you want to add, enter a unique 
4-character code for the comment and then enter the 
complete comment text as it will appear on the report card.

4 If you want to add more comments, click “Save+Add”.

5 Click OK.

Delete a comment 1 Select the comment to delete.

2 From the Actions menu, click Delete. 

Edit a comment • Click the comment and enter the changes.
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4 Click OK.

To use the standard comments, set up a standard comment grading table to link to 
appropriate grade items. See “Creating and Editing Standard Comment Grading Tables” 
on page 87.
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Setting Up Grade Items
Grade items are ways that your school can measure student performance. Examples of grade 
items include:

• Conduct

• Effort

• Comments

• Quarter or semester grades

• Semester or final exams

• Course grade (this is a built-in grade item)

By entering grade items on the Grade Items page, you create a schoolwide pool of items for 
which grades may possibly be reported, and identify how each item will be graded by 
assigning it a grading table.

For example, if you want to display overall comments for the grading period, define a grade 
item called Comments and assign a narrative comment grading table or a standard comment 
grading table.

If you plan to collect grades for the same grade item in multiple grading periods, set up a 
single grade item and assign it to each applicable grading period. 

IMPORTANT NOTE

Do not create a separate grade item for each grading period. The numerous grade items produced when 
you create individual grade items for each grading period slows performance when you enter student 
grades. In addition, the generic report card displays a maximum of thirteen grade items.

For example, if you want to collect semester exam grades in quarter 2 and quarter 4, create 
a grade item called Semester Exam, then assign the grade item to a grading table, such as a 
numeric grading table that displays percentage grades. Later, when you define grading 
period sets, you can apply this grade item to each semester and assign it to both the quarter 
2 and quarter 4 grading periods. 

The collection of items that you create on the Grade Items page does not determine what 
appears on report cards; rather, when you define grading period sets, you select which grade 
items from this collection you want to appear on the report card for each grading period. for 
further information, see “Defining Secondary Grading Periods” on page 93.

“Course grade” is a built-in grade item that you cannot remove. You must define what 
grading table a course grade will use.
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NOTE

The grading table to which you assign a grade item can be changed when the grade item appears in a 
particular course. For example, you can set up a semester grade item that has a letter grade grading 
table. You can then change this grading table for courses such as Physical Education that you want to 
grade as pass/fail. For details about how to change the grading table for a course grade item, see 
“Defining Course Grading Properties” on page 99.

Defining Grade Items
Grade items must be defined for any grades you want to capture. Do not create a separate 
grade item for each grading period; too many grade items slow performance when you enter 
student grades. Instead, create one grade item that can be applied to each grading period. 
For further information, see “Setting Up Grade Items” on page 63.

To add or edit grade items:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 3, click Grade Items.

3 On the Grade Items page, do one of the following:

4 Define each grade item as follows:

5 Click OK.

To Do this

Add a grade item • Use the first available row. If there are no empty rows, from 
the Actions menu, click Add Rows. 

Delete a grade item 1 Select the grade item.

2 From the Actions menu, click Delete Row.

3 Click OK and skip the remaining steps.

Edit a grade item • Edit the settings in the row.

Field Description

Grade Item Name Enter a name for the grade item. This name is shown when the 
grade item is displayed as a row (e.g., on a report card).

Short Name Enter up to six characters as an abbreviation of the grade item. 
This name is shown as the column header when the grade item 
is displayed as a column (e.g. on a report card).

Use in Current Year 
Calculations

If you want to use this grade item in GPA definitions, select Yes; 
otherwise, select No.

Grading Table Select a grading table that will define the possible grades that 
teachers can enter for this grade item by default. This grading 
table can be changed at the course level. 
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Defining Secondary Grading Tables
Grading tables define the format and meaning of the grades and GPAs that students receive 
on their report cards. 

You need to create a grading table for each way that you will capture grades. For example, 
courses might be graded as percentages or as letter grades. Conduct or participation may be 
graded using teacher comments. A GPA might be graded using grade points on a 4.0 scale.

You can create different versions of the same grading table to accommodate different course 
difficulty levels (e.g., remedial, honors, advanced placement) and allow marks to be valued 
differently, based on the course level.

The core purpose of a grading table is to list all the possible grades a student can receive and 
the meaning of each grade. Grading tables can also identify:

• Conversions from one format to another, such as percentages to letters

• The credit value of each grade (e.g., a failing grade typically means the students earns 
0% of the possible credit for the course)

• Whether a grade is a pass or a fail

• The numeric or grade point equivalent of numeric grades, letter grades, and symbols so 
that these grades can be used in calculations, such as calculated grades and GPAs

• The different grade points available for numeric, letter, or graphic symbol grades earned 
in courses of different difficult levels (e.g., honors, advanced)

Grading tables appear as legends on report cards to help readers interpret the grades. Since 
a report card often includes items with different grading tables, report cards often display 
multiple grading table legends.

You can choose from five types of grading tables. The type of grading table is determined by 
how the grade is entered, not how it is displayed on the report card. For more information, 
see “Selecting a Grading Table Type” on page 65.

You can also enter a numeric grade scale that allows you to manage bonus points and specify 
equivalent numeric values or grade points for multiple course levels, as required, so that you 
can set up your GPA definitions to use the appropriate method of calculating your GPAs. See 
“Setting Up for Bonus Points” on page 74 and “Setting Up for GPA Calculations (including 
Course Leveling)” on page 75.

In addition, you can add special grades, such as “Incomplete” or “Exempt”, to all grading 
tables. See “Adding Special Grades to Grading Tables” on page 88.

Selecting a Grading Table Type
Grading tables provide the flexibility to enter grades in several ways and either show them as 
they were entered or convert the grades to other forms on report cards.

With Chancery SMS grading tables, you can:

• Enter numbers that are converted to letter grades or symbols and equated to grade point 
values for calculations.

• Use scales such as percentages, 4-point scale, or 12-point scale.
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• Enter letter grades in any format you design, such as A, B, C, D, and F, or G, S, and N for 
Good, Satisfactory, and Needs Improvement. 

• Enter comments for conduct or participation grades, or enter codes that are shown as 
symbols, such as ☺, ., /.

To get such a wide range of options, grading tables are divided into five different types. 
These types correspond to the way you enter grades, not how the grades appear on the 
report card. 

The five types of grading tables are summarized in the following table:

The following table shows the options available for entering and displaying grades, along with 
the required grading table settings:

Grading Table Type Description

Letter Grade Grades entered as letters will appear on the report card as 
letters.

Numeric Grades entered as numbers are either left as is or converted 
so that they appear as letter grades or graphic symbols on 
the report card.

Graphic Symbol Grades entered as codes will appear on the report card as 
graphic symbols, such as “H” for ☺.

Narrative Comment Grades entered as free form text.

Standard Comment Grades selected from a list of predefined options.

Grades on Report Cards Grading Table Type

Letters, such as A, B, C, D, F or G, S, 
N

To enter letter grades that appear as letter grades on the 
report card, set the Type to Letter Grade.

To enter numbers that appear as letter grades on the report 
card, set Type to Numeric and then set Equivalent Grade 
Type to Letter Grade.

For further information, see “Letter Grade Grading Table – 
Enter Letters and Display Letters” on page 71.

Numbers, such as percentages or 
1.0, 2.0, 3.0

To enter numeric grades and display them as numeric on the 
report card, set Type to Numeric and then set Equivalent 
Grade Type to None.

For further information, see “Numeric Grading Table – Enter 
Numbers and Display Numbers” on page 67.

Graphics, such as ☺, ., / To enter and display a code, such as “H,” as a graphic symbol 
on the report card, set Type to Graphic Symbol. 

To enter grades as numbers that appear as symbols on the 
report card, set Type to Numeric and then set Equivalent 
Grade Type to Graphic Symbol.

For further information, see “Numeric Grading Table – Enter 
Numbers and Display Symbols” on page 70
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Numeric Grading Table – Enter Numbers and Display 
Numbers 
To enter grades as numbers and display them as numbers on the report card, set Type to 
Numeric and Equivalent Grade Type to None.

Percentages

If you enter grades as percentages, use a grading scale of 100 and a numeric grade input 
range of 0 to 100.

NOTE

If you want to award bonus points, make the upper input range greater than 100 (e.g. 110). For more 
details, see “Setting Up for Bonus Points” on page 74.

Comments To enter and display free-form comments, set Type to 
Narrative Comments.

For further information, see “Creating and Editing Narrative 
Comment Grading Tables” on page 86

To enter comments by selecting from a set of predefined 
comments, set Type to Standard Comments.

For further information, see “Defining Standard Comments” 
on page 60.

Grades on Report Cards Grading Table Type
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In the Lower Cutoff column, enter the lowest mark required to earn the grade. 

NOTE

The marks you enter in the Lower Cutoff column must be of the same format as the scale you entered in 
the Grading Scale field. For example, if you enter a grading scale of 100, you must enter lower cutoff 
marks between 0 and 100.

If you want to report on passing and failing grades, in the P/F column, select P (for pass) or 
F (for fail).

In the % Credit column, enter the percentage of credit that should be awarded for this grade.

In the Description in Legend column, describe the meaning of the grade.

4-Point Scale

If you enter grades on a 4-point scale, use a grading scale of 4 and a numeric grade input 
range of 0 to 4.
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In the Lower Cutoff column, enter the lowest mark (from 0 to 4) required to earn the grade.

NOTE

The marks you enter in the Lower Cutoff column must be of the same format as the scale you entered in 
the Grading Scale field. For example, if you enter a 4-point grading scale, you must enter lower cutoff 
marks between 0 and 4.

If you want to report on passing and failing grades, in the P/F column, select P (for pass) or 
F (for fail).

In the % Credit column, enter the percentage of credit that should be awarded for this grade.

In the Description in Legend column, describe the meaning of the grade.

Numeric Grading Table – Enter Numbers and Display 
Letters
To enter grades as numbers and display them as letters on the report card, set Type to 
Numeric and Equivalent Grade Type to Letter Grade.

Set up the grading scale and numeric grades input range as appropriate for percentages or 
grade points.
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In the Lower Cutoff column, enter the lowest mark required to earn the grade. 

In the Letter Grade column, enter the equivalent letter grade. 

NOTE

If you plan to use calculated grades, you must set up grade points. Calculated grades and GPAs use grade 
points to determine the value of the letter grade. For further information, see “Grade Calculations for 
Semester Grade Averages” on page 97 and “Setting Up Grade Point Averages” on page 117. 

If you want to report on passing and failing grades, in the P/F column, select Pass (for pass) 
or F (for fail). 

In the % Credit column, enter the percentage of credit that should be awarded for this grade.

In the Description in Legend column, describe the meaning of the grade. 

Numeric Grading Table – Enter Numbers and Display 
Symbols
To enter grades as numbers and display them as symbols, set Type to Numeric and 
Equivalent Grade Type to Graphic Symbol.

Set up the grading scale and numeric grades input range as appropriate for percentages or 
grade points.
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In the Lower Cutoff column, enter the lowest mark required to earn the grade. In the Graphic 
Symbol column, select the equivalent symbol. 

If you want to report on passing and failing grades, in the P/F column, indicate if the grade is 
a pass or fail. 

In the % Credit column, enter the percentage of credit that should be awarded for this grade.

In the Description in Legend column, describe the meaning of the grade.

Letter Grade Grading Table – Enter Letters and Display 
Letters
To enter letters and display letters on the report card, set Type to Letter Grade.

Enter the appropriate letters in the Letter Grade column. 

In the Lower Cutoff column, enter the lowest mark required to earn the grade. 

If grades will be transferred in from Gradebook, define the Grbk % Cutoff (this value can be 
different from the Lower Cutoff value, if required). 

NOTE

If you plan to use calculated grades, you must set up grade points. Calculated grades and GPAs use grade 
points to determine the value of the letter grade. For further information, see “Grade Calculations for 
Semester Grade Averages” on page 97 and “Setting Up Grade Point Averages” on page 117. 
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If you want to report on passing and failing grades, in the P/F column, indicate if the grade is 
a pass or fail. 

In the % Credit column, enter the percentage of credit that should be awarded for this grade.

In the Description in Legend column, describe the meaning of the grade. 

Graphic Symbol Grading Table – Enter Codes and Display 
Symbols
To display symbols, such as a faces or checkmarks, on the report card, set Type to Graphic 
Symbol.

In the Input Grade column, enter up to three characters that staff will use to enter this 
grade. 

In the Reporting Grade column, select the symbol to show on the report card. 

If grades will be transferred in from Gradebook, define the Grbk % Cutoff (this value can be 
different from the Lower Cutoff value, if required). 

NOTE

If you plan to use calculated grades, you must set up grade points. Calculated grades and GPAs use grade 
points to determine the value of the letter grade. For further information, see “Grade Calculations for 
Semester Grade Averages” on page 97 and “Setting Up Grade Point Averages” on page 117. 

If you want to report on passing and failing grades, in the P/F column, indicate if the grade is 
a pass or fail. 

In the % Credit column, enter the percentage of credit that should be awarded for this grade.

In the Description in Legend column, describe the meaning of the grade.
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Special Grades
To handle special circumstances, such as exemptions, incomplete courses, and grades that 
are not available, use the Special Grades area at the bottom of numeric, letter, or graphic 
symbol grading tables. 

In the Input Grade column, enter up to three characters that staff will use to enter this 
grade. 

In the Reporting Grade column, select the symbol to show on the report card. 

In the P/F column, indicate if the grade is a pass or fail. 

In the % Credit column, enter the percentage of credit that should be awarded for this grade. 

In the Description in Legend column, describe the meaning of the grade. 
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Setting Up for Bonus Points
When you create or edit numeric grading tables, you can set up your grade input ranges to 
accommodate awarding bonus points. The key fields involved are the Grading Scale field, the 
Numeric Grades Input Range fields and the Lower Cutoff column.

In the Grading Scale field, enter the value that acts as the denominator in all of the 
calculations relating to grades from this table. In the Numeric Grades Input Range field, you 
enter the lowest and highest grades a student can receive for a grade item that uses this 
table. 

When you set up bonus points, the maximum value in the Numeric Grades Input Range 
should be greater than the value in the Grading Scale field. 

If, for example, you are working with percentages and students are eligible for up to ten 
bonus points, enter a Grading Scale of 100 and a Numeric Grades Input Range of 0 to 110. In 
the Numeric Grading Table grid, add a row with a Lower Cutoff of 101 to accommodate all 
grades above 100%, and define all of the other settings as appropriate.

Use these 
fields to set up 
bonus points.
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Setting Up for GPA Calculations (including Course 
Leveling)
There are several GPA settings that affect how you should set up your grading tables. These 
GPA settings are:

• Calculation method

• Course level

• Current year GPA report card display

The Calculation Method you select when setting up your current GPA definition determines 
how the GPA will be calculated: 

• If you choose the “Use numeric values scaled to 100” method, the actual numeric values 
(or the lower cutoff equivalent for letter grades and graphic symbols) are divided by the 
appropriate scale and then multiplied by 100, which allows grades that use different 
grading tables to be averaged. 

• If you choose the “Use grade points” calculation method, each grade is converted to its 
equivalent grade point, as specified in the appropriate grading table.

Use these GPA 
fields to help 
you determine 
how to set up 
grading tables 
for GPA 
calculations.
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Where students receive different values for their grades based on the course level, course 
adjustment factors can be applied in a non-linear or linear way. Whether your school applies 
adjustment factors in a non-linear or linear way determines how the grading tables should be 
set up:

• If the course adjustment factor is non-linear (e.g., add 5% to every grade over 75%, but 
nothing to grades below 75%), the adjustment factors are applied in the grading tables; 
grading tables should be set up to accommodate the different levels. 

• If the adjustment is linear (e.g., add 5% to every grade), use the course adjustment 
factors in the GPA definition setup; no adjustment is required at the grading table level 
(however, the adjustment factor for the course must already be defined). 

The Display As setting in the GPA definition determines how the current year GPA will appear 
on the page and in reports after the calculation is complete: 

• If you select Equivalent Grade, the system converts the GPA to the equivalent grade 
specified in the selected grading table. 

• If you select Numeric value, the system leaves the existing numeric value of the GPA as 
is, rounded to the degree of precision specified in the Decimal Places dropdown. If the 
current year GPA is calculated using grade points, it is displayed in grade points. If the 
current year GPA is calculated using numeric values scaled to 100, it is converted to a 
value based on the scale of the grading table selected for the calculation results (most 
commonly a percentage).

To support these options, numeric, letter grade, and graphic symbol grading tables have 
multiple columns where relevant information can be entered. 

Numeric grading tables include the following columns to support GPAs:

• Lower Cutoff – Enter the Lower Cutoff for all numeric grading tables, regardless of what 
settings you are using for your GPA definition. 

• Level Adjustment – If you are using the “Use numeric values scaled to 100” calculation 
method to calculate your GPA, and want to apply non-linear course adjustment factors, 
enter the adjustment factor in this column. This column is only available for course levels 
other than “Regular”.

• Letter Grade – If you selected “Display as equivalent grade” in your GPA definition, and 
are setting the equivalent grade type to Letter Grade, enter the equivalent grade in this 
column.
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• Grade Points – If you are using the “Use grade points” calculation method to calculate 
your GPAs, enter the grade point equivalent in this column.

• Graphic Symbol – If you selected “Display as equivalent grade” in your GPA definition, 
and are setting the equivalent grade type to Graphic Symbol, enter the equivalent grade 
in this column.

Letter and graphic symbol grading tables include the following columns to support GPAs:

• Letter Grade or Graphic Symbol – Enter the Letter Grade or Graphic Symbol for all letter 
grade and graphic symbol grading tables, regardless of what options you are using for 
your GPA definition.

• Lower Cutoff – If you choose “Display as equivalent grade” in your GPA definition, which 
converts your GPA back into a letter grade or graphic symbol, enter the lower cutoff 
values in this column. Ensure that you use the same scale for these values as the scale in 
the GPA definition.

• Grade Points – Enter the equivalent values in the Grade Points column regardless of 
whether you choose the “Use numeric values scaled to 100” or “Use grade points” 
method.

If you intend to set up GPA definitions using both calculation methods, you may need to set 
up more than one Letter Grade grading table.

For more information about setting up GPA definitions, refer to “Setting Up Grade Point 
Averages” on page 117.
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Adding and Editing Numeric Grading Tables
With Numeric Grading Tables, you can choose to enter grades as numbers and have them 
display as numbers on the report card or you can set up the grading table so that numeric 
grades can be entered as numbers but display as letters or graphic symbols on the report 
card. For further information, see “Selecting a Grading Table Type” on page 65.

All numeric grading tables display a Regular course level. If your school offers courses with 
different difficulty levels (e.g., remedial, honors), different levels appear in the grading table. 

If the marks for these courses are valued differently than the regular level courses, you 
select a level adjustment factor (add or multiply) and then specify the level adjustment for 
the level. 

To add or edit a numeric grading table:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the Type dropdown, select Numeric.

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading table 1 Select the grading table to delete. 

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading table name Enter a name of up to 30 characters, such as “Numeric Grades 8-
10”. This name is shown when you enter grades.

Short name Enter an abbreviation up to six characters, such as “N810”. This 
abbreviation appears when you set up course grading properties. 
For more information, see “Defining the Grading Properties of a 
Course” on page 99.

Description If you want to describe the table and when to use it, enter a brief 
description.
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6 Define the overall properties for the numeric grading table as follows:

Field Description

Max no. of Digits Select the maximum number of digits that teachers can enter. 
For example, “3” to permit up to three digits.

Decimal Places Select the number of digits that indicates how many of the Max 
No. of Digits appear to the right of the decimal point, such as “1” 
for grades like “3.5”.

For example, if you enter “3” for Max No. of Digits and “1” for 
Decimal Places, the maximum value possible is “99.9”.

Grading Scale Enter the maximum grade a student can receive without bonus 
points. This value is used as the denominator in all calculations 
using this grading table. For example, if you are assigning 
percent grades, this value would be 100, even if bonus points 
are permitted.

Numeric Grades Input Range Enter the minimum grade and a maximum grade that will be 
accepted, using only positive numbers. For example, “0 to 4.0” 
or “0 to 100”. If teachers give bonus points, ensure the upper 
limit accommodates it, for example, by entering “125” as the 
maximum rather than “100”.

Equivalent Grade Type Select one of the following:

• None – display the numeric grades exactly as they are 
entered. 

• Letter Grade – display the numeric grades as letters.

• Graphic Symbol – display the numeric grades as symbols. 

Level Adjustment Factor If you are working with course levels with different values for 
marks, select one of the following:

• Add – to adjust the grade, Chancery SMS will add the value 
entered in the Level Adjustment column to the numeric grade.

• Multiply – to adjust the grade, Chancery SMS will multiply the 
value entered in the Level Adjustment column by the numeric 
grade.

During initial set up of a grading table, when you select Add or 
Multiply, a Copy button appears that enables you to copy the 
Regular level version of the grading table to create a new 
version for other levels. You can then enter the level 
adjustments and make other changes as required.

NOTE
Level adjustment factors apply only to course levels other than Regular.
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7 For each grade you want to define in the grading table, complete the following fields, as 
appropriate:

Field Description

Lower Cutoff Enter the lowest mark required to earn the grade, such as “75”. 
The range of marks for the grade start at this value and go to 
the next highest grade (or to the maximum value for the 
“Numeric grade input range”, if it is the highest range of grades). 
For example, if the Lower Cutoff for the first row in the table is 
“80” and the second row is “60”, the range for the second row is  
60-79.9. This value is used only to determine the grade and is 
not shown on the report card. 

The marks you enter in the Lower Cutoff column must be of the 
same format as the grading scale you entered in the Grading 
Scale field. For example, if you enter a grading scale of 100 you 
must enter lower cutoff marks between 0 and 100.

NOTE
If you are using course leveling, the lower cutoff values can differ between 
different course level versions of the grading table.

Level Adjustment This column is only available if:

• Add or Multiply has been selected from the Level Adjustment 
Factor dropdown, and

• You are working with a course level other than Regular.

Enter the value by which the grade should be adjusted.

NOTE
Data is required in this column only if the GPA calculation method is “Use 
numeric values scaled to 100”.

Letter Grade If required, enter the equivalent letter for the numeric grade.

Grade Points If required, enter the grade point equivalent of the numeric 
grade. This value is used in calculations only; it is not displayed 
on the report card. 

Graphic Symbol If required, select the graphic symbol to display for the numeric 
grade.

P/F If you want to indicate whether the grade is considered a 
passing or failing grade, select P or F. For example, if the course 
requires 50% to pass, click F for all grades under 50%.

Use this column if you want to report on passing and failing 
grades.

% Credit If you want to award partial credit to students based on their 
grades, enter the percent of total credit that the student 
receives for this grade. For example, enter “100” for passing 
grades, “50” for grades that earn partial credits, and “0” for 
failing grades.

Description in Legend Enter a description of the grade, up to 15 characters long, that 
will appear in the legend on the report card. Ensure the 
description includes the grade itself, such as “3.0-4.0 Excellent”, 
“A 85-100”, or “Happy Face - Excellent”, not just the description.
80 Defining Secondary Grading Tables
Adding and Editing Numeric Grading Tables



Chancery SMS Grading Setup Guide
8 Do any of the following:

9 If you have selected a level adjustment factor, click Copy to copy the setup from the 
Regular course level version to other versions. 

OR

Click a course level link to manually enter information.

10 Click OK.

Adding and Editing Letter Grade Grading Tables
With Letter Grade Grading Tables, grades are entered as letters and appear on the report 
card as letters.

If you plan to use calculated grades, in addition to entering letter grades on the letter grade 
grading table, you must set up grade points and use a 100-point grading scale. Calculated 
grades and GPAs use grade points to determine the value of the letter grade.

All grading tables display a Regular course level. If your school provides courses with 
different difficulty levels (e.g., remedial, honors) additional levels will appear in the grading 
table. The grading table setup in each additional level is a copy of the grading table setup for 
the Regular level; you can make adjustments to the grading table setup of these other levels 
as required.

To Do this

Add rows to a grid • From the Actions menu, click Add Rows to > Grading Table.

NOTE
Rows will be added only to the active course level grid.

Set up special grades 
(e.g., incomplete, 
medical exemption, 
exempt, audit)

See “Adding Special Grades to Grading Tables” on page 88.
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To add or edit a letter grade grading table:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the Type dropdown, select Letter Grade.

6 In the Grading Scale field, enter the maximum value of any grade.

For example, enter “4” for a 4-point scale or “100” for a 100-point scale.

7 For each grade you want to define in the grading table, complete the following fields:

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading table 1 Select the grading table to delete.

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading table name Enter a name up to 30 characters, such as “Letter Grades 8-10”. 
This name is shown when you enter grades.

Short name Enter an abbreviation up to 6 characters, such as “L810”. This 
abbreviation displays when you set up course grading 
properties. For more information, see “Defining the Grading 
Properties of a Course” on page 99.

Description If you want to describe the table and when to use it, enter a 
brief description.

Field Description

Letter Grade Enter up to 3 characters that staff will use to enter this grade on 
a report card. For example, enter “A” so that staff can press the 
A key to enter this grade. 

Lower Cutoff If you want to use the grades in calculations such as GPA enter 
the lowest mark required to earn the grade, such as “75”. The 
range of marks for this grade start at this value and go to the 
next highest grade, with the Grading Scale determining the 
highest possible value.

For example, to average two grades, first use Num Equiv to get 
the values of the grades. Then average the values, and use 
Lower Cutoff to determine the grade of the result.

NOTE
The marks you enter in the Lower Cutoff column must be of the same format 
as the grading scale you entered in the Grading Scale field. For example, if 
you enter a grading scale of 100, you must enter lower cutoff marks between 
0 and 100.
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8 If your school offers courses of different difficulty levels that are graded differently than 
regular level courses, click a level and enter the appropriate grades.

9 Do any of the following:

10 Click OK.

Creating and Editing Graphic Symbol Grading Tables
With Graphic Symbol Grading Tables, grades are entered as codes and appear on the report 
card as graphic symbols. For example, teachers might enter “H” to display ☺.

Grbk % Cutoff If you use Gradebook, enter the percentage in Gradebook that 
students must earn to receive this grade in Chancery SMS.

NOTE
The Grbk % can be different than the lower cutoff mark, if required.

Grade Points If you want to use the grades in calculations such as GPA 
definitions where grade points are used, enter the number that 
represents this grade in any calculations. For example, the grade 
point equivalent of “A” is “4.0”.

NOTE
If you are applying linear course adjustment factors, this value will be 
adjusted by the value specified. If you are applying nonlinear course 
adjustment factors, you can enter different values in this column to reflect 
the adjusted value for each course level.

P/F If you want to indicate whether the grade is considered a 
passing or failing grade, select P or F. For example, if the course 
requires 50% to pass, click F for all grades under 50%.

Use this column if you want to report on passing and failing 
grades.

% Credit If you want to award partial credit to students based on their 
grades, enter the percent of total credit that the student 
receives for this grade. For example, enter “100” for passing 
grades, “50” for grades that earn partial credits, and “0” for 
failing grades.

Description in Legend Enter a description of the grade up to 15 characters, such as 
“Good”. Unlike with Numeric grading tables, you do not need to 
include the grade itself. The report card legend will include the 
Input Grade next to the description, such as “B - Good”.

To Do this

Add rows to a grid • From the Actions menu, click Add Rows to > Grading Table.

NOTE
You can only add rows to the Regular course level version of the grading 
table because all versions must have the same letter grades.

Set up special grades (e.g., 
incomplete, medical 
exemption, exempt, audit)

See “Adding Special Grades to Grading Tables” on page 88.

Field Description
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All grading tables display a Regular course level. If your school provides courses with 
different difficulty levels (e.g., remedial, honors) additional levels will appear in the grading 
table. The grading table setup in each additional level is a copy of the grading table setup for 
the Regular level; you can make adjustments to the grading table setup of these other levels 
as required.

To create or edit a graphic symbol grading table:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the Type dropdown, select Graphic Symbol.

6 In the Grading Scale field, enter the maximum value of any grade.

For example, enter “4” for a 4-point scale or “100” for a 100-point scale.

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading table 1 Select the grading table to delete. 

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading table name Enter a name up to 30 characters, such as “Graphic Symbols 8-
10”. This name is shown when you enter grades.

Short name Enter an abbreviation up to 6 characters, such as “G810”. This 
abbreviation appears when you set up course grading 
properties. For more information, see “Defining the Grading 
Properties of a Course” on page 99.

Description If you want to describe the table and when to use it, enter a 
brief description.
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7 For each grade that you want to define in the grading table, complete the following fields:

Field Description

Input Grade Enter up to 3 characters that staff will use to enter this grade on 
a report card. For example, enter “G” so that staff can press the 
G key to enter this grade. 

Reporting Grade Determine how the grade is displayed by doing one of the 
following:

• To display a symbol, select Check Mark, Happy Face, Neutral 
Face, or Sad Face.

• To display nothing, select Blank Space.

• To display the Input Grade itself, select Same.  
For example, select Same for an Input Grade of “X” to have a 
symbol that corresponds to the Check Mark symbol.

Lower Cutoff If you want to use the grades in calculations such as GPA 
definitions where numeric values are scaled to 100, enter the 
lowest mark required to earn the grade, such as “75”. The range 
of marks for this grade start at this value and go to the next 
highest grade, with the Grading Scale determining the highest 
possible value.

For example, to average two grades, first use Num Equiv to get 
values of the grades. Then average the values, and use Lower 
Cutoff to determine the grade of the result.

NOTE
The marks you enter in the Lower Cutoff column must be of the same format 
as the grading scale you entered in the Grading Scale field. For example, if 
you enter a grading scale of 100, you must enter lower cutoff marks between 
0 and 100.

Grbk % Cutoff If you use Gradebook, enter the mark in Gradebook that 
students must earn to receive this grade in  
Chancery SMS.

NOTE
The Grbk % can be different than the lower cutoff mark, if required.

Grade Points If you want to use the grades in calculations such as GPA 
definitions where grade points are used, enter the number that 
represents this grade in any calculation. For example, enter 
“4.0”. 

NOTE
If you are applying linear course adjustment factors, this value will be 
adjusted by the value specified. If you are applying nonlinear course 
adjustment factors, you can enter different values in this column to reflect 
the adjusted value for each course level.

P/F If you want to indicate whether the grade is considered a 
passing or failing grade, select P or F. For example, if the course 
requires 50% to pass, click F for all grades under 50%.

Use this column if you want to report on passing and failing 
grades.
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8 If your school offers courses of different difficulty levels that are graded differently than 
regular level courses, click a level and enter the appropriate grades.

9 Do any of the following:

10 Click OK.

Creating and Editing Narrative Comment Grading Tables
Narrative comment grades are entered in free form text and appear on the report card as 
entered.

NOTE

Comment type grading tables are not included in GPA calculations.

To create or edit a narrative comment grading table:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

% Credit If you want to award partial credit to students based on their 
grades, enter the percent of total credit that the student 
receives for this grade. For example, enter “100” for passing 
grades, “50” for grades that earn partial credits, and “0” for 
failing grades.

Description in Legend Enter a description of the grade up to 15 characters, such as 
“Good”. Unlike with Numeric grading tables, you do not need to 
include the grade itself. The legend on the report card will 
include description next to the Reporting Grade, such as 
“☺ Good”.

To Do this

Set up other course levels 1 Click the course level link the course level located above the 
grid. 

2 On the new grid, repeat step 7 above.

Add rows to a grid • From the Actions menu, click Add Rows to > Grading Table.

NOTE
You can only add rows to the Regular course level version of the grading 
table, as all versions must have the same graphic symbols.

Set up special grades (e.g., 
incomplete, medical 
exemption, exempt, audit)

See “Adding Special Grades to Grading Tables” on page 88.

Field Description
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3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the Type dropdown, select Narrative Comment.

6 Define the following fields:

7 Click OK.

Creating and Editing Standard Comment Grading Tables
Standard comment grades are selected from a list of pre-defined options and appear on the 
report card as entered. Comment type grading tables are not included in GPA calculations.

NOTE

To use a Standard Comment Grading Table, you must first set up standard comments. See “Setting Up 
Secondary Standard Comments” on page 59 for details. 

To create or edit a standard comment grading table:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 2, click Grading Tables.

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading table 1 Select the grading table to delete.

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading table name Enter a name up to 30 characters, such as “Narrative Comments 
8-10”. This name is shown when you enter grades.

Short name Enter an abbreviation up to 6 characters, such as “NC810”. This 
abbreviation is used when you set up course grading properties. 
For more information, see “Defining the Grading Properties of a 
Course” on page 99.

Description If you want to describe the table and when to use it, enter a 
brief description.

Field Description

Max no. of chars Enter a number that represents the maximum number of 
characters permitted in a comment.

Comments are mandatory When you select this checkbox, if no comments have been 
entered, the Missing Grades report displays the narrative 
comment grades as “Missing”.
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3 On the Grading Table page, do one of the following:

4 Define the grading table as follows:

5 From the Type dropdown, select Standard Comment.

6 Define the following fields:

7 Click OK.

Adding Special Grades to Grading Tables
If required, you can add special grades, such as “Incomplete” or “Exempt”, to numeric, letter 
grade, and graphic symbol grading tables. 

NOTE

If your district is using course levels, you can only edit special grades for the Regular course level. 
However, the special grades themselves apply to courses for all course levels.

To add special grades:
1 Create or edit a numeric, letter grade, or graphic symbol grading table and set the 

common options for that type of grading table. Refer to the following for details:

• “Adding and Editing Numeric Grading Tables” on page 78

To Do this

Add a grading table • From the Actions menu, click Add Grading Table.

Delete a grading table 1 Select the grading table to delete.

2 From the Actions menu, click Delete Grading Table.

3 Click OK and skip the remaining steps.

Edit a grading table • Click the grading table name.

Field Description

Grading table name Enter a name up to 30 characters, such as “Participation 
Comments”. This name is shown when you enter grades.

Short name Enter an abbreviation up to 6 characters, such as “Partic”. This 
abbreviation appears when you set up course grading 
properties. For more information, see “Defining the Grading 
Properties of a Course” on page 99.

Description If you want to describe the table and when to use it, enter a 
brief description.

Field Description

Max no. of comments Enter the maximum number of comments a grade item can 
receive.

Comments are mandatory When you select this checkbox, if no comments have been 
entered, the Missing Grades report displays the narrative 
comment grades as “Missing”.
88 Defining Secondary Grading Tables
Adding Special Grades to Grading Tables



Chancery SMS Grading Setup Guide
• “Adding and Editing Letter Grade Grading Tables” on page 81

• “Creating and Editing Graphic Symbol Grading Tables” on page 83

2 Do one of the following:

3 Under Special Grades, create grades for special circumstances – such as incomplete, 
medical exemption, exempt, and so on – as follows:

To Do this

Add special grades to a new 
grading table

• Go to step 3 below.

Add special grades to an 
existing grading table

• From the Actions menu, click Add Rows>Special Grades.

Field Description

Input Grade Enter up to 3 characters that staff will use to enter this grade on 
a report card. For example, enter “I” so that staff can press the I 
key to enter an incomplete grade.

Reporting Grade Select Same to display the Input Grade on the report card or 
select one of the other options as appropriate. For example, 
select Same to display “Inc” (for Incomplete) for the “Inc” 
grade.

P/F If you want to indicate whether the grade is considered a 
passing or failing grade, select P or F. For example, select F to 
indicate that Incomplete is a failing grade.

% Credit If you want to award partial credit to students based on their 
grades, enter the percent of total credit that the student 
receives for this grade. For example, enter “100” for passing 
grades, “50” for grades that earn partial credits, and “0” for 
failing grades.

Description in Legend Enter a description of the grade, such as “Incomplete”. On the 
report card, the description will appear in the legend next to the 
grade, such as “Inc Incomplete”.

Grade Calculations Select one of the following actions that the system will take 
when it encounters special grades in grade calculations:

• Ignore grade item – if the special grade is part of a 
calculation, the system removes both the numerator and the 
denominator from the formula.

• Count item as zero – if the special grade is part of a 
calculation, the numerator is counted as zero, meaning that 
the student is penalized for the special grade.

• No calculated grade – if the special grade is part of a 
calculation, the calculation cannot be completed.

• Treat as missing grade – if the special grade is part of a 
calculation, the grade is treated as a missing grade, meaning 
that the Missing Grade setting for that grade item in the 
calculated grade formula applies. This setting allows special 
grades to be treated differently in different calculations.
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4 Do any of the following:

5 Click OK.

To Do this

Add more rows • From the Actions menu, click Add Rows to Special Grades.

Change the order of the 
grade descriptions in the 
legend

1 From the Edit menu, click Change Order for Special Grades.

2 Use the up and down arrows to change the order. Click OK.
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Working with Secondary Grading Periods
Before you can create report cards and progress reports, you must define the date ranges 
that they cover and the grade items to include (for further information about grade items, 
see “Setting Up Grade Items” on page 63). These date ranges with their grade items are 
called grading periods. 

You need to create separate grading periods when you want report cards and progress 
reports with:

• the same date ranges but different grade items.

• the same grade items but different date ranges.

You should align the grading period end dates with the scheduling term end dates set up in 
your school’s schedule. Attendance summary statistics that appear on report cards, such as 
the number of days a student was absent during the grading period, reflect the grading 
period, not the scheduling term. For information about scheduling, see the Chancery SMS 
Scheduling Guide.

Grading periods are defined in sets, enabling you to stagger grading periods by grade levels. 
The grade levels you choose from are defined on the Grade Levels Setup page. Grading 
periods affect what grade levels a given report card applies to, because a grading period set 
is linked to one or more grade levels in your school. 

You need to create separate grading period sets when you want:

• different grade levels with different date ranges.

• different grade levels with different grade items.

Ensure that all of the grade levels in your school are included in a grading period set. 

The following diagram shows two grading period sets at a school. Each set has different date 
ranges for different grade levels. Within the sets there are separate grading periods for 
progress reports and report cards because these have different date ranges as well.

Grading Period Set for Grades 7-10

Grading Period Set for Grades 11-12

Grading 
Period

Progress Report Period Grading 
Period

Report Card Period

 Name End Date Name End Date

1 Progress Report Q1 Oct. 3 2 Report Card Q1 Nov. 1

3 Progress Report Q2 Nov 30 4 Report Card Q2 Jan. 9

Grading 
Period

Progress Report Period Grading 
Period

Report Card Period

 Name End Date Name End Date

1 Progress Report Q1 Oct. 25 2 Report Card Q1 Nov. 15

3 Progress Report Q2 Dec. 14 4 Report Card Q2 Jan. 14
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Grading Periods and GPA/Class Rank Reporting Terms 
GPA/Class rank reporting terms in Chancery SMS enable schools to produce GPAs and class 
ranks for district-defined time periods. GPA/Class rank reporting terms are set up by your 
district and are based on district policies. 

NOTE

A “reporting term” is a period of time determined by your district. It might be a semester, trimester, or 
some other time period. 

If your district has set up GPA/class rank reporting terms, a GPA/Class Rank Reporting Term 
field appears on the Grading Period page. Use this field to assign a district-defined reporting 
term to each report card grading period. This assignment enables Chancery SMS to 
determine which grades to use when calculating term GPAs and term class ranks.

NOTE

If your district does not calculate GPAs and class ranks by term, the GPA/Class Rank Reporting Term field 
does not appear on the Grading Period page.

In the example below, there is an “RQ1” report card grading period with a grade item called 
“S1 Grade”. The district GPA/class rank reporting term called “Semester 1” is assigned to 
report card grading period “RQ1”. When you run GPA calculations, only the grades from the 
S1 Grade grade item are included in the term calculation.

NOTE

For a grade item to be included in the GPA calculation, on the Course Grading page, the “Use in Cum 
GPA” setting for the grade item must be set to “Yes”. For further information, see the Chancery SMS 
Scheduling Guide.

GPA/class rank 
reporting term 
“Semester 1” assigned 
to “RQ1” grading 
period.

Grade item “S1 Grade” 
will be included in GPA 
calculations.

Grading period “RQ1”.
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• For further information about term GPA calculations, see “Calculating Term GPAs” on 
page 174.

• For further information about term class rank calculations, see “Calculating Class Ranks” 
on page 177.

• For information about setting up district GPA reporting terms, see the Setting up District 
GPA/Class Rank Reporting Terms Technical Bulletin available from the Pearson Customer 
Support website.

NOTE

For instructions about how to update custom secondary report cards and/or transcripts to use the new 
GPA/class rank reporting term functionality in Chancery SMS 6.6.5, contact Pearson technical support.

Defining Secondary Grading Periods
Grading periods are defined in sets. Typically, you create multiple grading period sets so you 
can provide report cards at different times for different grades. 

NOTE

Once all the grade levels in your school are assigned to a grading period set, you can’t create more 
grading period sets unless you delete an existing one first.

When you define grading period sets, you can also specify a grace period for entering student 
grades. The grace period is the number of days past the last date of all grading periods that 
staff can continue to enter or submit grades. The grace period is not connected to past 
grades.

To add or edit grading periods:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 3, click Grading Periods.

3 On the Grading Periods page, in the Grace Period field, enter how many days staff can 
continue entering or submitting grades after the last date of the grading periods.

NOTE

The grace period you enter here applies to all grading periods in all grading period sets.

4 Do one of the following:

5 On the Add/Edit Grading Period Set page, define the entire set as follows:

To Do this

Add a set • From the Actions menu, click Add Grading Period Set. 

Edit a set • Click the name of a set. 

Delete a set 1 Select the grading period set you want to delete.

2 From the Actions menu, click Delete Grading Period Set.

3 Click OK and skip the remaining steps.

Field Description

Set Name Enter a meaningful name for the set of grading periods, such as 
“Grade 10 Grading Periods”.
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6 In the Grading Periods panel, do any of the following:

7 On the Grading Period page, define grading periods as follows:

Grade Levels Select the grades that this set applies to. If you do not select all 
of the grades, ensure you create additional sets for the 
remaining grades. The grades available are the ones that are not 
already covered by other grading period sets.

To Do this

Add a period • From the Actions menu, click Add Grading Period.

Edit a period • Click the name of the grading period.

Delete a period 1 Select the period.

2 From the Actions menu, click Delete Grading Period.

3 Click OK and skip the remaining steps.

Field Description

Grading Period Type Indicate whether this grading period results in a progress report 
or a report card.

Name Enter the name of the reporting period, such as Report Card 1 or 
Interim Report 1, as you want it to appear on reports.

Short Name Enter up to 6 characters to identify each period that is displayed 
on the report card as a column heading, for example “Q1”. 

End Date Enter the end date of each reporting period. The first period 
starts on the first school day of the school year, while each other 
period starts the day after the previous period end date.

Grade Items to Collect Add grade items to the period by clicking items in the Available 
list and clicking  to move them to the Selected list. 

GPA/Class Rank Reporting 
Term

This field appears only if:

• Your district has defined GPA/class rank reporting terms in the 
GPA/Class Rank Reporting Term setup list.

• The grading period type is Report Card.

Select the GPA/class rank reporting term to assign to the report 
card grading period. Only the grades for the grade items in this 
grading period will be included in the GPA calculations. For 
further information, see “Grading Periods and GPA/Class Rank 
Reporting Terms” on page 92.

NOTE
For instructions about how to update custom secondary report cards and/or 
transcripts to use the new GPA/class rank reporting term functionality in 
Chancery SMS 6.6.5, see the Pearson Customer Support website.

Field Description
94 Working with Secondary Grading Periods
Defining Secondary Grading Periods



Chancery SMS Grading Setup Guide
8 Click OK.

9 Repeat Steps 5 through 7 for each grading period you need to add or edit in the set.

10 Click OK.
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Grade Calculations for Semester Grade 
Averages
To create semester grade averages in Chancery SMS, you create grade calculation formulas 
and apply them to existing grade items. Once the formulas are set up, you can run a 
calculation to generate grades according to defined rules. The results can be manually 
overridden if required. 

• For more information about grade items, see “Setting Up Grade Items” on page 63.

• For more information about overriding calculated grades, see “Overriding Grade 
Calculations” on page 166.

Setting Up and Editing Grade Calculation Formulas
Keep in mind the following when setting up grade calculation formulas:

• If you use letter grades, you must use a 100-point grading scale and set up grade points.

• Special grades are handled in the calculation as indicated in the grading table. The grade 
calculations setting in grading tables specify how special grades are to be treated in grade 
calculations. For further information, see “Adding Special Grades to Grading Tables” on 
page 88.

• You can set up a grade item to be calculated from other grade calculations. For example, 
the Final Grade can be calculated as an average of the Semester 1 Grade and Semester 2 
Grade, which are themselves grade calculations.

• Course Grade grade items cannot be grade calculations.

To set up or edit a grade calculation formula:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 5, click Calculated Grades.

3 On the Grade Calculations page, do one of the following:

4 On the Add/Edit Grade Item Calculation page, in the Grade Calculation Name field, enter 
a name to define the formula.

5 From the Calculated Grade Item dropdown, select the grade item for a specific grading 
period to which the formula applies, such as Semester 1 Grade (Q2). 

The list does not include any Course Grade grade items or items that are not used in 
current year calculations.

To Do this

Add a grade calculation • From the Actions menu, click Add Grade Calculation.

Edit a grade calculation • Click the calculation name.

Delete a grade calculation 1 Select the calculation. 

2 From the Actions menu, click Delete Grade Calculation. 

3 Click OK and skip the remaining steps.
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6 In the Contributing Grade Items panel, for each potential contributing item, define the 
following:

7 If you have changed the default weights for the grade items, in the Result panel, click 
Refresh to see the new formula.

8 In the Courses Using this Calculation panel, use the Basic or Detail search to populate the 
Available Courses list with the appropriate courses. Select the courses to which the grade 

calculation formula applies and click  to move them to the Selected Courses list.

NOTE

Courses that have already been assigned a grade calculation formula display in the Available Courses 
list with an exclamation mark. A course can only be added to one grade calculation for a given grade 
item. If you select a course that has been added to a grade calculation, completing the transaction 
will transfer the course from the previous grade calculation to the new one.

9 Click OK.

Field Description

Grade Item The system displays all global grade items collected in or prior to 
the grading period for the grade item you selected, provided 
they are set up to be used in current year calculations.

This list can include other calculated grades.

Formula Key Each global grade item is automatically assigned a character to 
represent it in the formula displayed in the Result panel. You 
cannot change the assigned character.

Weight Enter a whole number to indicate how the grade item will be 
weighted in the calculation (e.g., 2 to double the weighting, 0 to 
remove the item from the calculation).

Missing Grade From the Missing Grade dropdown, select the way that the grade 
will be treated in the calculation if it is missing. Select from:

• Ignore grade item – the grade item is removed from both the 
numerator and denominator of the formula.

• Count item as zero – the grade item is counted as a grade of 
zero, with the weight specified.

• No calculated grade – the calculation cannot take place if the 
grade is missing for the student.
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Defining Course Grading Properties
After creating relationships between grade levels, grade items, and grading periods, you 
need to make the link to individual courses.

Most aspects of courses are set up at the district. However, each school needs to determine 
which grading period set the course is using.

In addition, schools specify whether:

• Report card and progress report grade items will use the default grading table or be 
changed to a different grading table.

• Report card grade items are kept in a student’s historical data, displayed on transcripts, 
or discarded when year-end processing runs.

• Progress report grade items are kept in a student’s historical data or discarded when 
year-end processing runs.

• Report card grade items are counted as final grades towards class rank calculations that 
include a minimum number of final grades to determine class rank eligibility. 

• Report card grade items are credit awarding. 

• Report card grade items are used in cumulative GPAs.

Defining the Grading Properties of a Course
Before defining the grading properties for a course, ensure the scheduling structure has been 
set up at your school. For more information see the Chancery SMS Scheduling Guide 
available, from the Pearson Customer Support website.

To define the grading properties of a course:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 4, click Courses.

3 On the Course List page, search for a course and click the course name.

4 In the control bar, click Course Grading.

5 On the Course Grading page, if the school has more than one grading period set, from the 
Grading Period Set dropdown, select the grading period set to use for the course.

6 In the dialog, click OK. 

NOTE

If the school has only one grading period set, that grading period set is already selected.
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After you select a Grading Period Set, the Course Grade Items area displays each grade 
item collected for each grading period in the selected grading period set. The Course 
Grade grade item automatically appears for each grading period in the set; for all other 
items, you select the required grade item when you create each grading period. For 
further information, see “Defining Secondary Grading Periods” on page 93.

7 In the Grading Table column, select the appropriate grading table for each grade item.

NOTE

This value defaults from the Grade Items page. The grading table must have the same grading table 
in all grading periods.

8 In the History column, select one of the following for each grade item:

• Keep – this saves the grade for this grade item in the student’s historical data but 
does not display it on transcripts.

• Discard – this does not save the grade for this grade item beyond the current school 
year.

• Transcript – this saves the grade for this grade item in the student’s historical data 
and also displays it on transcripts.

NOTE

You can select Transcript for up to four grade items per course.

9 In the Final Grade column, select Yes if the grade item is to be counted as a final grade in 
calculating class ranks (where the class rank definition includes a minimum number of 
final grades to determine eligibility). Otherwise, leave the selection blank.

You can only specify that a grade item is a final grade if it does not use a comment-type 
grading table. For details about how this field is used in class ranks calculations, see 
“Adding and Editing Class Rank Definitions” on page 137.
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10 In the Award Credit column, if the grade item is credit-awarding, select Yes. Otherwise, 
leave the selection blank.

Your options for the Award Credit column are determined by the following factors:

For further information about credits, see “Calculating Student Credits” on page 166.

11 In the Use in Cum GPA column, if the grade item is to be used in calculating cumulative 
GPAs, select Yes. Otherwise, leave the selection blank.

If “Exclude from GPA” is selected at the top of the page, then this course is not included 
in cumulative GPA, regardless of what you select for the “Use in Cum GPA” column.

12 If the grading period set includes grading periods for progress reports, click the Progress 
Report tab.

The Final Grade, Award Credit, and Use in Cum GPA columns are not available in the 
Progress Report tab because you cannot award credit for progress report grade items or 
use progress report grade items in cumulative GPAs.

13 On the Progress Report tab, in the History column, select one of the following options for 
each grade item:

• Keep – this saves the grade for this grade item in the student’s historical data but 
does not display it on transcripts.

• Discard – this does not save the grade for this grade item beyond the current school 
year.

Transcript is not an option in the History dropdown because you cannot display progress 
report grades on transcripts.

14 Click Save.

If You can

Allow Partial Credits is 
selected

Divide the maximum credits for the course by more than one 
grade item by selecting Yes for more than one grade item (e.g., 
a full-year course that awards partial credits at the end of each 
semester).

Divide the maximum credits for the course by more than one 
grading period by selecting Yes for the Course Grade in more 
than one grading period (e.g., a full-year course that awards 
partial credits at the end of each grading period).

Allow Partial Credits is 
deselected

Select one grade item, other than a course grade item, that will 
be used to award credit for the course (e.g., a course that 
awards full credits upon completion).

Max credits for the course is 
0

Award Credit is not editable.
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Copying Grading Properties
Since each school can have many courses, Chancery SMS enables you to define the 
properties for one course and copy them to other courses.

To copy grading properties, you must meet the following requirements:

• The course you are copying from and the courses you are copying to must all be 
scheduled.

• The course you are copying from and the courses you are copying to must all have the 
same settings for:

• grading period; 

• scheduling term; and 

• Allow Partial Credits. 

In general, copy from a course that allows partial credits to other courses that allow 
partial credits, and vice versa. Specifically, you cannot copy from a course that will 
distribute credits among multiple grade items to a course that does not allow partial 
credits.

• The courses that you are copying to:

• Must be able to collect grades. Specifically, “Collect Grades for this Course” on the 
Course Grading page must be selected. This checkbox is set at the district level; and 

• Must not already have collected grades.

To copy grading properties from one course to other courses:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 4, click Courses.

3 On the Course List page, search for the course you want to copy grading properties from, 
and click the course name.

4 In the control bar, click Course Grading.

5 On the Course Grading page, click Copy in the upper right corner.
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6 On the Copy page, under Fields to Copy, select Course Grade Item Properties.

7 Under “School Graded Courses to Copy to”, in the “Available School Graded Courses” list, 

select the courses you want to copy to, and then click  to move them to the selected 
School Graded Courses List.

The available courses are course for which:

• The district has selected “Collect Grades for this Course”.

• The school has selected the same Grading Period Set as the course being copied from.

• The school has scheduled the course for the same term as the course being copied 
from.

8 Click OK.
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Working with Honor Rolls
Honor rolls list students who have met specific academic requirements. The honor roll 
functionality available in Chancery SMS allows your school to set up rules that determine 
students’ honor roll eligibility. 

Eligibility is determined using a wide variety of criteria, including grades, GPAs, attendance, 
and test results. At the end of each report card period, eligibility is calculated and the 
resulting list of students is assigned to the honor roll.

Honor rolls are only available for secondary schools.

Permissions to Set Up and Use Honor Rolls
To set up and use honor rolls, you need the following permissions:

By default, school administrators can set up honor roll definitions, including eligibility rules. 
School administrators can also assign students to honor rolls and calculate honor rolls. Only 
school administrators have permission to override honor rolls.

School secretaries can view honor roll information, including honor roll definitions and 
students’ honor roll status.

For further information about permissions, contact your system administrator or see the 
Chancery SMS Permissions Guide.

Understanding Eligibility Rules
Chancery SMS enables you to construct eligibility rules that specify the criteria students must 
meet to qualify for an honor roll. You can run calculations that use these rules to determine 
students’ honor roll eligibility.

Eligibility rules are created using the eligibility control. This control is available to many 
features of Chancery SMS, such as Attendance, Demographics, Grading, Program 
Management, and so on. This topic focuses specifically on honor roll eligibility. 

For detailed information about the eligibility control, see the Understanding Eligibility Rules 
Technical Bulletin.

To You need this permission Set to

Set up honor roll definitions, including 
defining eligibility criteria

School Setup > Honor Roll Definitions Delete

Manage honor rolls, including calculating 
honor rolls

Grading > Honor Rolls Edit

Assign students to honor rolls Grading > Honor Rolls Edit

Assign ineligible students to honor rolls Student > Override Honor Rolls Yes

Run the Honor Rolls Report Reports > Honor Roll Report View
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The eligibility control is made up of:

• A statement builder

In the case of honor rolls, a statement describes what the student needs to have 
achieved to qualify for an honor roll; for example, a GPA of 3.5 or a total of less than 5 
absences in a specific time frame. The statement builder is a collection of fields known as 
“Search By” sets that you use to construct the statement.

• Eligibility criteria

Eligibility criteria are one or many statements plus the logical operators (AND/OR) that 
connect the statements. The eligibility criteria section is where you add the statements 
and their logical operators.

In each category (e.g. Grading, Attendance), you will find all the existing properties in the 
database that could be relevant to calculating eligibility for that particular category. 

Statement 
builder

Eligibility 
Criteria

Eligibility 
control
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The Search By section in the statement builder is made up of a left term (the left dropdown), 
an operator (e.g., equals, is greater than or equal to, contains, etc.), and a right term (the 
right dropdown). Using these components, you construct the main search statement.

Depending on the category you select, from the left term, you can select either a field or a 
function.

The options available for specifying a criteria depends on whether you select a field or a 
function from the left term dropdown:

• Field

In its simplest form, a field is any single piece of data stored in the database, such as a 
student’s gender. When you select a basic field as the left term, you can simply specify an 
operator and right term, then add the statement to the eligibility rule.

Some fields include an additional Search By set below the first, which allows you to 
search for specific information related to the selected field. For example, if you select a 
setup list, such as Ethnicity, an additional dropdown allows you to select another left 
term, such as description or code, and specify an operator and right term; for example, 
“Ethnicity Description equals Asian”. 

functions

fields

Basic fields include 
only one Search By 
set.

Some fields include an 
additional Search By 
set.
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• Function

A function is used to construct statements about complex data that require you to specify 
limiting or “where” clauses. When you select a function, a section called “Where the 
following conditions apply” appears below the Search By section. 

For example, if you select the category Grading, then choose Cumulative GPA from the 
left dropdown, a “where clause” displays, enabling you to select a specific GPA definition.

Once you select the operator and value for the first Search By set and all associated where 
clauses, you can add the statement to the eligibility rule. 

The eligibility rule as a whole is displayed in the list box in the Eligibility Criteria section. This 
list box is organized in a tree structure, similar to the folders on a computer. The branches of 
this tree are called nodes. 

A node can be the Criteria text at the top of the Eligibility Criteria list box or a logical operator 
within the list box. When you construct a statement and click Add Criteria, the statement is 
added below the selected node, or to the bottom of the rule if a node was not selected.

When you select a 
function in the first 
Search By dropdown, 
you can specify 
conditions in the 
“Where the following 
conditions apply” 
section.

Node

Logical operators 
(also a node)

Statement

Completed rule
(displays after 
the rule is 
saved)

Tree structure

Eligibility 
Criteria list 
box
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If you have more than one statement in the your rule, you must add logical operators to 
group them meaningfully. 

For example, if students are required to meet all the criteria in your rule, the first node under 
Criteria should be AND; all the statements would then hang off that node. If, on the other 
hand, students are only required to meet one out of a list of criteria, the first node should be 
OR. Additional nodes can be added to allow a combination of these operators.

To add logical operators, click the node to which you want to add the operator and then click 
the AND or OR button. If required, you can drag the statements to the appropriate node. You 
can also drag whole nodes to different locations in the list box, or remove statements 
completely.

NOTE

When dragging a statement or operator, make sure the cursor is directly above the node before releasing 
it.

Eligibility Rule Example
In the following example, a single honor roll is used for multiple grade levels. Students in 
grades 9 must have a weighted cumulative GPA of 3.3 or higher; students in grades 10 must 
have a weighted cumulative GPA of 3.5 or higher. For both grade levels, students may have 
no more than one unexcused absence for the year-to-date.

To construct this statement, perform the following steps:
1 In the eligibility criteria panel, next to the tree, click AND. This allows you to specify that 

there are multiple statements in the rule (e.g., grade level and GPA, plus attendance).

2 In the tree, click the cursor on the AND item, then click OR. This adds OR to the rule, 
which allows you to create one set of rules for one grade level, and another for a different 
grade level.

3 In the tree, click the cursor on the OR item, then click AND. This adds AND as a branch, 
where you can define multiple criteria for one variation of the honor roll.

4 Add the grade level and GPA criteria for one grade level as follows:

a From the Category dropdown, select Demographics.

b In the first search by set, construct the following statement: “Grade level equals 9”.In 
the second search by set, construct the following where clause: “Effective date equals 
today”.

c Click Add Criteria.

d From the Category dropdown, select Grading.
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e In the first search by set, construct the following statement: “Cumulative GPA is 
greater than or equal to 3.3”.

f In the second search by set, construct the following where clause: “Cumulative GPA 
Definition equals Weighted Cumulative GPA”.

g Click Add Criteria.

5 Click and drag the two statements to the AND item.

NOTE

You must drag and drop the statement directly on top of the AND statement to move it.

6 Repeat steps 3-5 for grade 10 with a GPA of 3.5.

7 Add the attendance criteria for one grade level as follows:

a From the Category dropdown, select Attendance.

b In the first search by set, construct the following statement: “Days Absent Unexcused 
is less than or equal to 1”.

c In the second search by set, construct the following where clause: “Start date equals 
start of district calendar (active)”.

d In the second search by set, construct the following where clause: “End date equals 
today”.

e Click Add Criteria.

NOTE

When you calculate eligibility for honor rolls, Chancery SMS looks at grades earned at the school that is 
running eligibility. So if a student is dual-enrolled in the district, only the grades he or she earned at the 
school that is running eligibility will be counted.

Setting Up Honor Rolls
Honor rolls should be set up by someone familiar with the relevant data and comfortable with 
the logical statements created by the eligibility control. Once the honor roll definition is 
created, other users can run the eligibility calculation and manage the resulting list of 
students. For information about calculating eligibility and managing honor rolls, see “Working 
with Student Honor Rolls” on page 112 and “Managing Honor Rolls” on page 115. 

Creating and Editing Honor Roll Definitions
Before you assign students to an honor roll, you must first define the honor rolls for your 
school. You can have multiple honor rolls. For example, you might create one honor roll for 
each grade level. 

You can also create multiple honor rolls for each grade level. You might have an all “As” 
Honor Roll, an all “As” and “Bs” Honor Roll, an Academic Honor Roll, an All Courses Honor 
Roll, and so on.

To create or edit an honor roll definition:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 5, click Set Up Honor Rolls.
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3 On the Honor Roll Definitions page, do one of the following:

4 On the Add/Edit Honor Roll Definition page, specify the following:

5 In the eligibility control, do any of the following:

To Do this

Add an honor roll definition • From the Actions menu, click Add Honor Roll Definition.

Edit an honor roll definition • Click the honor roll definition name.

Delete an honor roll 
definition

1 Select the honor roll definition to delete. 

2 From the Actions menu, click Delete Honor Roll Definition.

3 Click OK and skip the remaining steps.

Field Details

Honor Roll Name Enter the name of the honor roll.

Description Enter a description of the honor roll.

Automatically assign eligible 
students

If you want the system to automatically assign all eligible 
students to the honor roll when eligibility is calculated, select 
this checkbox.

To Do this

Add a logical operator to 
define the relationships 
between statements

1 In the Eligibility Criteria list box, click the node below which 
you want to add the logical operator (e.g., click Criteria or 
another logical operator).

2 Click AND or OR.

Add a criteria statement to 
the eligibility rule

1 From the Category dropdown, select the type of data to be 
added.

2 Under Search By, from the first dropdown, select the field or 
function.

3 From the second dropdown, select the appropriate operator 
(e.g., equals, is in list).

4 In the third field, enter or select the appropriate value(s).

5 If additional Search By sets appear below the first set, repeat 
steps 2-4 for all sets.

6 Click Add Criteria.

Delete a criteria statement 
from the eligibility rule

1 In the Eligibility Criteria list box, click the statement to 
highlight it.

2 Click Remove.

Move a statement to another 
location in the eligibility rule

• Click and drag the statement to the new logical operator 
under which it belongs.

NOTE
Ensure that the cursor is directly on the operator before releasing.
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6 Click OK. 

Working with Student Honor Rolls
When working with honor rolls, you first determine eligibility. If student is eligible, you assign 
the student to an honor roll.

If your district is using honor roll overrides, and you have the appropriate permissions, you 
can assign an override reason code to students who were deemed ineligible for the honor 
roll. For example, a student might be ineligible due to poor attendance, but if their poor 
attendance record is due to illness and the student has achieved the required GPA, you can 
assign an appropriate override code and still place the student on the honor roll. You might 
also have a student who has achieved the eligibility criteria but because of disciplinary 
problems you want to remove him from the honor roll. For this student, assign an override 
reason code and remove the eligible student from the honor roll.

Adding a Student to an Honor Roll
1 Search for and open a student record.

2 On the Demographics page, in the control bar, click Honor Rolls.

3 On the Student Honor Rolls page, from the Actions menu, click Add Honor Roll.

4 On the Add Honor Roll page, specify the following:

Validate the rule • Click Validate.

Save the rule and continue 
working with it

• Click Apply.

Field Details

Honor Roll Name From the dropdown, choose an honor roll name.

Report Card Name From the dropdown, choose a report card name.

Eligibility Indicates the student’s eligibility status.

Override Reason If the student is ineligible, from the dropdown choose an 
override reason, if applicable.

To Do this
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5 To determine whether the student is eligible for the selected honor roll, click Calculate 
Eligibility. 

The student’s eligibility status displays.

6 If the student is Not Eligible for the selected honor roll, from the dropdown, choose an 
override reason.

7 Click OK.

Editing or Deleting Student Honor Roll Assignments
1 Search for and open a student record.

2 On the Demographics page, in the control bar, click Honor Rolls.

3 On the Student Honor Rolls page, do one of the following:

4 On the Edit Honor Roll page, specify the following:

5 Click OK.

To Do this

Edit an honor roll Click the honor roll name.

Delete an honor roll 1 Select the honor roll to delete. 

2 From the Actions menu, click Delete Honor Roll.

3 Click OK and skip the remaining steps.

Field Details

Honor Roll Name From the dropdown, choose an honor roll name.

Report Card Name From the dropdown, choose a report card name.

Calculate Eligibility To determine whether the student is eligible for the selected 
honor roll, click the Calculate Eligibility link.

Eligibility Indicates the student’s eligibility status.

Override Reason From the dropdown, choose an override reason, if applicable.
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Calculating Honor Roll Eligibility
When you assign students to an honor roll, first calculate their eligibility, then place them on 
the appropriate honor roll. Typically, students are placed on honor rolls at the end of a report 
card period.

You can also recalculate eligibility for a student partway through the report card period. For 
example, if a student was ineligible for an honor roll when you initially tried to assign them at 
the start of the term but the student has since improved their attendance record, you can 
re-assess the student’s eligibility.

You can calculate honor roll eligibility for individual students or a group of students.

To calculate honor roll eligibility for a student:
1 Search for and open a student record.

2 On the Demographics page, in the control bar, click Honor Rolls.

3 On the Student Honor Rolls page, do one of the following:

4 On the Add/Edit Honor Roll page, enter or update information as needed.

5 To determine whether the student is eligible for the selected honor roll, click Calculate 
Eligibility.

6 Click OK.

To calculate honor roll eligibility for a group of students:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 7, click Calculate Honor Rolls.

3 On the Honor Rolls page, select an honor roll and, from the Actions menu, click Manage 
Honor Roll.

4 On the Manage Honor Roll page, in the Eligible Students section, select the students you 
want to calculate eligibility for and, from the Actions menu, click Calculate Eligibility.

To Do this

Add an honor roll • From the Actions menu, click Add Honor Roll.

Edit an honor roll • Click the honor roll name.
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Managing Honor Rolls
When working with honor rolls, you can assign and unassign students as needed. You can 
also view students who are eligible for the selected honor roll and those who are currently 
assigned to the selected honor roll.

To manage honor rolls:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 7, click Calculate Honor Rolls.

3 On the Honor Rolls page, select an honor roll and, from the Actions menu, click Manage 
Honor Roll.

4 On the Manage Honor Roll page, do one of the following:

Configuring the Honor Roll Calculation Alert
By default, honor roll alerts are turned on. These alerts are sent to the user who ran the 
eligibility calculation.

You can turn off the Calculate Honor Roll alert or change its priority.

To configure the calculate honor roll alert:
1 In the control bar, under Admin, click School Setup.

2 On the School Setup page, under School, click Alerts.

3 On the Alerts page, click Calculate Honor Roll.

Depending on how many alerts you have, you might need to click Next to navigate to the 
next page.

To Do this

Assign an eligible student to 
an honor roll

1 Under Eligible Students, select one or more students.

2 From the Actions menu, click Assign Students.

Remove a student from an 
honor roll

1 Under Assigned Students, select one or more students.

2 From the Actions menu, click Unassign Students.
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4 On the Edit Alert page, make the necessary changes.

5 Click OK.
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Setting Up Grade Point Averages
Use Chancery SMS to calculate grade point averages (GPAs).

NOTE

“Grade Point Average” refers to any grade average, not just averages using grade points.

Chancery SMS supports four types of GPAs:

• Current year GPAs include grades from the current year only. For details, see “Working 
with Current Year GPAs” on page 117.

• Cumulative GPAs include both current year grades and historical grades. For details, see 
“Working with Cumulative GPAs” on page 127.

• Term GPAs:

• End-of-term GPAs include grades for a district-defined period of time in the current 
year only. Term GPAs are only calculated if your district has set up GPA/class rank 
reporting terms. 

• Cumulative-to-end-of-term GPAs include current year and historical grades, but only 
for a district-defined period of time. 

NOTE

To calculate term GPAs, your district must set up GPA/class rank reporting terms. When GPA/class 
rank reporting terms are set up and calculations are run, end-of-term GPAs and cumulative-to-end 
of term GPAs are calculated automatically. For further information about term GPAs, see “Grading 
Periods and GPA/Class Rank Reporting Terms” on page 92, “Calculating Term GPAs” on page 174, and 
“Entering and Editing Historical Term GPAs” on page 156.

Working with Current Year GPAs
Current year GPAs are highly flexible, providing many options for you to choose from. To 
understand these options, refer to the appropriate topic:

• “Options for Current Year GPAs” on page 117

• “Selecting a Current Year GPA Calculation Formula & Method” on page 118

• “Displaying Current Year GPAs” on page 122

• “Adding and Editing Current Year GPAs” on page 123

Options for Current Year GPAs
The following options are available when determining what goes into a current year GPA 
calculation:

• Depending on the calculation formula you use, you can apply weights or adjustment 
factors. You can also use course leveling to apply adjustments.

• You can calculate GPAs based on grade points or numeric values.

• Current year GPAs are not limited to course grades. While most GPAs do contain course 
grades, GPAs can include other grade items, such as semester grades or exam grades. To 
make the grade items available for use in GPAs, the “Used in Current Year Calculations” 
option must be set to Yes on the Grade Items page. The only items you cannot include in 
a GPA are grade items that use a comment-type grading table. 
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• The items in a GPA do not have to share the same grading table. Each grade item can 
have a different grading table. For example, a GPA can include a Course Grade grade item 
that uses a letter grade grading table and an exam grade item that uses a numeric 
grading table in percentages. Chancery SMS converts all the grades to a common 100-
point scale or it uses grade points to average the grades.

• You control the courses by including only courses you specifically select, excluding 
courses you specifically select, or including all courses. A GPA can only include courses for 
which grades are collected, which is determined by the district in the Course Catalog.

• You can include the best courses in the GPA definition, such as the best five courses, 
rather than all of the courses selected in the GPA definition.

NOTE

If a student is enrolled in multiple schools, the current year calculations are based on the grading tables 
for the school where the student is taking the course. 

Selecting a Current Year GPA Calculation Formula & Method
When creating your current year GPAs, you must select a calculation formula. How this 
calculation formula works depends on the calculation method you use: grade points or 
numeric values scaled to 100. Refer to the description for each formula for details:

• “Simple Grade Average” on page 119

• “Adjusted Simple Grade Average” on page 120

• “Weighted Grade Average” on page 121

• “Weighted Adjusted Grade Average” on page 122

Current Year GPA Calculation Formula Setup Example
For each formula, assume the GPA includes only course grades that use a letter grade 
grading table. A student took two courses, and received a B and a C, and the grading table 
was set up as follows:
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Simple Grade Average
For setup example, see “Selecting a Current Year GPA Calculation Formula & Method” on 
page 118.

The process for calculating a simple grade average differs depending on whether you are 
using grade points or using numeric values scaled to 100.

When calculating a simple grade average using grade points, Chancery SMS first determines 
the grade points of each grade by checking the appropriate grading table. It then averages 
the grades by adding the grades for each grade item in the calculation and dividing by the 
total number of grade items in the calculation. 

The formula for a simple grade average that uses grade points is:

When calculating a simple grade average by scaling numeric values to a scale of 100, 
Chancery SMS first determines the numeric value of each grade. For grade items using 
numeric grading tables, the numeric value is simply the grade that is entered. For grade 
items using letter grade or graphic symbol grading tables, the Grade Points column in the 
grading table is used. 

Chancery SMS then converts all grades to a 100-point scale. Since GPAs can include grade 
items that use different grading tables, the grades could have different scales. For example, 
course grades might use a grading scale of 4.0, while exam grades use a percentage, with a 
grading scale of 100. Therefore, all grades must be converted to the same scale before being 
used in the calculation.

To convert a grade to a 100-point scale, Chancery SMS divides the grade by the current scale 
specified in the original grading table, and multiplies it by the common scale of 100. 

Chancery SMS averages the grades by adding the scaled numeric values for each grade item 
in the calculation and dividing by the total grade items in the calculation. 

The formula for a simple grade average that uses numeric values scaled to 100 is:

Chancery SMS converts the resulting GPA to the scale or numeric range of the grading table 
assigned to the GPA in the GPA definition. For example, if the scale of the grading table is 
4.0, divide the GPA by 100 and multiply the result by 4:
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Adjusted Simple Grade Average
For setup example, see “Selecting a Current Year GPA Calculation Formula & Method” on 
page 118.

Using adjustment factors enables you to adjust a grade value to accommodate different 
levels of difficulty.

For example, an A in the regular course is equivalent to a B in the more difficult honors 
course. To reflect the difference, you can assign an adjustment factor to the honors course 
that multiplies the value of the grade by 1.25.

The district sets the adjustment factors for every course in the Course Catalog. When schools 
define GPAs, they can decide whether to take adjustment factors into account. To use 
adjustment factors, choose a Calculation Formula that includes the word “adjusted”.

NOTE

If your school does not apply adjustment factors in a linear way to courses (i.e., you cannot always 
multiply by or add the same factor to all grades), you cannot use adjustment factors in your GPAs. 
Instead, set up your grading tables to accommodate the different course levels (advanced, remedial, 
etc.). For further information, see “Setting Up for GPA Calculations (including Course Leveling)” on 
page 75.

To adjust a grade average, include the adjustment factor of the course before scaling the 
grade. The adjustment factor can be a multiplier or an addition, and is defined at the district 
level in the course catalog. 

Using the same example, assume that the B course does not have an adjustment factor, so 
no adjustment factor is included. The C course is an honors course and therefore has an 
adjustment factor that multiplies the grade by 1.25. 

The exact formula depends on whether you are using grade points or numeric values scaled 
to 100.

The formula for an adjusted grade average that uses grade points is:

The formula for an adjusted grade average that uses numeric values scaled to 100 is:
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Weighted Grade Average
Credit weights change the impact of a course on the GPA using course credits. For example, 
a Math course might be worth 3 credits, while an after-school band program is worth only 1.5 
credits. If you don’t use course credit weights, the band grade affects the GPA as much as 
the Math grade. If you use course credits weights, the band grade has only half the impact of 
the Math grade. 

The district sets the maximum course credits for every course in the Course Catalog. When 
schools define GPAs, they can decide whether to take course credits into account.

Alternatively, you can use user-defined grade-item weights, which change the impact of one 
grade item over another based on rules you define. For example, assume a GPA includes a 
course grade and an exam grade, and you want the course grade to have twice as much 
impact on the GPA as the exam grade. You would set the weight of the course grade to 2 and 
the exam to 1.

Using the setup example (see “Selecting a Current Year GPA Calculation Formula & Method” 
on page 118), assume that the B course is worth 6 credits while the C course is worth only 3.

The formula for a weighted grade average that uses grade points is:

The formula for a weighted grade average that uses numeric values scaled to 100 is:

For user-defined grade item weights, the formula is the same but the values of the weights 
comes from a different source. Also, user-defined grade item weights only apply when you 
are using different grade items.

NOTE

A single formula can include both course weights and user-defined weights.
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Weighted Adjusted Grade Average
For setup example, see “Selecting a Current Year GPA Calculation Formula & Method” on 
page 118.

A weighted adjusted grade average applies both adjustments and course and/or user-defined 
weights to each grade.

In this example, the B course is worth 6 credits while the C course is worth only 3. The B 
course does not have an adjustment factor, so its adjustment factor is set to 1. The C course 
is an honors course and has an adjustment factor that multiplies the grade by 1.25. 

The formula for a weighted adjusted grade average that uses grade points is:

The formula for a weighted adjusted grade average that uses numeric values scaled to 100 
is:

NOTE

If your school does not apply adjustment factors in a linear way to courses (i.e., you cannot always 
multiply by or add the same factor to all grades), you cannot use adjustment factors in your GPAs. 
Instead, set up your grading tables to accommodate the different course levels (advanced, remedial, 
etc.). For further information, see “Setting Up for GPA Calculations (including Course Leveling)” on 
page 75.

Displaying Current Year GPAs
Once the calculation is complete, Chancery SMS uses the GPA display settings to determine 
how to display the calculation results. If “Display As” is set to Numeric Value, the system 
rounds the GPA result to the number of decimals specified in the GPA definition. If “Display 
As” is set to Equivalent Grade, and/or the “Calculation method” is set to Use numeric values 
scaled to 100, the system uses the Grading Table selected in the GPA definition to convert 
the GPA to the appropriate equivalent grade.

For example, assume that the Calculation Result panel of a GPA definition is set up as 
follows:
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In this example, the GPA definition specifies that the GPA should display as the Numeric 
Value, with a precision of 1. As a result, a final GPA of 3.25 remains in grade points, rather 
than being converted to a letter grade, but is rounded to 3.3.

Conversely, if the GPA specified that the Equivalent Grade should be displayed, the same GPA 
is converted to a letter grade of B based on the setup of the letter grade grading table.

Adding and Editing Current Year GPAs
Each current year GPA definition can cover year-to-date or a specific report card period.

To add or edit a current year GPA:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 5, click Grade Point Averages.

3 On the Grade Point Averages page, do one of the following:

4 On the Add/Edit Current Year GPA page, define the GPA as follows:

To Do this

Add a GPA definition for the 
current year 

• From the Actions menu, click Add > Current Year GPA 
Definition.

Edit a GPA definition • Click the current year GPA definition name.

Delete a GPA definition 1 Select the current year GPA definition to delete.

2 From the Actions menu, click Delete GPA Definition.

3 Click OK and skip the remaining steps.

Field Description

GPA name Enter a unique name for the GPA of up to 55 characters. If you 
will be using more than one GPA on a report card, ensure the 
name clearly distinguishes the GPA from all other GPAs. For 
example, if a report card will have different GPAs for different 
grading periods, include the grading period in the GPA name, 
such as “GPA Current Rpt Card Period”, “GPA Year-to-Date”, or 
“GPA Rpt Card Period”. Similarly, if the report card will have 
different GPAs for different courses, describe the courses in the 
GPA name, such as “Academic GPA” and “GPA for All Courses”.

Description If you want to describe the GPA in greater detail, enter a 
description.
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5 From the Calculation Formula dropdown, choose a formula that uses adjusted, weighted, 
both, or neither. Use the following table as a guide:

For more information, see “Selecting a Current Year GPA Calculation Formula & Method” 
on page 118.

6 From the Calculation Method dropdown, select one of the following:

• Use grade points – this converts existing grades to the grade point equivalents 
specified in the grading table prior to averaging them.

• Use numeric grades scaled to 100 – this divides the actual grades entered by the 
appropriate scale and then multiplies them by 100 prior to averaging them.

For more information, see “Selecting a Current Year GPA Calculation Formula & Method” 
on page 118.

7 From the Level dropdown, select one of the following:

• Use Assigned Level – this uses values from the version of the grading table specified 
for the course (e.g., Honors, Remedial).

• Use Regular Level – this uses values from the Regular version of the grading table, 
regardless of the course level specified for the course. The name of this option may be 
different if your district has changed the name of the Regular course level setup list 
item.

8 In the Calculation Display Result panel, define how the GPA result is displayed as follows:

NOTE

The grading table selected in the Grading Table field is only used when the GPA Calculation method 
is set to “Use numeric values scaled to 100” and/or the GPA “Display as” option is set to “Equivalent 
grade”. For more information, see “Displaying Current Year GPAs” on page 122.

Calculation Formula Adjustment Factor Used? Weights Used?

Simple grade average No No

Adjusted simple grade average Yes No

Weighted grade average No Yes

Weighted adjusted grade average Yes Yes

Field Description

Grading Table Select the grading table that will be used to determine the grade 
of the resulting GPA. 

Display As Choose one of the following:

• Equivalent Grade – this displays the grade in the format 
specified by the Equivalent Grade column of a numeric grading 
table or the Input Grade of a letter grade or graphic symbol 
grading table. 

• Numeric Value – this displays the numeric value of the GPA 
result, using the scale of the grading table. 

Decimal Places • If you selected Numeric Value, specify how many decimal 
places the resulting GPA should be rounded to.
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9 In the “Contributing Grading Periods and Grade Items panel”, from the Grading Period 
dropdown, select a grading period for the GPA. The different settings have the following 
effects:

10 In the Available Grade Items list, click each grade item that you want to include in the 
GPA and click  to move it to the Selected Grade Items list.

If a grade item that you want does not appear in the Available Grade Items list, ensure 
the Used in Calculations setting for the grade item is set to Yes. For further information, 
see “Setting Up Grade Items” on page 63.

Grading Period Description

Year to Date If this option is selected, the resulting GPA includes all grading 
periods up to the current grading period. 

The GPA may also include the current grading period; however, 
this depends on the option chosen when GPA calculations are 
run. For more information see “Current-Year GPAs and Effective 
As Of Date” on page 175.

If the result of this GPA definition is printed on every report card 
in a grading period set, the result changes each grading period 
to include the most recent grades.

Current Report Card Period If this option is selected, the GPA includes grades from either the 
current grading period only or from the last completed grading 
period.

Which grades are included depends on the option chosen when 
GPA calculations are run. For more information, see 
“Current-Year GPAs and Effective As Of Date” on page 175.

Report Card <#> This option allows you to customize the GPA for each report card 
period or to show GPA definitions for each report card period at 
once by creating a separate GPA for each.

If you have more than one grading period set, you can use the 
same GPAs for report cards of each grading period set. The GPA 
for Report Card 1 applies to the first report card period, no 
matter what the date range or the name.
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11 If the Calculation Formula is set to “Weighted Grade Average” or “Weighted Adjusted 
Grade Average”, do any of the following:

To Do this

Weigh grades to reflect 
course credits

• To use course credit weights, select “Use Course Credit 
Weights”.

Credit weights change the impact of a course on the GPA 
using course credits. For example, a Math course might be 
worth 3 credits, while an after-school band program is worth 
only 1.5 credits. If you don’t use course credit weights, the 
band grade affects the GPA as much as the Math grade. If you 
use course credit weights, the band grade has only half of the 
impact than the Math grade. 

The district sets the maximum course credits for every course 
in the Course Catalog. When schools define GPAs, they can 
decide whether to take course credits into account. 

Courses with 0 max. credits are ignored.

NOTE
The % Credit column in the grading tables is unrelated to course credit 
weights. 

Weigh grade items using 
weights you specify 

1 Select “Use user-defined grade item weights”.

2 Click “Specify Grade Item Calculation Properties”.

3 On the Grade Item Calculation page, in the Weight column for 
the grade item, enter the appropriate weight.

4 Click OK.

User-defined grade item weights change the impact of one 
grade item over another; therefore, it applies only to the GPAs 
that include multiple grade items, not to GPAs based on 
course grades only. For example, assume a GPA includes a 
course grade and an exam grade, and you want the course 
grade to make up two-thirds of the GPA - the course grade 
has twice as much impact on the GPA as the exam grade. You 
would set the weight of the course grade to 2 and the exam to 
1.

The school sets user-defined grade-item weights when it 
defines a GPA.

Specify what happens if a 
grade is missing

By default, missing grades are ignored. You can choose to count 
a missing grade as 0.

To change the impact of missing grades:

1 Click “Specify Grade Item Calculation Properties”.

2 On the Grade Item Calculation page, in the Missing Grade 
column for the grade item, select the appropriate setting.

3 Click OK.
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12 In the Contributing Courses panel, do one of the following:

13 In the Historical Pages panel, select “Store in historical pages upon year end processing 
and print on student transcript report”, if required.

NOTE

You can only select this option for one weighted and one unweighted current year GPA definition. 
The GPA definitions with this setting appear on the Grade Point Averages page and are preceded by 
an asterisk (*).

14 Click OK.

Working with Cumulative GPAs
Cumulative GPAs can be easily configured to meet the specific requirements of your school. 
To understand the available options, refer to the appropriate topic:

• “Options for Cumulative GPAs” on page 128

• “Using More than One Scale for Cumulative GPAs” on page 129

• “Selecting a Calculation Formula” on page 129

• “Adding and Editing Cumulative GPAs” on page 133

To Do this

Include all courses in the 
GPA calculation

• Select “Include all courses in the calculation”.

Include only certain courses 
in the GPA calculation

1 Select “Include selected courses in the calculation”. 

2 Click “0 courses selected”. 

3 On the Select Courses page, search for and select the courses 
to be included in the GPA, and then click OK.

Exclude only certain courses 
from the GPA calculation

1 Select “Exclude selected courses from the calculation”. 

2 Click “0 courses selected”. 

3 On the Select Courses page, search for and select the courses 
to be excluded from the GPA, and then click OK.

Include only a student’s top 
grades in the GPA calculation

• Select “Count only the best # of the included courses” and 
enter the number of courses.

NOTE
This option can be combined with any of those listed above.
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Options for Cumulative GPAs
Because cumulative GPA calculations include both current year and historical data, make 
sure the overall historical data on the students’ historical pages does not include any current 
year information - keep current year grades and historical grades separate. The cumulative 
GPA calculations combine the historical and current year data to produce the correct 
cumulative GPA and if historical GPAs include current year data, cumulative calculations will 
not be correct. For more information, see “Selecting a Calculation Formula” on page 129.

For any cumulative GPA definition, you can:

• Calculate as a potential credits grade average or a simple grade average.

• Apply course adjustment factors or not, regardless of the formula chosen.

• Use grade points or numeric values scaled to 100 in the calculation.

• Specify that if the student is denied credit for any reason the grade should be counted as 
0 in cumulative GPA calculations.

• Define how to treat missing grades.

• Use course leveling to apply adjustment factors.

• Use either weighted or unweighted values from historical data, regardless of the formula 
chosen.

• Control the courses by including only courses you specifically select, excluding courses 
you specifically select, or including all courses. A GPA can only include courses for which 
grades are collected, as determined by the district in the Course Catalog.

• Include the best courses in the GPA definition, such as the best five courses, rather than 
all of the courses assigned to the GPA definition.

All cumulative GPA calculations also follow these rules:

• From the current year’s grades, special grades are ignored because they have no point 
values or numeric equivalents.

• If a student is enrolled in multiple schools, the cumulative calculation includes all courses 
from all schools the student is enrolled in. The cumulative GPA definition used for a 
particular student is taken from the student’s home school. 

• If cumulative GPA definitions are set up differently at different schools, students who are 
dual enrolled may be awarded different GPAs at different schools. In this case, the 
cumulative GPA assigned at the student’s home school prints on the student’s transcript 
and, when Year End Processing is run, rolls over to the student’s historical transcript 
page. 

• On the Course Grading page at the district level, if “Exclude from GPA” is selected, then 
that course is not included in the cumulative GPA calculations. The “Exclude from GPA” 
setting supersedes the “Use in Cum GPA” setting on the Course Grading page at the 
school level.

• For a student’s grades to be included in the cumulative GPA calculation, the student must 
be enrolled during the time period to which the calculation applies. A new student’s 
grades earned prior to enrollment and entered in Chancery SMS are not counted in the 
cumulative GPA calculations because the student was not enrolled during the applicable 
time period. 
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• If a student is missing overall historical data or one or more yearly historical GPAs, the 
student is added to the suspect cumulative GPA list. However, if the student is also in a 
grade level equal to the “Start from grade level” specified on the Add/Edit Cumulative 
GPA page, the student’s cumulative GPA is calculated using the current year data.

Also be aware of the attendance rules for credit calculations that apply to the current year 
grades portion of cumulative GPA calculations. The rules are as follows:

• For current year grades, if both Award Credit and “Use in Cum GPA” on the Course 
Grading page are set to Yes, then the attendance rules set up on the “Attendance Rules 
for Credit Calculations” page that affect credit awarding are taken into account.

• If a student is denied credit due to excessive absences based on the settings on the 
“Attendance Rules for Credit Calculations” page, then the grade is considered 0 (zero) for 
the cumulative GPA calculation. For example, if a student gets 87 in a course but is 
denied credit due to excessive absences, that course is counted as 87 in current year 
averages, but as 0 for cumulative GPA calculations. For information about attendance 
rules for credit calculations, see “Set Up Attendance Rules for Credit Calculations” in the 
Chancery SMS School Setup Guide.

• If a user enters a credit override where, for example, the calculated credits earned is 0 
and it is overridden to 0.5, then the student’s actual grade is used, not 0 and not the 
overridden credits earned.

• If a student’s credits earned value is 0 due to the student’s grade, then the grade is used 
for calculations. For example, D=0 grade points in the grading table is a passing grade 
with 0% credit awarded.

Using More than One Scale for Cumulative GPAs
If you choose to set up cumulative GPAs using both grade points and numeric values scaled 
to 100, you must ensure that you are comparing grades using the same scale for historical 
and current year data. When you are using numeric values scaled to 100, this is not an issue 
because the scaling is done as part of the calculation. However, with the grade points 
method, there is no scaling. 

To accommodate no scaling for grade points, you must enter overall values in all students’ 
historical records in the same scale that you use for the Grade Points column of the grading 
table used for the current year data. This ensures that the grades are comparable.

Selecting a Calculation Formula
When you create cumulative GPAs, you must select a calculation formula. How this 
calculation formula works then depends on the calculation method you use: grade points or 
numeric values scaled to 100. 

For information about each formula, refer to the following descriptions:

• “Sum (Points x Potential Credits / Total Potential Credits (Potential Credits Grade 
Average)” on page 131

• “Sum (Points) / Total Number of Grades (Simple Grade Average)” on page 132
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The following factors apply to all cumulative GPA calculations:

• If an overall cumulative GPA exists on the historical transcript pages, it is used for the 
historical portion of the calculation. The current year portion of the calculation uses 
current year grades.

“Overall cumulative GPA” is the Cumulative GPA value entered in the Graduation 
Information panel on the Student > Historical page.

• If an overall cumulative GPA does not exist, the yearly GPA value is used for each 
historical year that has a yearly GPA.

“Yearly GPA” is the Yearly GPA value in the Course Information panel on the Student > 
Historical > Add/Edit Historical Year page.

• If at least one yearly GPA value is missing and an overall cumulative GPA does not exist, 
then the calculation is based on the yearly GPAs that do exist, and the item is included in 
the suspect cumulative GPA list.

Cumulative GPA Calculation Formula Setup Examples
For each combination, assume that no adjustment factors are applied, the GPA definitions 
are set up to use Unweighted values from the student’s historical page, and the following 
overall values have been entered:

For the current year, the student took two courses, and received a B for a 6-credit course and 
a C for a 3-credit course. The current year grading table is set up as follows:
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Sum (Points x Potential Credits / Total Potential Credits (Potential 
Credits Grade Average)
The “Potential Credits” for a grade item is the maximum credits for the course divided by the 
number of grade items within the class’s schedule that have “Use in Cum GPA” set to Yes. For 
example, if a course has a maximum credits of 1 and it has two grade items – one in each 
semester – set to “Use in Cum GPA”, the potential credits are calculated as 1 / 2 = 0.5. If the 
class only runs in one semester, the potential credits are calculated as 1 / 1 = 1.

The potential credits grade average formula weights the historical cumulative or yearly GPAs 
and the current year grades by multiplying them by their potential credits.

The formula for “Sum (Points x Potential Credits) / Total Potential Credits” using grade points 
is:

When you apply the values from the example, it looks like this:

The formula for “Sum (Points x Potential Credits) / Total Potential Credits” using numeric 
values scaled to 100 is:

When you apply the values from the example, it looks like this:
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Sum (Points) / Total Number of Grades (Simple Grade Average)
The simple grade average formula does not use weights, so each grade is considered an 
equivalent unit, regardless of the potential credits.

The formula for “Sum (Points) / Total Number of Grades” using grade points is:

When you apply the values from the example, it looks like this:

The formula for “Sum (Points) / Total Number of Grades” using numeric values scaled to 100 
is:

When you apply the values from the example, it looks like this:
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Adding and Editing Cumulative GPAs
When you edit cumulative GPAs, keep in mind that class ranks use cumulative GPAs as part 
of their definitions; you will need to recalculate class ranks because student ranks may be 
affected by your changes. 

NOTE

If your district calculates term GPAs, Chancery SMS uses the formula you set up for the cumulative GPA 
when calculating both the end-of-term GPA and the cumulative-to-end-of-term GPA. For more 
information about term GPAs, see “Grading Periods and GPA/Class Rank Reporting Terms” on page 92 
and “Calculating Term GPAs” on page 174.

To add or edit a cumulative GPA:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 5, click Grade Point Averages.

The Grade Point Averages page shows the type of GPA (Cumulative or Current Year), the 
GPA name, its formula, and its description.

3 On the Grade Point Averages page, do one of the following:

4 On the Add/Edit Cumulative GPA page, define the cumulative GPA:

To Do this

Add a cumulative GPA 
definition

• From the Actions menu, click Add > Cumulative GPA 
Definition.

Edit a GPA definition • Click the cumulative GPA definition name.

Delete a GPA definition 1 Select the cumulative GPA definition to delete. 

2 From the Actions menu, click Delete GPA Definition.

3 Click OK and skip the remaining steps.

NOTE
Deleting GPA definitions will affect the class rank definitions that use them, 
as well as the student ranks calculated using those class rank definitions.

Field Description

GPA Name Enter a unique name for the GPA of up to 55 characters. If you 
will be using more than one cumulative GPA on a report card, 
ensure the name clearly differentiates the GPA from all others.

Description If you want to describe the GPA in greater detail, enter a 
description of up to 200 characters.

Calculation formula Select one of the following:

• Sum (Points x Potential Credits) / Total Potential Credits

• Sum (Points) / Total Number of Grades

For more details, see “Selecting a Calculation Formula” on 
page 129.
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Adjustment factor If you want to apply course adjustment factors to the current 
year portion of the calculation, select “Use course adjustment 
factor to determine points”.

NOTE
If your school does not apply adjustment factors in a linear way to courses 
(i.e., you cannot always multiply by or add the same factor to all grades), 
you cannot use adjustment factors in your GPAs. Instead, set up your grading 
tables to accommodate the different course levels (advanced, remedial, 
etc.). For further information, see “Setting Up for GPA Calculations 
(including Course Leveling)” on page 75.

Calculation method Select one of the following:

• Use grade points – converts existing grades to the grade point 
equivalents specified in the grading table.

• Use numeric grades scaled to 100 – divides grades entered by 
the appropriate scale and multiplies them by 100.

Credits earned penalty If you want to penalize students who have not received credit, 
select “If credits earned is zero, count grade as zero”.

Missing grade Indicate how you want missing grades to be treated. Select one 
of the following:

• Ignore Grade Item – removes the grade item from both the 
numerator and the denominator.

• Count Item as Zero – enters a value of zero in the numerator 
and leaves the corresponding credit value in the denominator.

Level Select one of the following:

• Use Assigned Level – this uses values from the version of the 
grading table specified for the course (e.g., Honors, 
Remedial).

• Use Regular Level – this uses values from the Regular version 
of the grading table, regardless of the course level specified 
for the course. The name of this option may be different if 
your district has changed the name of the Regular course level 
setup list item.

Historical values Select one of the following:

• Use unweighted values from historical

• Use weighted values from historical

Start from grade level Select the grade level to go back to when calculating cumulative 
GPAs.

This only applies if yearly historical values are being used by the 
system, rather than overall historical values.

Historical scale Enter the scale to be used when using GPA values in historical 
records. For example, if you enter 4 and the GPA value in the 
historical records is 3.29, Chancery SMS takes 3.29 to be on a 4 
point scale. If you enter 5, the calculation is 3.29 on a 5 point 
scale.

This only applies if the Calculation Method is “Use numeric 
values scaled to 100”. No scale is required for grade points.

Field Description
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5 In the Calculation Display Result panel, from the Decimal Places dropdown, select how 
many decimal places the resulting GPA should be rounded to when displaying the result. 
This is the display precision, not the calculation precision.

When Chancery SMS does its calculations, it uses the internal value with more decimal 
places, and then rounds and displays the result in the number of decimal places you 
specify here. Therefore, the results might not be the same as calculating using the 
displayed values. You can, however, use the Cumulative GPA report to print displayed 
precision values for comparison.

6 In the Contributing Courses panel, do one of the following:

7In the Historical Pages panel, select “Store in historical pages upon year end processing 
and print on student transcript report”, if required. 

You can only select this option for one weighted and one unweighted cumulative GPA 
definition.The GPA definitions with this setting appear on the Grade Point Averages page, 
preceded by an asterisk (*).

8 Click OK.

To Do this

Include all courses in the 
GPA calculation

• Select “Include all courses in the calculation”.

Include only certain courses 
in the GPA calculation

1 Select “Include selected courses in the calculation”. 

2 Click “0 courses selected”. 

3 On the Select Courses page, search for and select the courses 
included in the GPA, and then click OK.

Exclude only certain courses 
from the GPA calculation

1 Select “Exclude selected courses from the calculation”. 

2 Click “0 courses selected”. 

3 On the Select Courses page, search for and select the courses 
excluded from the GPA, and then click OK.
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Class Ranks
A class rank is the academic standing of a student based on their grade point average in 
comparison with the other members of a class. Typically, schools calculate student class 
ranks for transcript purposes.

In Chancery SMS, you can set up class rank definitions for your school. When you create 
these definitions, you select a predefined cumulative GPA definition, as well as specify the 
grade levels and minimum enrollment days, credits, and grades for the ranking. You then run 
calculations against these class rank definitions to determine each student’s ranking in a 
class. For information about class rank calculations, see “Calculating Class Ranks” on 
page 177.

Class ranks functionality is only available for secondary schools, as class ranks are built on 
cumulative GPAs, which are also available for secondary schools only. You must set up 
cumulative GPA definitions before you can set up class rank definitions. For further 
information, see “Adding and Editing Cumulative GPAs” on page 133.

Adding and Editing Class Rank Definitions
Set up class rank definitions based on your district’s policies. If required, you can choose to 
exclude certain students who may meet eligibility requirements but who should not be 
included in class rank calculations. These students are treated as ineligible for the purposes 
of the calculation.

Some students may be ineligible to be ranked according to the class rank eligibility criteria 
you set up, but may be eligible for other reasons. In this case, you can manually rank those 
students, provided you have the access permissions. See “Permissions to Set Up Secondary 
Grading & Enter Grades” on page 58.

For information about calculating and storing student ranks, see “Calculating Student Ranks” 
on page 179. 

To add or edit class rank definitions:
1 In the control bar, under Admin, click Grading. 

2 On the Grading page, under Step 5, click Set Up Class Ranks.

3 On the Class Ranks page, do one of the following:

4 On the Add/Edit Class Rank page, specify the following:

To Do this

Add a class rank definition • From the Actions menu, click Add Class Rank Definition.

Edit a class rank definition • Click the class rank definition name.

Delete a class rank definition 1 Select the class rank definition to delete.

2 From the Actions menu, click Delete Class Rank Definition.

3 Click OK and skip the remaining steps.

Field Description

Class rank name Enter a class rank name of up to 55 characters.

Description Enter a description of up to 200 characters.
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5 In the Student Exclusions panel, search for students.

6 From the Available Student’s list, select the students you want to exclude from the 
calculation.

7 Click  to move the appropriate students to the Selected Students list.

NOTE

You can run multiple searches for students based on different criteria; the results in the Available 
list change to match the search criteria, but the Selected Student list displays a cumulative list of 
students you have selected, regardless of the search.

8 In the Global Criteria panel, specify the following:

9 In the Grade Level Specific Criteria panel, specify the following for each grade:

Field Description

Cumulative GPA Select the cumulative GPA to be used for calculating class rankS.

Rank following a tie Select what rank number to use after a tie. The options are:

• Skips number in tie – e.g., if three students were ranked 15th, 
the next student would be ranked 18th.

• Use next consecutive number – e.g., if three students were 
ranked 15th, the next student after the tie would be ranked 
16th.

Ignore all students who have 
withdrawn from the current 
year except those students 
with the following status 
codes

This option is selected by default and enables you to exclude 
students who have withdrawn during the current year. In the 
Available Items list, select the status codes to include in class 
rank calculations and click  to move them to the Selected 
Items list. Only Withdrawal type status codes are listed in the 
Available Items list.

NOTE
If you deselect this option, then all students, including students who have 
withdrawn from the current year, are included in class rank calculations.

Field Description

Grade Level Displays the grade levels from the cumulative GPA definition.

Chancery SMS always calculates class ranks for each grade level 
separately.

You can set up multiple class rank definitions for a grade level.

Include Select whether to include this grade level in class rank 
calculations.

If there are already calculated or stored ranks for a grade level, 
and you change this field to No, the calculated and stored ranks 
for this grade level are permanently deleted.
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10 In the Historical panel, if you want to store historical class rank information, select “Store 
in historical upon year end processing”. 

You can store one rank definition – weighted or unweighted – for each grade level. For 
example, if you have a class rank definition for grades 9 and 10, and another one for 
grades 11 and 12, you can select this option for both class rank definitions. If you have a 
class rank definition for grades 10 and 11, and another one for grades 11 and 12, you can 
select this option for only one of the class rank definitions, because grade 11 is in both 
class rank definitions.

NOTE

This checkbox indicates which set of stored student ranks is put on the historical pages. Before you 
run Year-End Processing, be sure to calculate (or recalculate) and store the student ranks for this 
definition so that Chancery SMS stores the correct student ranks. 

11 Click OK. 

Min Number Days Enrollment 
in District

Enter the minimum number of days students in this grade level 
must be enrolled in the district before students are eligible to be 
included in this class rank definition.

For example, your district might require that students be 
enrolled for at least the equivalent of one semester’s school days 
before they’re eligible to be included in class rank calculations.

A student who is enrolled in any school in your district is 
counted; therefore, if a student is enrolled in two schools, 
enrollment days in both schools are counted.

Min Number Credits Earned Enter the minimum number of credits students in this grade 
level must have earned, in any school or district, before they are 
eligible to be included in class rank calculations. Credits earned 
in historical years contribute to this count.

Min Number Final Grades Enter the minimum number of grade items indicated as final 
grade that students in this grade level must have earned, in any 
school or district, before they are eligible to be included in class 
rank calculations. All final grades earned in historical years 
contribute to this count, as do failing final grades in the current 
year, and final grades from other schools the student is enrolled 
in.

Field Description
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Setting Up Secondary Report Cards 
Once you create your grading structure and set up your calculations, you are ready to define 
report cards and progress reports.

Chancery SMS provides a generic report card template, which you can modify to meet your 
needs, or you can create a custom report card template. For further information, see the 
Chancery SMS Working with Secondary Report Cards and Progress Reports Technical Bulletin.

NOTE

For instructions about how to update custom secondary report cards to use the new GPA/class rank 
reporting term functionality in Chancery SMS 6.6.5, contact Pearson technical support.

You need to be sure to set up a report card for all grade levels in your school. You can create 
different report cards for different grade levels or have one report card for all grade levels.

You can have a maximum of one report card for each grade level. Once you’ve assigned a 
report card to a grade level, that grade level is no longer available for any other report card 
setup. For example, if your school has grades 9, 10, 11, and 12, you could create a report 
card and assign it to grade levels 9, 10, and 11 and then create a different report card and 
assign it to grade 12. When you set up the second report card, you only have the option to 
select grade 12 because other grade levels have already been assigned a report card.

At secondary schools, progress reports are set up just like, but separately from, report cards. 
As with report cards, each grade level can have only one progress report.

The grade levels you can choose from are defined on the Grade Levels Setup page. For 
information about grade levels, see the Chancery SMS School Setup Guide.

Creating Secondary Report Cards/Progress Reports
You can specify the columns and headings you want to show on the report cards and 
progress reports, as well as the order in which you want courses to display. In addition, you 
can specify which current year GPAs to show on report cards.

Setting up Report Card and Progress Report Options
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 6, click Report Card and Progress Report Setup.

3 On the Report Card Setup page, do one of the following:

To Do this

Add a report card • From the Actions menu, click Add Report Card. 

Add a progress report • From the Actions menu, click Add Progress Report. 

Edit a report card or 
progress report

• Click the name of the report card or progress report. 

Delete a report card or 
progress report

1 Select the report card or progress report to delete.

2 From the Actions menu, click Delete Report.

3 Click OK and skip the remaining steps.
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4 On the Edit Report Card/Progress Report page, define the report card as follows:

After you select grade levels, the page refreshes to display all defined grade items.

5 Under Report Card/Progress Report Elements, select all of the elements that you want 
displayed on the report card or progress report. 

NOTE

Due to space restrictions, if you select to display course level information, you cannot also display 
grading table legends.

Sorting Courses on Report Cards and Progress Reports
You can specify the order that courses should appear on report cards and progress reports.

To sort courses:
1 On the Edit Report Card or Edit Progress Report page, do one of the following:

Field Description

Report card/Progress report 
name

Enter a name for the report card or progress report, such as 
“Grade 10 Report Card”.

Grade level Identify the grades that this report card or progress report 
applies to. If you do not select all of the grades, ensure you 
create additional report cards and progress reports for those 
grades.

To Do this

Sort courses alphabetically 
by course name

From the Sort Courses By dropdown, select Course Name.

Sort courses alphabetically 
by course number

From the Sort Courses By dropdown, select Course Number. 
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2 If you want to display meeting pattern and term on the report card/progress report, 
under Course Information, select Meeting Pattern and Scheduling Term.

3 Click OK.

Defining Report Card GPAs, Columns, and Headers
You can specify which current year GPAs to show on the report card. Current year GPAs apply 
only to report cards, not to progress reports. For both report cards and progress reports, you 
can specify which columns and columns headings to display.

To define GPAs, columns and headers:
1 On the report card, select one or more current year GPAs in the Available list and click 

 to move them to the Selected list.

The current year GPAs in the Available list are the current year GPAs set up for your 
school. See “Setting Up Grade Point Averages” on page 117.

Sort courses by meeting 
pattern

From the Sort Courses By dropdown, select Meeting 
Pattern/Scheduling Term or Scheduling Term/Meeting Pattern. 

Selecting Meeting Pattern/Scheduling Term sorts by meeting 
pattern first and then by term, so you would see the course in 
period 1 for term 1, then the course for period 1 in term 2.

Selecting Scheduling Term/Meeting Pattern sorts by term first 
and then by meeting pattern, so you would see the courses for 
all periods in term 1 and then the courses for all periods in term 
2. For information about meeting patterns, see the 
Chancery SMS Scheduling Guide.

NOTES

• If a class is assigned to more than one term, the course is 
sorted according to the current term for the current grading 
period.

• If a class has a different meeting pattern in each term, 
courses are sorted according to the meeting pattern that 
currently applies, e.g., in semester 1, the course is sorted 
according to the meeting pattern assigned to the class for 
semester 1 and, in semester 2, according to the meeting 
pattern assigned to the class for semester 2.

• If a class is assigned to more than one meeting pattern within 
the same term, the course is sorted based on the earliest 
occurrence of the class and subsequent occurrences of the 
class are ignored. For example, if a class is assigned to 
meeting pattern 1 that meets in Period 1 on Mondays and 
meeting pattern 4 that meets in Period 4 on Wednesdays, the 
course is sorted according to Period 1 on Monday only.

• If a school has more than one term set defined, terms are 
sorted by the number of terms in the term set (smallest to 
biggest), by the term number, and then by term set name. For 
example, a full year term with 1 term would be displayed first 
and a term set with 2 terms would sort next with semester 1 
coming before semester 2.

To Do this
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2 To change the order in which the GPAs appear on the report card, change their order in 
the Selected list. To move a GPA up or down, in the Selected list, click the GPA you want 
to move and click the up or down arrow.

NOTE

If your current year GPA definition is set up to calculate for a specific report card grading period (for 
example, grading period “Report Card 1”), remember to remove the GPA from the report card setup 
when it is no longer that grading period. This is because if you are now in a new grading period 
(i.e.“Report Card 2”) but you have not removed the current GPA for the Report Card 1 grading 
period, it will still appear on the student's report card. 

3 Under Report Card/Progress Report Columns, to provide labels for the columns on the 
report card or progress report, click the Column Header field for each item and enter a 
label or use the grade item code that appears by default.

If you defined a numeric grading table and set the Equivalent Grade Type to Letter Grade 
or Graphic Symbol, you can use the Grade Item Display setting to specify whether you 
want to display the numeric value, the Equivalent Grade value, or both for the grade 
item. For more information about grading tables, see “Selecting a Grading Table Type” on 
page 65.
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4 Add summaries of attendance and credits:

NOTE

If you add a Credit Awarded or Cumulative Absences column, the Grade Item Display column shows 
N/A. 

5 If you want to display a grade item as a row on the report card or progress report instead 
of a column, select the grade item under Report Card Columns. From the Actions menu, 
click Switch Row/Column. 

When positioning elements as rows or columns, the following restrictions apply:

• Grade items that use Numeric, Letter Grade, or Graphic Symbol grading tables can be 
either columns or rows. They appear as columns by default. 

• Grade items that use comment grading tables must appear in rows. 

• Credit Awarded and Cumulative Attendance can appear only as columns.

• Total Absences, Unexcused Absences, and Excused Absences can appear only as 
rows.

6 Click OK.

To add this Do this

A column showing credit 
awarded for a grade item 
(report card only)

1 Under Report Card Columns, select a grade item. 

2 From the Actions menu, click Add Column > Credit Awarded.

A column indicating the 
cumulative absences in a 
course (report card only)

1 Under Report Card Columns, select a Course Grade for one of 
the grading periods. 

2 From the Actions menu, click Add Column > Cumulative 
Absences.

A column indicating the total 
absences in a course 
(progress report only)

1 Under Progress Report Columns, select a Course Grade for 
one of the grading periods. 

2 From the Actions menu, click Add Column > Total Absences.

A row of total absences 
(excused and unexcused) for 
each grade item for each 
grading period

• From the Actions menu, click Add Row > Total Absences.

A row of unexcused 
absences for each grade 
item for each grading period

• From the Actions menu, click Add Row > Unexcused 
Absences.

A row of excused absences 
for each grade item for each 
grading period

• From the Actions menu, click Add Row > Excused Absences.
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Interpreting Attendance Values on Secondary Report Cards
Cumulative Absences typically indicate absences during the selected grading period. 
However, if you add only one Cumulative Absences column and it is in the last grading 
period, the column indicates absences during the entire year.

Attendance numbers for a course only appear on the report card if the course appears on the 
report card. 

Therefore, if a student transfers between courses, the report card displays both courses – 
and absences in them – only if the student receives a grade for both courses. Similarly, if a 
student withdraws, the report card displays the course – and absences in it – only if the 
student receives a grade for the course.

Filtering and Grouping for Distribution
Chancery SMS includes several options for filtering and grouping report cards/progress 
reports for distribution. 

To filter and group for distribution:
1 In the control bar, under Admin, click Reports.

2 On the Reports List page, under Grading Reports, click Secondary Progress Report or 
Secondary Report Card. 

3 On the Report Options page, from the Grading Period Set dropdown, select the grading 
period set.

4 From the Grading Period dropdown, select a grading period. 

5 To filter report cards/progress reports, do one of the following:

To Do this

To include students who 
have withdrawn from the 
school after grades were 
collected

This option applies to all 
filters.

• Under students, select “Include withdrawn students who have 
grades”.

Print report cards/progress 
reports for all students

• Under students, select “All students from the selected grading 
period”.

Print report cards/progress 
reports for students in a 
specific grade level

• Under students, select Selected Grade Levels. Select the 
grade levels. 

NOTE
Available grade levels display when a grading period set and grading period 
are selected. 

Print report cards for specific 
students

1 Under students, select Selected Students.

2 In Last Name and First Name fields, enter the student name 
search criteria. Click Search.

3 Students matching the search criteria are added to the 
Available Students list.

4 In the Available Students list, select students and move them 
to the Selected Students list.
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6 To group the print output for distribution, do one of the following:

NOTE

If a student does not match the selected grouping criteria, their report card prints at the end of the 
print run, sorted by student last name. 

Print reports for students 
who have a course taught by 
a specific teacher 

For example, use this option 
if a teacher made a grading 
error and you need to reprint 
the report cards for all 
students in her classes

1 Under students, select “Students taught by teacher in the 
selected grading period”.

2 In the Available Teachers list, select teachers and move them 
to the Selected Teachers list.

Print reports for students 
who are taking a specific 
course

1 Under students, select “Students taking course in selected 
grading period”.

2 Use basic or detail search to search for specific courses or 
click Display All Records.

Courses matching the search criteria are added to the 
Available Courses list.

3 In the Available Courses list, select courses and move them to 
the Selected Courses list.

To Do this

Group by student 
homeroom, then sort by 
student last name

In Sort Options, select Homeroom/Student Last Name.

Sort by student last name, 
then student first name

In Sort Options, select Student Last Name.

Group by Grade Level, then 
sort by student last name

In Sort Options, select Grade Level/Student Last Name.

To Do this
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7 Click Preview.

Group by the student’s 
teacher in a specific period, 
then sort by student last 
name

1 In Sort Options, select “Student’s teacher in period/Student 
last name”.

2 In the date fields, select the date. Chancery SMS groups the 
report cards based on the student’s schedule on the selected 
date.

3 If more than one scheduling group is defined for the school, 
from the Scheduling Group dropdown, select the appropriate 
scheduling group.

4 In the Day field, verify the scheduling day assigned to the 
specified date.

5 In Period Name, select the period you want to distribute 
report cards in.

6 If you want to exclude students who are not taking classes in 
the specified scheduling group, click “Exclude students not 
scheduled for the specified scheduling group”.

For example, if your school has different scheduling groups for 
middle and high school students. You can print report cards 
for your middle school students and exclude the high school 
students, so their report cards don’t print at the end of the 
print run sorted only by student last name. Then you can print 
report cards for the high school students and exclude the 
middle school students. 

To Do this
148 Setting Up Secondary Report Cards
Creating Secondary Report Cards/Progress Reports



Setting Up Transcripts (School-Level)
A transcript is an official document that summarizes a student’s academic history. Often, 
transcripts summarize secondary school performance for students applying to college or 
university.

Setting up transcripts involves both the district and the school. The steps are as follows:

1 The district:

• Chooses the columns that contain grade information and what their names are, such 
as S1 for Semester 1 and S2 for Semester 2. The district can choose up to four 
columns for grade information.

• Chooses the specific content of the transcript, including the subject areas that are 
shown, the tests the person printing the transcript can choose to show, and specific 
details such as whether the student’s address or the principal’s name is shown.

• Informs the schools that it has completed its part of the transcript setup.

For information about these steps, see the Transcript Setup topic in the Chancery SMS 
District Administration guide.

2 The schools define the grade items that correspond to each of the columns the district 
has chosen. See “Setting Up Grade Items for Historical Courses” on page 150.

When all of these steps are completed, historical information can be entered or imported. 

About Transcripts
You can print student transcripts for students who have historical transcript information, 
meaning that information has been:

• Manually entered on the Historical student pages. See “Student Historical Transcript 
Information” on page 153.

• Imported as historical data. See the Chancery SMS Import/Export Guide.

• Entered in a previous year and converted to historical records through Year-End 
Processing. See the Chancery SMS School User Guide.

Transcripts in Chancery SMS also include current year data and up-to-date cumulative GPAs. 
You can group transcripts by school year (e.g., 2000, 2001, 2002), or by subject area.

Transcripts can include the following information: 

• School and student information 

• Courses, course grades, and grade averages

• Attendance

• Scores on state or college exams

• Credits

• Graduation information

Printing transcripts is like printing other reports in Chancery SMS. For information about 
printing transcripts, see the Reports topic in the Chancery SMS School User Guide.
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Setting Up Grade Items for Historical Courses
The district defines much of the information that appears on transcripts. However, each 
school needs to customize historical information and transcripts in these ways:

• Identify all the grade items that can be collected for historical courses at the school. 
Grade items are anything related to a course that you can collect a grade for, such as a 
semester 1 grade, a semester 2 grade, a final grade, a semester 1 exam, and a semester 
2 exam. You can define up to 12 grade items; however, you can display only 4 grade 
items on transcripts.

• Identify which grade items appear on transcripts by linking your grade items to the 
transcript columns the district created. The district can create up to four columns. Be sure 
to define and link a grade item to each one. The only grade items that will show on 
transcripts are the ones linked to transcript columns. 

• Determine whether each grade item awards credit. 

• Determine whether each grade item is used in cumulative GPAs. 

Before you customize your school transcripts, ensure the district has named the transcript 
columns.

To name and link grade items to transcript columns:
1 In the control bar, under Admin, click School Setup.

2 On the School Setup page, under School, click Transcript Grade Items.

Transcript columns
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3 On the Transcript Grade Items page, add the transcript column and a description by 
clicking in the rows and entering the column name and description. You can create up to 
12 grade items.

4 From the Transcript Column dropdown, select the column that will be linked to each grade 
item, if any. The district can create up to four columns. Be sure to define and link a grade 
item to each column. The only grade items that will be shown on transcripts are the ones 
linked to transcript columns. 

You can link multiple grade items to a transcript column. For example, the district has set 
up transcript columns for Semester 1 and Semester 2 and you want to display  
Semester 1 and Semester 2 exam marks on the transcript. You would link the Semester 
Exam grade item to the Semester 1 transcript column and to the Semester 2 transcript 
column.

5 If more than one option is available in the Award Credit dropdown, select one of the 
following:

• Yes – credit is awarded for this grade item at this school.

• Blank – credit is not awarded for this grade item at this school.

Two options are available to you only if the district chose School-Defined when setting up 
Transcript Columns at the district level. 

6 If more than one option is available in the “Use in Cum GPA” dropdown, select one of the 
following:

• Yes – this grade item is used in Cumulative GPAs at this schools.

• Blank – this grade item is not used in Cumulative GPAs at this school.

Two options are available to you only if the district chose School-Defined when setting up 
Transcript Columns at the district level. 

7 Click OK.

Transcript grade items 
where you store 
historical grades for a 
student

Transcript columns 
defined by the district
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Student Historical Transcript Information
Historical transcript data for secondary students is used by Chancery SMS when calculating 
cumulative GPAs or, if your district calculates GPAs by term, when calculating 
cumulative-to-end-of-term-GPAs. Before you run cumulative GPA calculations, it’s important 
to ensure that historical data has been entered. 

You can enter three types of historical transcript information:

• Summary information about all past school years, such as the student’s cumulative GPA, 
weighted and unweighted GPAs by term, total absences, total points, total credits, and so 
on. You enter summary information about the main Historical page in the fields on the 
Graduation Information panel.

• Information about a specific year, such as the student’s school, credits and GPA that year, 
and class rank. You enter information about a specific year on the Add/Edit Historical Year 
page.

• Information about the courses a student took in a specific year, such as the course name 
and number and the grade that the student received. You enter course information on the 
Add/Edit Historical Course page. You can see a list of all the courses for a specific year on 
the Historical Courses page. 

Permissions to Work with Historical Transcript 
Information
To work with historical transcript records, you need the following permissions:

For further information about permissions, contact your district administrator or see the 
Chancery SMS Permissions Guide.

Methods for Entering Historical Transcript Information
Student historical transcript information can be entered using the following methods:

• Imported as historical data. This method is typically used when there are many students 
who require historical data entry. For information about importing records, see the 
Chancery SMS Import/Export Guide.

• Populated during Year End Processing. After a school has used Chancery SMS for the first 
school year, current year information becomes historical information through an 
automated process during Year End Processing. For details, see the Chancery SMS 
Next-Year Preparation and Year-End Processing Guide.

• Manually entered on the student’s Historical pages. This method is typically used when 
only one or two students require historical data entry. This chapter covers this manual 
entry method. Refer to the appropriate sections for details: 

• “Entering and Editing Historical Transcript Summary Information” on page 154 

• “Entering and Editing Historical Term GPAs” on page 156

To You need this permission Set to

Add and edit historical records Transcript/Permanent Record>Student Historical Data Edit

Delete historical records Transcript/Permanent Record>Student Historical Data Delete
Student Historical Transcript Information 153
Permissions to Work with Historical Transcript Information



Chancery SMS Grading Setup Guide
• “Entering and Editing Historical Transcript Year Records” on page 158 

• “Entering Information About Students’ Past Courses” on page 161 

For information about displaying historical transcript information about transcripts, refer to:

• “Setting Up Transcripts (School-Level)” on page 149

• “Student Transcript Report” in the Chancery SMS School User Guide

Entering and Editing Historical Transcript Summary 
Information
Use the historical transcript summary page to enter and edit information, such as the 
student’s graduation date, cumulative GPA, total absences, total credits, and so on, for all 
historical years.

Historical transcript summary information is used in cumulative GPA calculations. If historical 
summary information is not available, cumulative GPAs are calculated using historical year 
data. See “Entering and Editing Historical Transcript Year Records” on page 158.

To enter or edit historical summary information:
1 Open a student record.

2 In the control bar, click Historical.

3 On the Historical page, in the Graduation Information heading bar, click Edit. 

4 On the Edit Graduation Information page, enter or edit the following information:

Field Description

Program Type Enter the program type; for example “Accelerated” or “Regular”.

High School Enrollment Date Enter the date the student entered high school. 

Graduation Date If applicable, enter the official date the student graduated from 
high school.

Coursework Completion Date Enter the date the student actually completed all coursework – 
but not necessarily the tests – required for graduation.

Graduation Status Chancery SMS automatically populates this field when the 
student graduates from your district. 

Grant Eligibility Select either Yes or No to indicate whether the student is eligible 
for grants. Eligibility is usually associated with the program type 
taken by the student. For example, students in the Accelerated 
Program Type may be eligible, while students in the Regular 
Program Type may not be.

Total Absences Enter the number of daily absences the student had in all 
historical school years.
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Total Credits Potential – Enter the total number of credits the student could 
have earned for all courses the student attempted in all 
historical school years.

NOTE
This value is not used for cumulative GPAs.

Earned – Enter the total number of credits the student actually 
earned in all historical school years.

State – Enter the total number of credits the student earned for 
state courses in all historical school years.

Local – Enter the total number of credits the student earned for 
local courses in all historical school years.

Cumulative GPA Unweighted – Enter the student’s unweighted GPA for all 
historical school years. 

Weighted – Enter the student’s weighted GPA for all historical 
school year.

Potential Credits for 
Cumulative GPA

Enter the potential credits for historical school year courses that 
are to be included in cumulative GPA calculations.

The difference between these fields and the Total Credits - 
Potential field is that the credits you enter here are the total 
potential credits for historical courses that are to be used in the 
cumulative GPA only, whereas the numbers in the Total Credits - 
Potential field include credit for all courses the student 
attempted.

NOTE
If this field is blank, cumulative GPA calculations use the yearly historical 
GPA values - not the Total Credits value.

Unweighted – Enter the total number of unweighted potential 
credits the student could earn for his or her cumulative GPA.

Weighted – Enter the total number of weighted potential credits 
the student could earn for his or her cumulative GPA. 

Total Points Depending on what you use for your cum GPA calculations, you 
can enter either total grade points or percentage points in this 
field.

Values entered here are used only when calculating cumulative 
GPAs using the simple average formula.

Unweighted – Enter the total number of unweighted points the 
student earned in all historical school years.

Weighted – Enter the total number of weighted points the 
student earned in all historical school years.

Field Description
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5 Click OK.

Entering and Editing Historical Term GPAs
If your district has set up Chancery SMS to produce term GPAs, a Term GPAs panel appears 
on the Historical page. Use the fields on this panel to track the student’s historical term GPAs. 

For detailed information about term GPAs see “Grading Periods and GPA/Class Rank 
Reporting Terms” on page 92 and “Calculating Term GPAs” on page 174. 

To enter or edit historical term GPAs:
1 Open a student record.

2 In the control bar, click Historical.

3 On the Historical page, in the Term GPAs panel, do one of the following:

Total Number of Grades This number is intended to take into account only the number of 
grades for courses that were to be counted in the cumulative 
GPA calculation.

Values entered here are used only when calculating cumulative 
GPAs using the simple average formula.

Unweighted – Enter the total number of unweighted grades for 
the student in all historical school years.

Weighted – Enter the total number of weighted grades for the 
student in all historical school years.

To Do This

Add or edit a historical 
end-of-term GPA or historical 
cumulative-to-end-of-term 
GPA

1 If your district uses weighted GPA values, click the Weighted 
tab.

2 Go to Step 4.

Field Description
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4 Enter the following information (if your district uses weighted GPA values, click the 
Weighted tab and enter the information under that tab):

5 Click Save.

Delete a historical 
end-of-term GPA or historical 
cumulative-to-end-of-term 
GPA

1 If your district uses weighted GPA values, click the Weighted 
tab.

2 Clear the fields.

3 Click Save.

Add additional rows to enter 
more term GPAs

• From the Actions menu, click “Add Rows To Term GPAs”.

Field Description

Year Enter the year to which the student’s end-of-term GPA and 
cumulative-to-end-of-term GPA applies.

GPA/Class Rank Reporting 
Term

Select the applicable GPA reporting term. 

Term GPA For the reporting term you selected, Enter the GPA for the 
student. 

Pot Cr for Term GPA If the potential credits formula was used to calculate the term 
GPA, enter the potential credits. 

NOTE
If you enter the total number of grades in the “# Grades Term GPA” field, 
you cannot enter potential credits.

# Grades Term GPA If the simple grade average formula was used to calculate the 
term GPA, enter the total number of grades. 

NOTE
If you enter potential credits in the “Pot Cr for Term GPA” field, you cannot 
enter the total number of grades.

Cum Term GPA Enter the cumulative-to-end-of-term GPA for the reporting term 
you selected.

Pot Cr for Cum Term GPA If the potential credits formula was used to calculate the 
cumulative-to-end-of-term GPA, enter the potential credits. 

NOTE
If you enter the total number of grades in the “# Grades Cum Term GPA”, 
you cannot enter potential credits.

# Grades Cum Term GPA If the simple grade average formula was used to calculate the 
cumulative-to-end-of-term GPA, enter the total number of 
grades. 

NOTE
If you enter potential credits in Pot Cr for Cum Term GPA field, you cannot 
enter the total number of grades.

To Do This
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Entering and Editing Historical Transcript Year Records
Before you can enter student course data for a specific historical school year, you must create 
a historical transcript year.

When you create a historical transcript year, use the Add/Edit Historical Year page to enter 
the student’s:

• school information for the year, such as the school name and address

• graduation information for the year, such as the credits and GPA

• ranking information for the year, such as the student’s class rank

• daily attendance information for the year, such as the absences and tardies

At a minimum, you must identify the year, the school name and number, and the student’s 
grade level in order to save the record. (Other historical information is not required to save 
the record but may be required by your district.)

NOTE

If historical transcript summary information is not entered, cumulative GPAs are calculated using yearly 
historical transcript data. If one or more historical year fields are blank, the historical yearly data that is 
available is used and the cumulative GPA result is marked as “suspect”.

To enter or edit a historical year:
1 Open a student record.

2 In the control bar, click Historical.

3 On the Historical page, do one of the following:

To Do this

Add a new year. • From the Actions menu, click Add Historical Year.

Edit an existing year. • In the Historical Years panel, click the year.

Edit more than one existing 
year.

1 Under Historical Years, select the years you want to edit. 

2 From the Actions menu, click Edit Historical Year.
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4 On the Add/Edit Historical Year page, in the School Information panel, enter or edit the 
following information:

5 In the Year Information panel, enter or edit the following information: 

Field Description

Year Enter the year with which all the information is associated. Use 
the year that started the academic year, such as “2004” for the 
2004-2005 academic year. 

NOTE

When you run the transcript report, if you choose to group information by school 
year, the year displays as a heading over each section of course information.

School Identify the school the student attended that year as follows:

If the school uses Chancery SMS:

1 Click Select.

2 In the Select School dialog, click a school.

3 Click OK. The remaining School Information fields are filled in 
with information for the selected school. 

OR

If the school does not use Chancery SMS, in the School field, 
enter the school name. 

School Number If the school is out of district, enter the number that identifies 
the school.

If you chose a Chancery SMS school using the Select link, this 
information is entered for you.

College Board Campus Code 
(CBCC)

If the school is out of district, enter the number that uniquely 
identifies the school for the college board. Students present this 
number when they are evaluated in any of the college board 
exams. 

District Number If the school is out of district, enter the number that identifies 
the district. 

Principal If the school is out of district, enter the name of the principal of 
the school that year. If you chose a Chancery SMS school using 
the Select link, this information is entered for you.

Address, City State, Country, 
ZIP, Phone, and Fax

If the school is out of district, enter the contact information for 
the school. If you chose a Chancery SMS school using the Select 
link, this information is entered for you.

Comments Enter information about this school that does not fit elsewhere. 
This information does not appear on transcripts.

Field Description

Grade level Enter the grade level of the student that year.

Homeroom Enter the name or number of the student’s homeroom that year. 
You can enter up to 10 characters. 

Yearly Absences Enter the total number of daily absences the student had that 
year. 
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6 In the Ranking Information panel, enter or edit the following information:

Yearly Credits Potential – Enter the total number of credits the student 
attempted to earn that year.

Earned – Enter the total number of credits the student 
successfully earned that year.

State – Enter the total number of credits the student earned for 
state courses that year.

Local – Enter the total number of credits the student earned for 
local courses that year.

Yearly GPA Unweighted – Enter the student’s unweighted GPA for that year. 

Weighted – Enter the student’s weighted GPA for that year.

Total Points Unweighted – Enter the student’s unweighted points for that 
year. 

Weighted – Enter the student’s weighted points for that year.

Total Number of Grades Unweighted – Enter the student’s unweighted grades for that 
year. 

Weighted – Enter the student’s weighted grades for that year.

Comments Enter information about the student’s graduation information 
that does not fit elsewhere. This information does not appear on 
transcripts.

Field Description

Class Rank Date Enter the date when class rank was calculated that year.

Class Rank If the student was formally ranked against the rest of the class, 
enter their rank in this field. For example, if the student was the 
second best student out of a class of 200, enter “2” for Class 
Rank. 

NOTE
Do not enter a value in both the Relative Position Only field and the Class 
Rank field.

Relative Position Only If the student was assigned a relative position against the rest of 
the class—possibly because the student came from outside the 
district—enter the number in this field. Do not enter a value in 
both the Relative Position Only field and the Class Rank field.

Out Of Enter the number that identifies the total number of classmates 
that student is being compared against. For example, if the 
student ranked 2 out of 200, enter “200”.

Percentile Enter the student’s class rank as a percentage. 

Field Description
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7 In the Daily Attendance Information panel, enter or edit the following information:

8 If you are editing more than one year at a time, move to another year by selecting from 
the year dropdown at the top of the page or by clicking Next.

9 Click OK.

Entering Information About Students’ Past Courses
You can enter detailed information about the courses a student took in previous years, along 
with the grades the student earned.

Before you can enter courses, you must create a historical transcript year to identify the year 
the courses were taken. See “Entering and Editing Historical Transcript Year Records” on 
page 158.

To add or edit a historical course:
1 Open a student record.

2 In the control bar, click Historical.

3 On the Historical page, in the Historical Years panel, click the number in the No. Courses 
column corresponding to the year the courses were taken. If no courses have been added 
yet, click the “0”.

Field Description

Present Enter the number of times the student was present for the year.

Excused Absences Enter the number of times the student was absent during the 
year with a valid reason.

Unexcused Absences Enter the number of times the student was absent during the 
year without a valid reason.

Excused Tardies Enter the number of times the student was late during the year 
with a valid reason.

Unexcused Tardies Enter the number of times the student was late during the year 
without a valid reason.

To work with 
another year, 
select from the 
dropdown, or click 
Prev or Next.

Click to add 
or edit a 
historical 
course.
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4 On the Historical Courses page, do one of the following:

5 On the Add/Edit Historical Course page, in the Course Information panel, enter or edit the 
following information:

To Do this

Add a new course. • From the Actions menu, click Add Historical Course.

Delete an existing course. 1 Select the course to delete.

2 From the Actions menu, click Delete Historical Course.

3 Click OK and skip the remaining steps.

Edit an existing course. • Click the course number.

Field Description

Exclude From Cum GPA Calcs Select Yes or No to specify whether the course should be 
included or excluded from GPA calculations.

Show on Transcript Select Yes or No to specify whether the course appears on the 
transcript.

Summer School Currently, this field is not used. In a future version of Chancery 
SMS, this field will identify whether the course was taken as part 
of a summer school program. 

Course Number Enter the official number (identifier) of the course.

State Course ID Enter the official number (identifier) assigned by the state to the 
course. 

Course Name Enter the name of the course.

Alternate Name If the course has another name, enter it.

Short Name Enter an abbreviated version of the course name.

Course Type Enter the type or category of the courses; for example, 
“Academic”.

Department Enter the department the course is in; for example “English”.

Course Level Enter the level of difficulty of the course; for example “Regular” 
or “Honors”.

Course Grade Level Enter the grade level of the course.

Section Enter the section of the course.

Teacher Enter the name of the teacher of the course.

Subject Area Select the subject area of the course; for example, “Science” or 
“Mathematics”. 

Description Enter a description of the course.

Adjustment Factor If a course adjustment factor was used in this course, select this 
option, then enter the adjustment value in the applicable Add or 
Multiply field.
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6 In the Course Attendance Information panel, enter or edit the following information:

7 In the Grades Information panel, enter or edit the following information:

8 If you are editing more than one existing course, choose from the dropdown at the top of 
the page or click Next to move to the next course. Your changes are automatically saved.

9 Click OK.

Field Description

Present Enter the number of times the student was present for the 
course.

Excused Absences Enter the number of times the student was absent from the 
course with a valid reason.

Unexcused Absences Enter the number of times the student was absent from the 
course without a valid reason.

Excused Tardies Enter the number of times the student was late for the course 
with a valid reason.

Unexcused Tardies Enter the number of times the student was late for the course 
without a valid reason.

Field Description

Grade Item Whether you need to enter grade items here depends on the 
following:

• If, when you added the historical year, you chose a Chancery 
SMS school using the Select link, you do not need to add 
grade items because the school’s transcript grade items 
automatically display here. 

• If, when you added the historical year, you did not use the 
Select link and manually entered the school, you must enter 
the grade items.

Leveled Letter Grade, 
Leveled Numeric Grade 
Leveled Grade Points

Enter a grade for this grade item in one of these columns.

P/F Select P or F to indicate whether the grade is a pass or fail.

Final Grade Select Yes or blank (blank means no).

NOTE
The final grade is used when calculating class ranks, but only when the Min 
Number Final Grades grade level criteria is being used on the Class Ranks 
page. See “Adding and Editing Class Rank Definitions” on page 137.

Potential Credits Enter the credits the student can earn for this grade item.

Credits Earned Enter the credits the student actually earned for this grade item.
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Performing Grading Calculations & 
Overrides
Within grading at secondary schools, there are several calculations that are performed 
automatically by Chancery SMS or initiated by users and run as tasks in the background:

• Grade calculations. See “Calculating Grades” on page 165.

• Student credit calculations. See “Calculating Student Credits” on page 166.

• Current year and cumulative GPAs. See “Calculating GPAs” on page 173.

• Class ranks calculations based on GPAs. See “Calculating Class Ranks” on page 177.

NOTE

Ensure all required grades have been entered before performing any grading calculations.

Calculating Grades
Grades should be calculated before student credit, GPA, or class rank and honor roll 
calculations. There are two parts to the process:

• From the Grading page, you can run the grade calculation task from a new calculations 
page. See “Performing Grade Calculations” on page 165.

• Once the calculations are complete, the calculated grade can be manually changed on the 
Student Grades and Class Grades pages in the same way as you would enter any other 
grade. See “Overriding Grade Calculations” on page 166.

For information about how to set up grade calculations, see “Grade Calculations for Semester 
Grade Averages” on page 97.

Performing Grade Calculations
All calculations for grades, credits, and GPAs are run from the same page.

To perform grade calculations:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 7, click “Calculate Grades, Credits, & GPAs”.

3 On the “Calculate Grades, Credits, & GPAs” page, in the Students panel, do one of the 
following:

• To run the calculation for all students, choose “All students in the school”.

• To run the calculation for selected students, choose “Selected students”. Use the Basic 
or Detail tabs to search for and select all students for whom you want to perform the 
calculation.

4 In the Calculated Grades panel, select the grade calculations to be run. 

NOTE

You can run this calculation with other calculations on the page.

5 From the Actions menu, click Run Calculation. In the confirmation dialog, click OK.

The grades are calculated in the background. You will receive an alert when the task is 
complete.
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Overriding Grade Calculations
Calculated grades can be overridden either from the Class Grades page or from the Student 
Grades page.

To override calculated grades for a class:
1 In the control bar, click Classes.

2 On the Classes page, click the Grading icon for the class.

3 On the Class Grades page, calculated grades are indicated with the Calculated Grades 
icon ( ). To view the calculated grade formula, pause the cursor over the icon.

4 Click the Calculated Grades icon.

5 In the Calculated Grades Override dialog, enter or select the appropriate grade. If 
override reasons are required for the district, from the dropdown, select an override 
reason.

6 Click OK.

On the Class Grades page, calculated grades that have been overridden are indicated 
with a tilde (~).

7 Click Save.

To override calculated grades for a student:
1 Open a student record.

2 On the Student Demographics page, in the control bar, click Grades.

3 On the Student Grades page, calculated grades are indicated with the Calculated Grades 

icon ( ). To view the calculated grade formula, pause the cursor over the icon.

4 Click the Calculated Grades icon.

5 In the Calculated Grades Override dialog, enter or select the appropriate grade. If 
override reasons are required for the district, from the Override Reason dropdown, select 
an override reason.

6 Click OK.

On the Student Grades page, calculated grades that have been overridden are indicated 
with a tilde (~).

7 Click Save.

Calculating Student Credits
Chancery SMS calculates the credits a student receives according to the grading table you 
are using.

A student’s credits earned are awarded based on the following:

• A credit-awarding grade item for a course the student has taken has a posted grade.

• Attendance Rules for Credit Calculations is either turned off or the student satisfies those 
attendance rules. A student who does not satisfy attendance rules is denied credit, 
overriding any calculation that might have given credit.
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If they meet the above rules, students are eligible for full credit at the end of the class; 
whether they receive full credit then depends on the student’s grade. For more examples of 
how credits are calculated, see “Examples of Credit Calculations” on page 167.

If your district uses attendance rules for credit calculations, then students might be denied 
credit due to excessive absences. For more information, see “Set Up Attendance Rules for 
Credit Calculations” in the Chancery SMS School Setup Guide, available from the Pearson 
Customer Support website.

From the Grading page, you can run credit calculations. See “Performing Student Credit 
Calculations” on page 170. Once the credits calculations are complete, you can override 
credits for individual students. See “Overriding Student Credit Calculations” on page 171.

All credit overrides are recorded in the audit log so that an audit trail is kept. For information 
about viewing the audit log, see “Viewing Audit Trail Records” in the Chancery SMS School 
Setup Guide. 

NOTE

If a student’s grade is deleted, the calculated credits earned and any overridden credits earned are also 
deleted, so the student will not have any credits.

Examples of Credit Calculations
• For each course in the course catalog, the district chooses whether to set the “Allow 

Partial Credits” flag. See “Allow Partial Credits” on page 167.

• Schools can set up classes using different scheduling term sets, and students can be 
assigned to those classes with a schedule that may or may not match the schedule of the 
class. See “Class and Student Schedules” on page 168.

Allow Partial Credits
When “Allow partial credits” is not selected for a course on the Course Grading page (set at 
the district level), only one grade item can be credit-awarding. Credit cannot be awarded to a 
student until a grade has been entered for that credit-awarding grade item. 

However, when “Allow partial credits” is selected, multiple grade items can be set up to be 
credit-awarding. When a grade is entered for credit-awarding grade items, credits are 
awarded for each grade item based on potential credits, which is the maximum allowable 
credits for the course divided by the number of grade items with “Award Credit” set to Yes, 
and on the student’s schedule for the class. For example, if a full-year course has a 
maximum of 1 credit and it has a grade item in each semester with an Award Credit setting 
of “Yes”, then the potential credits is 1 / 2 = 0.5. If the student is taking only the second half 
of the class, he or she is eligible for a maximum of 0.5 credits.

Once potential credits have been determined, credits are awarded based on the way that the 
grading table has been set up. For example, you can set up a grading table where receiving a 
grade of A, B, or C allows 100% of the potential credit to be earned, D allows 50%, and F 
allows 0%. At the end of the course with maximum credits of 5 and two credit-awarding 
grade items, students receive the following for each grade item:

Grade % Credit Potential Credits Calculation Credits Earned

A 100% 2.5 100% x 2.5 2.5

B 75% 2.5 100% x 2.5 2.5
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A student that gets a C for the first grade item and a D for the second grade item receives 
2.5 credits (100% x 2.5) and 1.25 credits (50% x 2.5) for a total of 3.75 credits. The credits 
will be awarded for each grade item when the grade is entered for that item.

Class and Student Schedules
The other major elements that determine how credits are awarded are the scheduling terms 
set for the course, the schedule for the class, and the schedule for the individual student. 
Chancery SMS takes each of these into consideration when calculating credits. 

For example, if a course is set up using a Semesters scheduling term set to accommodate 
setting up classes in each semester, as well as year-long classes, partial credits can be set up 
to allow a credit-awarding grade item in each term. If the student takes the full-year class, 
they are eligible for partial credit at the end of each semester. If the student takes the 
Semester 1 or Semester 2 class, they are eligible for the full credit at the end of the 
appropriate semester.

The key principle is that the student is eligible for full credit whenever their schedule matches 
the schedule of the class.

NOTE

Because the system now takes multiple factors into consideration when calculating credits, the grading 
properties for a course will no longer provide a visual cue for users as to how credit will be awarded.

The following table shows how credits are awarded based on the supported scheduling 
scenarios with the following assumptions:

• Max Credit is set to 1 for each course.

• The school uses full year and semester courses with nine-week grading periods, e.g., 
quarters.

• If Allow Partial Credits is selected, there is only one credit-awarding grade item in each 
semester. 

• The student has earned a grade that allows them to receive full credit based on the 
grading table:

C 50% 2.5 100% x 2.5 2.5

D 25% 2.5 50% x 2.5 1.25

F 0% 2.5 0% x 2.5 0

Grade % Credit Potential Credits Calculation Credits Earned
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Scheduling Term Set Student Schedule
Allow Partial Credits 
Not Selected

Allow Partial Credits 
Selected

Full Year (1 class 
scheduled across the 
full year)

NOTE
If Partial Credit is not 
enabled, the credit-
awarding grade item is in 
Semester 2.

Entire Class 1 credit awarded at the 
end of the year.

Half of the potential 
credits awarded at the 
end of Semester 1 and 
half awarded at the 
end of Semester 2, 
adding up to a 
potential of one credit 
for the full year course. 

Semester 1 only No credit awarded. Half of the potential 
credits awarded at the 
end of Semester 1, 
adding up to a 
maximum potential of 
.5 credits for taking 
half the course. 

Semester 2 only 1 credit awarded at the 
end of the year.

Half of the potential 
credits awarded at the 
end of Semester 2, 
adding up to a 
maximum potential of 
.5 credits for taking 
half the course. 

Semesters (2 classes, 
one in each semester, 
e.g. Math-1 in S1 and 
Math-2 in S2)

NOTE
If you want to schedule a 
single course across two 
semester, e.g., Math-1 in 
S1 and S2, use a Full Year 
term set.

Both classes

NOTE
Student may be retaking 
the course to get a better 
grade.

Not supported because 
you cannot have two 
credit awarding grades 
when partial credits is 
not selected.

1 potential credit 
awarded at the end of 
Semester 1 and 1 
credit awarded at the 
end of Semester 2, 
adding up to a 
maximum potential of 
two credits for taking 
both classes.

Semester 1 only Not supported because 
you cannot have two 
credit awarding grades 
when partial credits is 
not selected. 

1 potential credit 
awarded at the end of 
Semester 1, adding up 
to a maximum 
potential of 1 credit for 
the course.

Semester 2 only Not supported because 
you cannot have two 
credit awarding grades 
when partial credits is 
not selected. 

1 potential credit 
awarded at the end of 
Semester 2, adding up 
to a maximum 
potential of 1 credit for 
the course.
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Performing Student Credit Calculations
You perform student credit calculations from the same page as calculations for grades and 
GPAs. 

NOTE

When you open the Student Credits page, the credits are automatically re-calculated.

To perform student credit calculations:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 7, click “Calculate Grades, Credits, & GPAs”.

3 On the “Calculate Grades, Credits, & GPAs” page, in the Students panel, do one of the 
following:

• To run the calculation for all students, choose “All students in the school”.

• To run the calculation for selected students, choose “Selected students”. Use the Basic 
or Detail tabs to search for and select all students for which you want to perform the 
calculation.

4 In the Credits panel, select “Calculate credits for students selected above”. 

NOTE

You can run this calculation with other calculations on the page.

5 From the Actions menu, click Run Calculation. In the confirmation dialog, click OK.

Credits are calculated in the background. You will receive an alert when the task is 
complete.

Fall (class offered in 
the Fall semester only)

Entire class 1 credit awarded at the 
end of the Fall 
semester. 

Half of the potential 
credits awarded at the 
middle of the semester 
and half awarded at 
the end of the Fall 
semester, adding up to 
a maximum potential 
of 1 credit for the 
semester course. 

Spring (class offered in 
the Spring semester 
only)

Entire class 1 credit awarded at the 
end of the Spring 
semester. 

Half of the potential 
credits awarded at the 
end of quarter term 1 
and half awarded at 
the end of the Spring 
semester, adding up to 
a maximum potential 
of 1 credit for the 
semester course. 

Scheduling Term Set Student Schedule
Allow Partial Credits 
Not Selected

Allow Partial Credits 
Selected
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Overriding Student Credit Calculations
You can manually override the credits Chancery SMS calculates for a student. When you 
manually override a student’s credits, all calculated credits are no longer used and 
attendance rules are ignored. Only your manually entered value is used.

To override student credit calculations:
1 Open the student record. 

2 On the Student Demographics page, in the control bar, click Credits.

3 On the Student Credits page, review the following information:

Field Description

Grade Item Only credit-awarding grade items are shown with the grade item 
name and the grading period short code.

Grade items are grouped by class.

Grade The grade the student received for that grade item.

Potential Credits The potential credits for that grade item.

Credits Earned The credits earned for that grade item, based on the Maximum 
Credits value for that course.

A tilde (~) indicates that the earned credit has been manually 
overridden.

Override Reason If a grade item has an override reason, an icon appears in this 
column. Pause your cursor over the icon to see the override 
reason.
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4 From the Actions menu, click Override/Recalculate Credits.

The Override/Recalculate Credits page opens.

5 On the Override/Recalculate Credits page, specify the following information:

6 To delete an overridden earned credit, delete the value in the Credits Earned (overridden) 
column and remove the reason for the override. The calculated credits earned is now 
used for that grade item.

7 Click OK.

Field Description

Grade Item Only credit-awarding grade items are shown, with the grade 
item name and the grading period short code.

Grade items are grouped by class.

Potential Credits The potential credits for that grade item.

Credits Earned (calculated) The credits earned as calculated by Chancery SMS. Use this as a 
reference for the override value.

Credits Earned (overridden) Enter the overridden credits earned for this grade item, to a 
maximum of three decimal places.

Override Reason Enter a reason, if appropriate. While this is not a required field, 
giving a reason helps others understand why the calculated 
credits earned was overridden.
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Calculating GPAs
You run current year GPA calculations and cumulative GPA calculations from the same page. 
Before you run the cumulative GPA calculation, ensure student historical data has been 
entered. For further information, see “Student Historical Transcript Information” on 
page 153.

If your district has defined GPA/class rank reporting terms and you have assigned them to 
report card grading periods at your school, when you run the cumulative GPA calculation, 
Chancery SMS calculates end-of-term GPAs and cumulative-to-end-of-term GPAs. For further 
information, see “Calculating Term GPAs” on page 174.

GPA calculations are run as a background task. When the task is complete, an alert message 
is sent to the user who initiated the task. The alert message indicates whether the task was 
successful. This message includes the number of suspect cumulative GPAs, the number of 
students processed, the number of GPA definitions processed, the length of time the task 
took, and when it was completed. If GPA results were not successfully calculated or if a GPA 
is suspect, this message also displays the reason. For more information about working with 
alerts, see the Chancery SMS School User Guide available from the Pearson Customer 
Support website.

A GPA result is considered suspect if it meets either of the following conditions:

• The cumulative GPA (or, if your district is set up to use term GPAs, the cumulative-to-
end-of-term GPA) is calculated from historical yearly GPAs and at least one historical GPA 
is missing.

• The student meets both the following conditions:

• The student is in a grade level higher than the “Start from grade level” specified on 
the Add/Edit Cumulative GPA page.

• The student does not have any historical data with an overall cumulative GPA or 
yearly GPA.

The number of suspect GPAs includes all cumulative GPA definitions that are suspect. For 
example, if you set up one weighted and one unweighted cumulative GPA definition, and a 
student meets the suspect criteria for both GPA definitions, then that student is listed twice. 
Therefore, you might have a higher number of suspect cumulative GPAs than the total 
number of students.

For more information about how GPAs are defined, see “Setting Up Grade Point Averages” on 
page 117.

NOTE

Unlike other grading calculations, GPA calculations cannot be overridden.
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Calculating Term GPAs 
GPA/Class rank reporting terms enable schools to produce GPAs for district-defined time 
periods. A reporting term could be a semester, trimester, or other time period specified by 
the district. 

The district sets up GPA/class rank reporting terms and then the schools in the district assign 
the terms to their report card grading periods with defined grade items.

If your district has defined GPA/class rank reporting terms and the reporting terms have 
been assigned to grading periods, when you run GPA calculations, Chancery SMS calculates 
term GPAs.

There are two types of term GPA calculations: end-of-term GPAs and cumulative-to-end-of-
term GPAs. Both are cross-school calculations; that is, when a student is enrolled in more 
than one school in the district, the calculations include the student’s grades in all schools. 

• End-of-term GPA – This calculation includes only grade items associated with the GPA 
reporting term specified on the Grading Periods page. Historical grades are not used and 
future grades are not counted. In addition, the end-of-term GPA calculation uses the “Use 
in Cum GPA” setting from the Course Grading page for grade items.

• Cumulative-to-end-of-term GPA – This calculation includes historical grades and uses 
the same formula as the year-to-date cumulative GPA calculation; however, for the 
current year portion of the formula, only the grade items for the grading periods 
associated with the GPA reporting term are included.

A cumulative-to-end-of-term GPA provides a snapshot of a student’s GPA at the end of a 
GPA reporting term. This is useful if you want, for example, to compare a student's 
cumulative GPA at the end of Semester 1 with their cumulative GPA at the end of 
Semester 2.

As with end-of-term GPA calculations, future grades are not counted.

When you run GPA calculations, the calculations include only the grade items specified in the 
grading period to which the GPA reporting term is assigned. Both term calculations use the 
formula defined for the cumulative GPA. For further information about the cumulative GPA 
formulas, see “Working with Cumulative GPAs” on page 127.

For information about assigning a district GPA reporting term to a grading period, see 
“Grading Periods and GPA/Class Rank Reporting Terms” on page 92.
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Current-Year GPAs and Effective As Of Date
When determining which grades to include in the calculation, current-year GPA calculations 
consider the Effective As Of setting, as well as the Grading Period selected on the Edit 
Current Year GPA page. 

The following table summarizes how the Grading Period and Effective As Of settings affect 
the current-year GPA calculations:

Grading Period
(Set on Edit Current 
Year GPA Page)

Effective As Of 
(Set on Calculate 
Grades, Credits, and 
GPAs Page) Description

Current Report Card 
Period

Last Completed Report 
Card

The calculation includes grades from only the last 
completed report card. 

For example, if you run the calculation in grading 
period 2, the calculation only includes grades 
from grading period 1.

Current Report Card The calculation includes grades from only the 
current report card period. 

For example, if you run the calculation in grading 
period 2, the calculation only includes grades 
from grading period 2.

Year-to-date Last Completed Report 
Card

The calculation includes the grades up to and 
including the previous grading period.

 For example, if you run the calculation in grading 
period 3, the calculation includes the grades for 
grading periods 1 and 2.

Current Report Card The calculations includes the grades up to and 
including the current grading period.

 For example, if you run the calculation in grading 
period 3, the calculation includes the grades for 
grading periods 1, 2, and 3.
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To calculate GPAs:
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 7, click “Calculate Grades, Credits, & GPAs”.

3 On the “Calculate Grades, Credits, & GPAs” page, in the Students panel, do one of the 
following:

• To run the calculation for all students, choose “All students in the school”.

• To run the calculation for selected students, choose “Selected students”. Use the Basic 
or Detail tabs to search for and select all students for which you want to perform the 
calculation.

4 In the GPAs panel, select the GPAs you want to calculate. 

NOTE

You can run this calculation with other calculations on the page.

5 From the Effective As Of dropdown, select the appropriate setting.

6 From the Actions menu, click Run Calculation. In the confirmation dialog, click OK.

This calculation is run as a background task. When the calculation is finished, you receive 
an alert showing the results.

Cumulative GPAs and Effective As Of Date
By default, cumulative GPA calculations always include GPA values from students’ historical 
records (except when a student has no historical record, in which case only current-year 
grades are used). To specify which of the students’ current-year grades you want to include 
in the calculation, you select an option from the Effective As Of field. If you select “Last 
Completed Report Card”, the calculation does not include the grades from the current 
reporting period.

For example, let’s say you run a cumulative GPA calculation during grading period 2. If, in the 
Effective As Of dropdown, you select “Last Completed Report Card”, the calculation includes 
historical GPA values and current-year grades up to grading period 1. Any grades entered in 
grading period 2 are ignored. If you select “Current Report Card”, the calculation includes 
grades up to and including grading period 2.

Report Card 1, Report 
Card 2, and so on

Last Completed Report 
Card

Setting ignored.

Current Report Card Setting ignored.

Grading Period
(Set on Edit Current 
Year GPA Page)

Effective As Of 
(Set on Calculate 
Grades, Credits, and 
GPAs Page) Description
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NOTE

If your district calculates cumulative-to-end-of-term GPAs, the effective date functionality works 
exactly as it does for cumulative GPAs.

Calculating Class Ranks
You can calculate class ranks based on the cumulative GPA assigned to the class rank 
definition or, if your district has set up GPA/class rank reporting terms, you can choose to 
calculate class ranks based on a term GPA. For more information about term GPAs, see 
“Calculating Term GPAs” on page 174. 

With a cumulative GPA, class ranks are calculated to the end of the year. With a term GPA, 
class ranks are calculated using a cumulative GPA calculation but only to the end of the 
selected term. The term class rank can be stored, which enables you to track class ranks for 
each term in a school year. 

NOTE

Although you can store multiple class rank calculations, you can select only one class rank calculation to 
be rolled over to the next school year during Year-End Processing.

Cumulative and term GPA class rank calculations are run independently of each other; 
running a term GPA class rank calculation does not override any cumulative GPA class rank 
calculation results.

NOTE

You must run cumulative GPA calculations before you can calculate class ranks. If student grades were 
changed since the last time cumulative GPAs were run, you must run cumulative GPA calculations again 
before calculating class ranks. To be sure results are up-to-date, always run cumulative GPA calculations 
first, and then immediately calculate class ranks.

For more information about how class ranks are calculated and displayed, see “Class Rank 
Calculation Eligibility” on page 178.

From the Grading page, you can run class rank calculations. See “Calculating Student Ranks” 
on page 179. Once the class rank calculations are complete, you can override ranks for 
individual students. See “Overriding Stored Class Ranks” on page 181.
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When class ranks are calculated, the results appear on the Student Ranks page. This page 
has two tabs, Calculated and Stored:

For more information about how class ranks are defined, see “Adding and Editing Class Rank 
Definitions” on page 137.

Class Rank Calculation Eligibility
To be eligible to be included in class ranks calculations, the student must:

• Meet all criteria in the class rank definition, including, if applicable, rules covering 
withdrawal codes, minimum number of days enrolled in the district, and minimum 
number of credits earned; and

• Have a cumulative GPA value.

If a student’s ineligibility is suspect, a “?” appears in the left column on the Student Ranks 
page. A student’s ineligibility is considered suspect if the student is missing yearly credits 
earned or credits earned for course grade items because if the student’s credits earned were 
not missing, the student might be eligible.

Understanding Precision When Calculating Class Ranks
The cumulative GPA definition specifies the precision, or number of decimal places, in the 
calculation result. The displayed result is rounded to the precision specified, even though 
internally Chancery SMS stores and uses numbers with more decimal places.

Chancery SMS uses the stored precision, not the display precision, when calculating class 
ranks and when determining ties. Therefore, it is possible for students displaying an identical 
GPA to be ranked differently.

Use this tab To do this

Calculated • View the most recent calculated student ranks for a grade 
level in a class rank definition. 

• Recalculate student ranks.

• Store calculated ranks. 

Stored NOTE
This tab only appears if class ranks have been stored previously.

• View the last stored student ranks for a grade level in a 
class rank definition. 

• Override a student’s calculated rank. 

• Manually assign a rank to students who are deemed 
ineligible to be ranked by the criteria the school has set 
up. 
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For example, let’s say the cumulative GPA definition specifies three decimal places. If the 
stored cumulative GPA for student A is 3.2568 and for student B is 3.2566, both students’ 
GPA would be displayed as 3.257 because they are rounded to three decimal places. 
However, student A would be ranked higher than student B because Chancery SMS uses the 
stored value and not the displayed value when calculating class ranks.

To see full precision values, run the Cumulative GPA Report.

If the calculated class rank is not appropriate, you can manually override class ranks. For 
information about overriding a student’s rank, see “Overriding Stored Class Ranks” on 
page 181.

Calculating Student Ranks
1 In the control bar, under Admin, click Grading.

2 On the Grading page, under Step 7, click Calculate Class Ranks.

3 On the Calculate Class Ranks page, from the GPA for Rank Calculation dropdown, select 
cumulative GPA or a Term GPA.

4 Do one of the following:

When calculations are complete, the Student Ranks page opens and you can view and 
store the latest class ranks.

Use the Calculated tab to view the most recent calculated student ranks for this grade 
level for this class rank definition. The Last calculated field shows the date the student 
ranks were last calculated.

To Do this

Review stored class ranks • Click the link in the Date Last Stored column.

Calculate class ranks • Click Run next to the appropriate grade level. 

Displays the grade 
levels selected for 
each class rank 
definition.

The date class ranks 
were last stored for that 
grade level.

Click to begin class rank 
calculations. 
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5 On the Student Ranks page, on the Calculated tab, review the following information:

Students who are not ranked because they are deemed ineligible according to the class 
rank definition criteria always appear at the bottom of the list. Students with no GPA 
value are treated the same as ineligible students and also appear at the bottom of the 
list.

6 Do any of the following:

Field Description

Grade Level The grade level you selected on the Calculate Class Ranks page.

GPA For Rank Calculation The GPA used to calculate the student ranks.

Class Rank Out Of The total number of students in this grade level ranked by 
Chancery SMS.

This number does not include students ineligible to be ranked, 
but does include any ineligible students manually ranked on the 
Stored tab.

Last Stored The date and time you clicked Store to store the ranks of all 
students for this grade level for this class rank definition.

Last Calculated The date and time class ranks were calculated or recalculated for 
students for this grade level for this class rank definition.

Left column This column appears only if there are special indicators for any 
student. 

• A tilde (~) indicates the calculated rank has been manually 
overridden.

• A “?” indicates the student’s eligibility is in question.

• A caret (^) indicates an ineligible student’s rank has been 
overridden.

Rank The student’s rank as of the Last calculated date and time.

NOTE
If you click Recalculate, all students on this tab are re-ranked and the Last 
calculated field is updated.

Student Name Students are sorted by rank, then by cumulative GPA, then by 
last name, and lastly by first name.

GPA Value The cumulative GPA or term GPA used to calculate the student’s 
rank. The number of decimal places displayed is specified in the 
cumulative GPA definition. For more information, see 
“Understanding Precision When Calculating Class Ranks” on 
page 178.

To Do this

Recalculate student ranks as 
of today

• Click Recalculate. All students on this tab are re-ranked and 
the Last calculated field is updated.

Replace the currently stored 
student ranks, if any, and 
keep this list of student 
ranks in the Stored tab

• Click Store.
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Overriding Stored Class Ranks
1 On the Student Ranks page, click the Stored tab.

2 On the Stored tab, review the following information:

Manually override any of the 
calculated student ranks

• See “Overriding Stored Class Ranks” on page 181.

Field Description

Grade level The grade level you selected on the Calculate Class Ranks page.

GPA For Rank Calculation The GPA used to calculate the student ranks.

Class rank out of The total number of students in this grade level ranked by 
Chancery SMS.

This does not include students ineligible to be ranked. However, 
if you have manually ranked ineligible students on the Stored 
tab, then those students are included in this number.

Last stored The date and time you clicked Store to store the ranks of all 
students for this grade level for this class rank definition.

Left column This column appears only if there are special indicators for any 
student. 

• A tilde (~) indicates the calculated rank has been manually 
overridden.

• A “?” indicates the student’s eligibility is in question.

• A caret (^) indicates an ineligible student’s rank has been 
overridden.

Rank The student’s rank as of the Last stored date and time.

Students who are not ranked because they are ineligible 
according to the class rank definition criteria always appear at 
the bottom of the list.

To manually override a student’s rank, enter a new number in 
this field.

Student Name Students are sorted by rank, then by cumulative GPA, then by 
last name, and lastly by first name. 

GPA Value The cumulative or term GPA used to calculate the student’s rank. 
The number of decimal places that is displayed is specified in the 
cumulative GPA definition. For more information, see 
“Understanding Precision When Calculating Class Ranks” on 
page 178.

To Do this
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3 Do any of the following:

4 Click Save.

NOTE

Clicking Save on this tab does not change the Last stored date and time.

Calculating Honor Rolls
When calculating honor rolls, the system verifies that all students on the honor roll are still 
eligible. Students might have been eligible when they were first added to an honor roll, but 
their attendance or grades may have slipped, making them ineligible. In addition, the 
eligibility criteria associated with an honor roll might also have changed. 

When the honor roll calculation is complete, all eligible students are assigned to the honor 
roll. To view students on the honor roll, see “Managing Honor Rolls” on page 115.

To calculate honor rolls
1 In the control bar, under Admin, click Grading.

2 On the Grading page, click Calculate Honor Rolls.

3 On the Honor Rolls page, select an honor roll. 

4 From the Actions menu, click Calculate Honor Roll.

5 In the confirmation dialog, click OK.

To Do this

Manually override a 
student’s rank

• Click the student’s rank and enter a new rank. A tilde (~) 
indicates an eligible student’s rank has been overridden. A 
caret (^) indicates an ineligible student’s rank has been 
overridden.

Clear a manual override 1 Select the row. 

2 From the Actions menu, click Clear Override. Chancery SMS 
replaces the rank in that row with the last calculated rank.
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6 In the Select a Report card Period dialog, choose an option from the dropdown.

7 Click OK.

When eligibility calculations are complete, alerts are sent to the user who ran the 
eligibility calculation. 
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